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Linux is taking over the world and the last place it has to conquer is your 

desktop. If you’re desperate to dump Windows, curious enough to try Ubuntu 

or want to jump feet-first into the open source world, this Ubuntu special is 

the best place to get started. Inside this bookazine are all the guides, tutorials 

and advice you need to successfully install, get started and use Ubuntu for 

the first time. We’ll be holding your hand as you leave Windows behind and 

get Ubuntu up and running on your home systems.

The great thing about Ubuntu and Linux is that if you want to keep things 

simple, you can, but if you want to hit the bare metal and dive into the inner 

workings of the operating system, you can do that, too. We’re here to guide 

you into the world of Linux. We won’t pretend it’s completely easy – you need 

to be prepared to look for support and ask questions – but there’s a wealth of 

friendly help available from the Ubuntu and Linux communities. So what are 

you waiting for? Turn the page and start your Ubuntu adventure!
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What is Ubuntu?
It’s an operating system, it’s computer freedom, it’s your gateway to open 

source and a community that shares software for everyone to use.

I
f we say Microsoft Windows or Apple 

macOS, you know what they are. But if we 

say Ubuntu, are you left blank? If you’ve 

picked up this copy of Linux Format Presents: 

Ubuntu The Complete Guide, it’s more than 

possible you’ve heard of Linux, and you’ve 

possibly heard of Ubuntu. If you have, then 

dive in, but for those new to Linux, Ubuntu and 

open source software freedom, let’s first get 

you up to speed with what it’s all about.

So what is Linux? What is Ubuntu? And 

how does the concept of open source software 

work? If you’ve seen the little penguin fellow 

hanging around various pages and on the 

covers of Linux Format, his name is Tux. He’s 

the mascot of the world-famous open source 

system called Linux. It’s the control software at 

the heart of most open source operating 

systems, such as Android and Ubuntu, and it’s 

known as a kernel. You’ll find that Linux is used 

in hundreds of operating systems, and one of 

the most popular is Ubuntu. Just as Windows 

has its own kernel, and Apple’s macOS has its 

Darwin kernel, so Ubuntu has Linux.

While Linux has been developed since 1991, 

Ubuntu first appeared in 2004, and thanks to 

its easy-to-approach philosophy and short six-

month development cycle, it rapidly became 

the most popular open source Linux operating 

system in the world. Ubuntu is an operating 

system, just like Windows and macOS, but it’s 

also more than either of those. Within the Linux 

world, it’s called a distribution, aka distro.

As you get more into Ubuntu and open 

source, you’ll find choice is a huge element. 

Ubuntu is a distro that doesn’t just provide the 

Like most software, Ubuntu has 

released versions and code names. If 

you’ve never come across Ubuntu 

before then these can be a bit, erm, 

unusual and confusing so let us 

explain. Canonical, the company that 

develops Ubuntu, releases two 

versions a year and it then increases 

the version number by one. The 

releases are in April (04) and October 

(10), so version 19.04 was released in 

April 2019. The release after was 19.10 

in October 2019. 

Each normal release gets nine 

months of support updates. Every two 

years there’s a Long Term Support 

(LTS) release that gets three years of 

support releases. The current one is 

21.04 LTS; the next will be 22.04 LTS.  

If you want something more stable,  

we suggest opting for one of these 

releases. To add to the quirkiness, 

every release gets an interesting 

release name, after an animal that 

cycles the alphabet for each release. 

Recent names are:

16.04 LTS  Xenial Xerus

16.10  Yakkety Yak

17.04  Zesty Zapus

17.10  Artful Aardvark

18.04 LTS  Bionic Beaver

18.10  Cosmic Cuttlefish

19.04  Disco Dingo

19.10  Eoan Ermine

Ubuntu versions
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software that installs and runs Linux on your 

PC, it provides the Unity desktop software, it 

bundles in the Firefox browser, the LibreOffice 

office package, the Gimp art package, the 

Audacity audio editor and so much more. It’s a 

distro, because it packages and handles an 

entire software library in one.

This is only possible because of the open 

source philosophy under which the 

Linux kernel is developed, the Ubuntu 

distro is created, and the open source 

licence that all the programs used are 

released under. 

Open source is a key element to 

software freedom; the idea that all of us 

should be able to freely use computers 

without being locked in to any single vendor or 

reliant on any single operating system 

publisher. It’s a complex idea to get your head 

around initially, especially if you’ve been used 

to the Microsoft and Apple ways of doing 

things, but you’re about to break free of any 

restrictions and start to use computers as you 

want. The way it should be – it’s all quite 

exciting really.

Over the page, you’ll find out how to install 

and get started with Ubuntu. We assume 

you’re already running a Windows system 

here. If you do already have a Windows 

system, then you have two choices: wipe over 

Windows and be rid of it forever, or dual boot 

Ubuntu beside Windows, leaving your files 

intact. The latter is preferable if your system 

has room for it, and is probably the best option 

for anyone new to Linux.

Once you are up and running, Ubuntu  

gives you access to literally thousands of  

free open source apps. Many of which rival  

the abilities of anything you could buy for 

Windows or macOS, and many even  

surpass their abilities. You’ll also find the 

range of software to be enormous, (see  

page 34 for more on apps) and it 

encompasses such diverse areas as coding, 

mathematics, physics, engineering, space  

and beyond.

Finally, it’s important to remember 

that Ubuntu isn’t just limited to one 

distro. There’s a whole range of options 

available for you, and we encourage you 

to experiment, look around and try out a 

few different options to help find the one 

that suits you best. We’ll outline the many 

available here, but suffice to say that they 

cover tailored builds for desktop systems, 

internet servers, low-power systems, 

embedded internet-of-things devices, tablets 

and more.

So what are you waiting for? 

What does Ubuntu look like?

Desktop
Like all PC desktops, Ubuntu has 

one, too. You can keep it as clean or 

messy as you like with icons, and can 

choose your own background.

Launcher
The Launcher lives 

down the left of the 

desktop. It holds 

recently run 

programs. You can 

add and remove 

items and adjust 

the icon size. 

Desktop 
search
This search system 

is how you’ll find 

and access more 

programs and 

other files and 

documents. You 

can filter and even 

search online.

Files
Files and folders can still be 

accessed through a file explorer 

system. The Linux filesystem is 

more complex than Windows but 

stick to the Home folder.

Settings
You’ll find most system 

settings can be easily 

accessed through this 

handy system.

“It’s a complex idea but 
you’re about to break 
free of any restrictions”
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To circumvent this system it’s necessary to run the DVD in 

a compatibility mode. As mentioned in the box (see Disc 

Booting Problems) use the suitable button to enter the UEFI/

BIOS. In the UEFI, disable QuickBoot/FastBoot and Intel 

Smart Response Technology (SRT). If you have Windows 

8/10, also disable Fast Startup.

The procedure to disable the Secure Boot 

differs from machine to machine, and in some 

rare cases it’s outright impossible (where the 

manufacturer doesn’t want the original OS 

replacing). Look in the Boot UEFI settings for Classic-BIOS 

mode, CSM or Legacy to be able to run the DVD.

Going virtual
Another option is to install Oracle VirtualBox software from  

www.virtualbox.org/wiki/Downloads. Install and run this. 

It looks complex, but creating a virtual PC is pretty easy if you 

stick to the default settings. The main stumbling block is 

ensuring you add the ISO file to the virtual optical drive under 

the Storage settings. (See box Installing VirtualBox).

Ubuntu: Quick 
install guide
Linux isn’t scary or hard. You can be up and running in just  
4 minutes, honestly! Would we lie to you? Don’t answer that…

H
onestly, modern Linux is easier, faster and less hassle 

to install than any recent release of Windows. That’s 

the truth. No messing with keys, no worrying about 

activation and no digging out that lost install disc or USB 

drive. The beauty of Linux is that because it’s free software 

anyone can download and start using it immediately. You 

don’t even have to install anything! Linux technology and its 

free and easy licence means that it can be run straight off a 

CD or DVD. It’s not as fast and you can’t save work as such, 

but it’s an ideal way to quickly try out Linux without worrying 

about installing or setting up anything else. As long as you 

have an optical drive and can persuade your PC to boot from 

it – not always an easy task – then you can be trying out 

Linux in just a few minutes.

Perhaps you want something a little more permanent? 

If you’ve tried Ubuntu and decided it’s for you then it’ll easily 

help you install it permanently on your local hard drive. It can 

even automatically shrink Windows to fit Ubuntu on there. 

If that sounds too complex then why not use a virtual 

version? We’ll look at how using VirtualBox you can run 

Ubuntu at the same time as Windows. Another big win with 

Linux and Ubuntu is that it doesn’t require anywhere near the 

space of Windows. The minimum space is around 7GB, 

obviously more is always better, but to try out Ubuntu just 

10GB is more than enough.

Easy ways to Linux
If you’re not a big Linux user then you probably won’t want to 

destroy your existing Windows or Mac system. And the truth 

is that you don’t need to either, Linux is flexible enough that it 

can be run in a number of ways: beside, on top or alongside 

most other operating systems and on most types of 

hardware, and from virtual versions to versions running off 

USB drives, DVDs or on hardware like the Raspberry Pi.

Booting a DVD is the easiest and fastest way to try Linux 

and Ubuntu. Here, at Linux Format Towers, after navigating 

the DVD menu we can have Ubuntu loaded up in less than 

four minutes. Getting the disc to boot, however, can be easier 

said than done. If your system doesn’t automatically run the 

disc when turned on with it in the drive. Ideally, it’s no more 

complex than pressing the correct key to open a Boot Menu 

from which you can select the DVD to run. 

There’s an additional issue that can happen with PCs 

using the more recent UEFI boot system that replaces the 

BIOS – these tend to be on PCs made after 2010 – where the 

UEFI can block the disc from running for security reasons.

We didn’t include 

times to download 

anything, as that’s 

so variable and 

unnecessary. 

We also excluded 

any POST delays, 

but we also 

excluded the many 

times we popped 

out to make a 

nice Cup of Tea. 

Otherwise times 

include writing 

to any discs and 

the entire boot-up 

process.

Quick
tip

Boot to a 
Live Disc

3m 35s

“If you’re not a 
big Linux user 
then you probably 
won’t want to 
destroy your 
existing Windows 
or Mac system. 
And the truth is 
that you don’t 
need to either, 
Linux is flexible 
enough that it can 
be run in a 
number of ways”

http://www.virtualbox.org/wiki/Downloads
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If you find you want to keep using the virtual version of 

Ubuntu ensure you install the VirtualBox additions, this 

provides better screen scaling, seamless mouse integration, 

combined clipboard and seamless dragging and dropping 

from the host machine to the virtual Ubuntu. To do this run 

the VirtualBox Ubuntu, once the desktop has loaded select 

the Devices > Insert Guest Additions CD image… What this 

does is add another virtual optical disc with the required 

software. After a few seconds a window should open asking if 

you want to run the disc, choose ‘Run’ and allow the software 

to install, this can take a while.

Use the View, Input and Devices menus at the top of the 

VirtualBox window to adjust and control all of the previously 

mentioned integration features. They make using the 

VirtualBox much more comfortable, as well as enable a wider 

range of resolutions.

There are more options available including writing the ISO 

file to a suitable USB thumb drive and following a similar boot 

process as discussed above, running Linux from this. To get 

this to work you’ll need to use a write tool, such as 

UNetbootin from http://unetbootin.github.io. This can be a 

helpful option if your device doesn’t have an optical drive that 

you can boot from or you’ve downloaded the relevant disc 

image (ISO) file from www.ubuntu.com/download/desktop.

Using USB
There are some pretty exotic solutions for running Ubuntu 

and other versions of Linux from a USB stick, eg so you can 

carry your OS around with you and boot it on almost any PC 

you happen across, but we’re just looking at running a basic 

Live Disc so you can at least try it out. (See Ubuntu on a USB 

drive for more details.) 

You’ll need at least a 2GB stick, larger ones give you the 

option of using the spare space as storage, ensure you enter 

a suitable value into UNetbootin. Also be aware using USB 

storage brings its own set of issues. We had no problem with 

a Toshiba 16GB stick, but a San Disk 32GB stick would start 

but Ubuntu wouldn’t then load.

On the Mac you 

have to hold c 

when your system 

is turned on to get 

it to boot from an 

optical drive. As 

we go into some 

depth when you 

first turn on a PC 

you can usually 

get it to boot from 

alternative media 

by pressing F11/F12.

Quick
tip

1  Get VirtualBox
Head to www.virtualbox.org and download 

Virtual Box 6 for your operating system, be 

that Windows or macOS . Install it and be 

aware you’ll need around 20GB of space drive 

space to store the virtual OS file. You’ll also 

need the Ubuntu ISO file from www.ubuntu.

com. Once installed, start it, click the ‘New’ 

button and call it Ubuntu.

3  Starting virtual Ubuntu
A prompt will appear asking for a disc, locate 

the Ubuntu ISO file and click ‘Start’. Linux 

Ubuntu will start, once loaded you’re free to 

try out Ubuntu or use the Install icon to 

properly install it to the virtual machine. 

For extended use in the virtual machine’s 

settings under Display, you’ll want to enable 

3D acceleration and allocate 16MB.

2  Create a machine
Choose Ubuntu and the bits should match 

the ISO you downloaded, click ‘Next’. Under 

Memory we’d recommend 2048, but if you 

have an 8GB PC 4096 is best. You can leave 

all the rest as default settings, apart from the 

dynamic hard drive size. The default is 8GB, 

we’d suggest at least 32GB just in case. Finish 

and click Start to get going.

Installing to a VirtualBox 
Installed on 
a virtual PC

7m 00s

Disc booting problems

The first problem that many people encounter is booting 

their desktop or laptop from a DVD. Many systems no longer 

check the optical drive for boot media, as it slows down the 

start process. You have two options, one is to open any 

provided Boot Menu – not all devices offer this – the key 

used varies. HP systems use F9, Dell and Lenovo use F12, 

older AMIBIOS-based systems use F8, Award-based 

systems use F11. You need to slowly tap the key just after 

switching on the system. Select any CD-ROM/Optical drive 

option and you’re good to go.

If no boot menu seems available the other option is to 

select the order of boot devices within the BIOS/UEFI 

settings. Typically a message should flash up during the 

system start explaining which key to press. Just as with the 

boot menu pressing one of Del (the most common), F1, F2, 

Esc or a ‘special’ maintenance key should provide access. In 

the BIOS locate the Boot Device menu and ensure a DVD/

optical drive is first in the list. Save and reboot!  This is our boot menu, there are others like it, but this one is ours.

http://unetbootin.github.io
http://www.ubuntu.com/download/desktop
www.linuxubuntu.com
http://www.ubuntu.com
http://www.ubuntu.com
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We don’t really have space here to go into the full ins and 

outs of backing up any existing Windows partition, resizing 

partitions and installing Ubuntu by hand. The good news is 

Ubuntu will largely do the last two automatically for you, if you 

let it. Be warned though, it’s easy to destroy your Windows 

partition, the Windows bootloader or to leave your PC 

unusable if you should choose the wrong options or if 

something else goes wrong along the way. We don’t 

recommend installing or upgrading any OS unless you have 

backed up any files, created an image of your drives and the 

system isn’t critical to any business, personal use or other 

operation. With that dire warning out of the way, on to the fun!

As a general rule if you have Windows on the boot drive, 

Ubuntu will happily resize this and fit itself alongside Windows 

on the drive. Before trying to ensure the drive has enough free 

space. These days drives can be easily 500GB or larger, as 

long as there’s 20GB free there shouldn’t be an issue; more 

space is required than just for Ubuntu as there needs to be 

space to move Windows files out of the way too. If there isn’t 

this free space, run the Windows Disk CleanUp Tool, ideally 

choose to re-run it as Administrator, and get it to remove 

unused system files too.

If you don’t have 20GB free then it’s best that you don’t 

try to install Ubuntu. Once you start the Ubuntu install 

process don’t interrupt it. If you break your bootloader or 

partition tables then they can be a real pain to fix, but if you 

do manage to break something don’t panic Windows will still 

be there. 

1  UNetbootin Linux
To run Ubuntu from a USB stick, you first 

need a USB drive at least 2GB in size, 8GB 

would be ideal. You’ll need the Ubuntu ISO file 

from www.ubuntu.com as discussed in the 

VirtualBox walkthrough and we’ll use the 

download tool UNetbootin from http://

unetbootin.github.io. This installs the Live 

Disc ISO file directly to your USB drive.

3  Boot and run
You can now boot your PC from the USB 

drive. However, you’ll need to ensure your PC 

selects the USB drive as the boot device. 

Usually when you first turn on your PC a 

message says press F8, F9, F11 or F12 to 

select the boot device. Some PCs have their 

own specific button, consult your manual or 

manufacturer for details. Ubuntu will now run.

2  Install Ubuntu
The tool can download the ISO image, but it’s 

best practice to do this yourself. So select 

Diskimage, locate the file in the Download 

folder. Use the Ubuntu storage box to create 

reusable space—512MB should be fine use 

more on larger sticks. Ensure you have the 

correct USB drive select in the bottom pull-

down menu and click ‘OK’ to create the drive.

Ubuntu on a USB drive 

 UEFI has 

replaced the 

BIOS and can 

block discs from 

running for 

security reasons.

Installed on 
your USB

5m 20s

http://www.ubuntu.com
http://unetbootin.github.io
http://unetbootin.github.io
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E
ighteen years ago Canonical, led by 

dot-com magnate-cum-space 

tourist Mark Shuttleworth, 

unleashed the first Ubuntu release. It was 

nothing short of revolutionary. Suddenly 

Linux was a thing for human beings. 

Networking worked out of the box, as did a 

glorious – albeit brown – Gnome 2 

desktop. It was built on Debian and 

inherited that reputation of stability, but it 

wasn’t Debian. It was something special. 

A huge community rallied around 

Canonical, which promised that it would 

listen. A bespoke bugtracker named 

Launchpad was set up, and the first bug 

filed was “Microsoft has a majority market 

share”. For many, Linux’s golden age was 

about to begin, and there was a palpable 

sense that Bug #1 would soon be fixed.

Flash forward to today, and you’ll see 

that not all of those dreams came true. 

Windows still rules the desktop (though 

MacOS and ChromeOS are swallowing 

that up). Casual desktop computing as a 

whole is becoming a niche hobby, because 

a great deal of our browsing and 

communication is now carried out by 

smartphones (some of which run Linux, 

but not ‘real’ Linux). Desktop Linux is alive 

and well, but the ecosystem is still not 

perfect. An abundance of desktop choices, 

together with numerous forks of popular 

distros, have led to complaints about 

fragmentation (from people that don’t 

understand open source software and  

free will). And Canonical copped plenty  

of flack when it abandoned Unity and 

the Ubuntu Phone. 

But it’s not all bad. Companies 

have embraced Linux, in particular 

Valve. Its work on Proton has 

enabled some 5,000 Windows-

only games to be played on 

Linux. And Ubuntu  

is still a hugely popular  

Linux distribution that’s  

great for playing said games, 

wrangling vital 

documents, or 

managing  

your clouds.

And now 

Canonical is 

back with 

a brand-new release called Jammy 

Jellyfish. It incorporates parts of the latest 

Gnome 42 desktop. The switch to the 

Wayland display protocol has finally 

happened. The new Pipewire multimedia 

framework is woven into its fabric. And it’s 

a Long Term Support (LTS) release, so you 

can keep on using it for five whole years. 

You won’t find earth 

shattering user-facing 

changes here, but you 

will find a great, 

reliable OS. Read on 

to find out why…

Walpurgis Night is nearly upon us, so cast aside your old OS 

and begin life anew with Ubuntu 22.04.

BULLET-PROOF
UBUNTU 22.O4
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W
e always look forward to trying out a new 

Ubuntu release. But this time around we’re 

not expecting a wildly reinvented desktop 

paradigm or huge performance leaps. The previous 

Ubuntu LTS, Focal Fossa, after occasionally rocky 

beginnings, has been a loyal servant to many of our 

machines, and we’re sure Jammy Jellyfish will be a 

worthy successor. We’re looking forward to Gnome 42 

(although there are some loose ends from earlier 

releases), a more polished Wayland experience and we 

want to see how Canonical is pushing ahead with its 

Snap initiative.

There’s only one problem. At time of writing, it hasn’t 

been released. But that’s okay, because it will be by the 

time you read this. And if we’re lucky there we won’t 

have missed any last-minute additions or surprises. 

We’ve been testing the daily Jammy Jellyfish images for 

a couple of months prior to the official release. 

Minor niggles, begone!
And we’ve seen quite a bit of change in that time, 

particularly as parts of the recently released Gnome 42 

start to find their way in. Indeed, as we write this we’re still 

about a week away from launch day, but since both the 

Feature and UI Freeze have passed we don’t expect any 

drastic changes. We do rather hope some minor niggles 

(such as stuttering and occasional crashes while dragging 

windows between monitors) get sorted out, though.

If you’ve used either of the interim releases (21.04  

or 21.10) since the lasts LTS then you’ll be aware that 

now Ubuntu uses Wayland and (maybe) remember  

that Active Directory can be set up from the installer. 

Of jams and jellies
It’s Ubuntu LTS time, so let’s see what will be  
the shape of Ubuntu for the next few years…

 The official 

background 

is over the 

page, but these 

AI-generated 

jellyfish by 

Simon Butcher 

are something 

else.

You’ll be aware that there’s light and dark versions of 

the Yaru theme, and you’ll suspect (rightly) that these 

have been further tweaked. To be frank, if you’ve  

been using Ubuntu 21.10, then there’s not anything 

ground-breaking in 22.04. But that doesn’t mean you 

shouldn’t upgrade. You should, because if nothing else 

your interim release is about to be EOLd. Oh, and if 

you’re of the ilk that gets excited by phrases like 

‘modern design trends’, then check out the new logo.  

It’s similar to the old Circle of Friends logo, but on a 

web3-friendly (stop baiting sensible readers! – Ed) 

rectangular background.

If you just want to see what Ubuntu is like, there’s no 

need to install it at all. Just follow our handy three-step 

guide to downloading, writing and booting an Ubuntu 

USB stick, or DVD if you must. 
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Download and boot Ubuntu

2  Write out a USB stick
Use your favourite image writer (or 

download Balena Etcher from https://

etcher.io) to write the image to a USB 

stick. Don’t remove the medium until 

you’re told it’s safe to do so. Bad media will 

cause problems later. You could also 

(using different software) make a DVD, but 

this will be slower than using flash media.

3  Boot Ubuntu
Your machine might enable you to bring 

up a boot menu by pressing F12 or F10 at 

boot time. If so use this to one-time boot 

from the Ubuntu medium. Otherwise 

you’ll need to go into the UEFI/BIOS setup 

interface and change the boot order. See 

the official docs at https://ubuntu.com/

tutorials/try-ubuntu-before-you-install.

1  Download an ISO
Go to https://ubuntu.com/desktop 
and download the ISO file. It’s 3.5GB so 
you may want to fetch a cup of tea. If 
you’re interested in trying another 
flavour, such as Kubuntu or Lubuntu,  
you’ll find links at https://ubuntu.
com/download/flavours. You’ll also 
find links to the Server, Pi and Core  
editions here.
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W
indows 11 has been rolled out through the 

Insider program since late last year. All 

Windows 10 users will have been offered the 

upgrade, in all likelihood, by the time you’re reading this. 

There’s nothing like a new Windows release for 

motivating people to switch to Linux. So here’s a quick 

guide for recent Windows apostates.

You may be tempted to dual-boot Windows and 

Ubuntu together. This might sound convenient, but it’s 

rich with pitfalls so not something to rush into. Ubuntu 

will install alongside Windows, but there’s no telling if 

down the line Windows Update will, on a whim, decide 

the Linux partition(s) is no longer necessary. For this 

reason we don’t recommend installing both OSes to the 

same device. A 250GB SSD is ideal for your first Linux 

explorations, and you can get this new for around £25. 

Our next prudent bit of guidance is perhaps overly 

cautions, and a little inconvenient, but it’s the only way 

to be sure Windows won’t touch your Linux: unplug the 

SSD prior to booting to Windows. Yup, it’s hard to 

remember and potentially awkward to carry out (if your 

case is under the desk, say), but at least you can 

describe your install as ‘airgapped from Windows’.

You might instead want to install Ubuntu to an 

external hard drive or USB stick, though if you’re not 

using USB3 storage this won’t be terribly performant. 

Ideally, you’d put it on a whole new machine, but not 

everyone has a spare, working machine.

BIOS, meet UEFI
Modern PCs use a newer firmware, the Universal 

Extensible Firmware Interface, rather than the traditional 

BIOS of yore. UEFI machines may have a classic BIOS 

emulation mode, but you almost certainly shouldn’t 

enable it. Especially if you already have OSes installed in 

UEFI mode (they will stop working). 

Escape Windows
Whether you’re a complete novice or Windows has driven  

you to seek out other operating systems, Ubuntu can help.

Get to know Ubuntu’s Gnome desktop

1  Activities
Click here or press Super (Windows) 

to bring up the Activities Overview. 

This will show you previews of open 

windows, which you can drag over to 

the right, to move them to a new 

virtual desktop

2  Dock
This provides easy access to popular 

programs. Running applications are 

indicated by a red dot. Right-click to 

pin or unpin applications from here.

3  Applications grid
This displays all currently installed 

applications. Type a few characters to 

narrow down the list. You can also find 

emoji this way, if they float your boat. 

Oh, and there’s a virtual desktop 

switcher here too.

4  Desktop options
Right-click on an open space on the 

desktop to change either the 

background or display settings. You 

can also create desktop folders.

5  Status icons
Network, volume and power 

indicators. Click to access Bluetooth, 

brightness and (for laptops) power 

profile settings. The logout and 

shutdown options are also here.

6  Notification area:
Alerts, such as new software being 

available or media being played, are 

shown here. There’s a calendar too – 

this can be used locally or connected 

to a cloud service.

1

2

3

4

56
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Note that PCs these days can be 

incredibly fussy about getting into 

the UEFI setup or summoning a 

boot menu. Precision timing, 

multiple reboots, as well as digging 

up manuals to find the appropriate 

shortcut key may be required. The 

Ubuntu EFI boot capsules are all 

signed by a Microsoft-endorsed key, 

so there should be no need to 

disable Secure Boot. 

One thing to be aware of is that 

one EFI partition is required to boot 

a UEFI system. So if you plan on 

installing Ubuntu on a separate 

drive, make sure the “Device for 

bootloader installation” is set to the 

original drive, and that the EFI 

partition is selected. This drive will need to be plugged in 

to boot either OS, but you’ll be able to choose which 

from the UEFI.

Once you’ve successfully booted Ubuntu, you’ll be 

asked whether you want to try Ubuntu or jump right in 

and install it. We’d suggest trying it first, if you haven’t 

already. This enables you to get a feel for the operating 

system without it touching any of your storage. So you 

can try out bundled software, install new things and see 

if it’s right for you. The only downside is that it won’t 

quite be as performant as the real thing. Oh, and any 

changes you make will be lost after a reboot, of course. 

The annotation (below left) shows you the rudiments of 

Ubuntu’s Gnome desktop.

Just as in other OSes you’ll find folders for your 

Documents, Photos and Downloads. But unlike at least 

one other OS you won’t be bombarded with marketing 

or voice assistants trying to help you. The Dock area on 

the left-hand side is a nod to Ubuntu’s old Unity 

desktop. The new desktop has been based on Gnome 3 

since Ubuntu 18.04, but with some usability tweaks. 

Gnome 3 was seen by some as too ambitious, 

occasionally buggy, and a memory hog when it was 

introduced in 2008 (this commentator even used the 

phrase “hypermodern”), but these days the fact it forms 

the basis for so many desktops is testament to its 

solidity. If you imagine the dock was gone you’ll see 

what a lot of traditionalists’ main problem with Gnome 

is: There’s no obvious menu to launch applications. The 

applications grid provided by the Dock isn’t quite the 

same thing, but if you’re in the habit of using a mouse to 

open a traditionally placed applications menu, then your 

muscle memory will more likely bring you here than to 

the Activities view.

On a clean install the dock area has 

shortcuts to Firefox, Thunderbird and 

LibreOffice Writer. The question mark icon 

will take you to the desktop guide, which 

hopefully answers any questions you may 

have. You’ll also find links to Ubuntu 

Software (the shopping bag icon), in case 

you want to install more software, as well 

as the venerable Rhythmbox music player. 

Internal and external drives will also show 

up here, plus there is a Rubbish Bin from 

whence deleted files can be retrieved.
 If you know what you want, partition-wise, then the 

Something Else option in the installer will help.

USING A ROCK-SOLID GNOME
“The new desktop has been based  
on Gnome 3 since Ubuntu 18.04,  
but with some usability tweaks.”

Become a keyboard warrior
In an age of QHD screens and 4K displays, the 

mouse cursor’s pilgrimage to the top-left 

corner can be an arduous one. This journey can 

be saved through the magic of keyboard 

shortcuts. Apart from the all-important Super 

(Windows) key to bring up the Activities view, 

your life in Gnome may be improved (May? – 

Ed) with the following knowledge:

Ctrl+Super Left/right - tile window left/right

Super+A - show applications grid

Super+PgUp/PgDown - switch virtual desktops

Shift+Super+PgUp/PgDown - move window 

to prev/next workspace

Shift+Super Left/Right - move active window 

to prev/next display

 Don’t know 

what to install 

first? Let the 

Snap Store 

inspire you.  

And don’t forget 

your updates!
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Customise Ubuntu
Discover new software. Change settings. Install a new desktop (or three).

 Installing the whole Kubuntu desktop package makes for a menu that, 

unsurprisingly, is rich in items that begin with K.

U
buntu (and most other desktop Linux flavours) 

have been designed to be intuitive and easy to 

learn. However, sooner or later you’ll probably 

want to change some things around. For example, we 

think Rhythmbox is great. It’s been the default music 

player in Ubuntu since the very beginning (with only a 

brief sabbatical while Banshee took its place in 2011). But 

with its Client Side Decorated window it looks dated, and 

can’t connect to popular (albeit proprietary) streaming 

services so we might want to look at alternatives. By this 

point we’re assuming you’ve installed Ubuntu, and 

enjoyed its new look Flutter-built installer.

Fire up the Ubuntu Software application, scroll down 

to the list of categories and select Music and Audio. You’ll 

see a selection of audio programs, most of which we’ve 

never heard of. You will, however, find the official Spotify 

and Audible programs, as well as unofficial players for 

Deezer, YouTube, Google Play Music and Apple Music. If 

you prefer something even more nostalgic, you’ll also 

find Foobar2000, DeaDBeef-vs (a minimal GTK player 

and glorious hex reference) as well as myriad text-based 

music players. Install Spotify (or whatever else takes 

your fancy) by hitting the green button.

Most applications in the Software application are 

shipped as Snap packages. You can see the delivery 

mechanism in the Source box in the top-right. Snap is 

Canonical’s self-contained packaging format which  

(like Flatpak, which is a similar effort) enables  

developers to easily ship software without having to 

worry about distro-specific packaging and which 

versions of which libraries to ship. Snaps also run in a 

confined sandbox (unless you give them permission to 

otherwise) so they can’t access any files or hardware 

they don’t need to. 

Life on the bleeding edge
Occasionally in the Source box you’ll see a variety of 

different ‘channels’ are available for a given Snap. These 

often enable you to grab a beta or development release, 

in case you want to live on the bleeding edge. System 

packages are still installed as .deb packages and there 

are still tens of thousands of these traditional packages 

you can install from the command line with Apt. These 

no longer show up in the Software application, but if 

you install Synaptic you can browse these graphically.

Canonical has put a lot of effort into making sure 

popular applications are available in Snap form. Besides 

Spotify you’ll find Telegram, Slack, Blender, GIMP and the 

PyCharm development environment for Python. There’s 

also open source versions of some classic games, 

including Prince of Persia (SDLPoP), Open Jedi Knight  

and Widelands (a Settlers clone). 

 An ad-blocker and Mozilla’s container programs are 

essential for the modern Web. And switching the default. 

search to DuckDuckGo.

Desktop choices

There are multiple flavours of Ubuntu 22.04 that include the same rock-solid 

foundation as the flagship, but with a different desktop environment. If you like 

Ubuntu but don’t like modern Gnome, then Kubuntu, Ubuntu MATE (inspired by 

Gnome 2) or the lightweight LXQt-powered Lubuntu are well worth your time. 

But rather than install a whole new *buntu, you might prefer to just add a new  

desktop to the current installation. This is unlikely to break anything, but the 

session packages we’ll install include each desktop’s core applications. So you 

might end up with two (or more) file managers, text editors and the like.

Some desktops come with their own login manager too. So for example if you 

install the kubuntu-desktop package you’ll be asked if you want to stick with 

Gnome’s GDM3 or switch to SDDM (which is built using Qt so looks more KDE-

like). There’s no right or wrong answer, and you can change your mind with  

sudo dpkg-reconfigure gdm3 . The other desktop packages are named 

similarly, so there’s ubuntu-mate-desktop and xubuntu-desktop. Most of 

these have a more slimmed-down version – for example, kubuntu-core will 

install a more minimal set of applications.
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A big change in this Ubuntu outing is that Firefox is 

only available as a Snap. This comes directly from 

Mozilla, saving Canonical a packaging burden (and 

forcing derivatives such as Linux Mint to build and 

package their own Firefox). In our testing, there was a 

delay of about 10s each time Firefox was started from  

a clean login. This is mildly annoying since the web 

browser is often the first thing one opens post-login, but 

hopefully Snap startup times will be worked on in future.

If the slow-starting Firefox (or Snaps in general) bother 

you, then you can always use the Mozilla PPA to install a 

traditional package (see https://launchpad.

net/~mozillateam/+archive/ubuntu/ppa). Or download 

a tarball from its FTP site. Or you could switch to the other 

side of the modern packaging formats debate and install 

Flatpak and Firefox from the Flathub. Your first act will 

likely be to install uBlock Origin, as well as Mozilla’s 

Facebook Container and Multi-account Container add-ons.

If you’re a reader of Linux Format Magazine you may 

remember when we looked at how Firefox worked on 

Ubuntu 21.10 (and Fedora 35), and found that the Snap 

version didn’t work at all with VA-API video acceleration. 

Happily, we were able to get it working in the new 

version, though some extra configuration is required. Go 

to about:config (noting the warning) and set  media.

ffmpeg.vaapi.enabled  to true. Later you may also want 

to set  media.navigator.mediadatadecoder_vpx_enabled  

as well, which will accelerate WebRTC (for example, 

Zoom, Teams, Jitsi) sessions. In our testing (in Firefox 98, 

99 and 100 by way of Snap channels) we had to disable 

the RDD sandbox to make it work. Since this is a security 

risk we won’t tell you how to do it here (but we’re sure 

you can DuckDuckGo it).

In that feature we also saw that both Snap and 

Flatpak versions of Firefox (and Chromium and Edge) 

can’t handle extensions which use Native Messaging. 

This is still true, so password manager extensions (as 

well as things like hardware authentication tokens) don’t 

currently work here. Both packaging formats should 

soon see a host messaging portal soon, but until then 

these add-ons will only work with traditionally packaged 

browsers. On a related tangent, KeePassXC installed as a 

Snap (or Flatpak) will integrate with such browsers, but 

you’ll need to run a script, as described on its website.

Another consequence of contained browsers is that 

the old https://extensions.gnome.org (EGO) website 

won’t work correctly. Even if you install chrome-gnome-

shell and the browser plugin. That’s okay though, for 

now you can use a third-party tool, such as Extension 

Manager, to do this. This tool is available as a Flatpak, so 

we’ll need to install that and set up the FlatHub repo 

first. You might want to do this even if you don’t care 

about Gnome extensions, since it gives you a whole 

other avenue (and tool) by which more software can be 

accessed. So open a terminal and run:

$ sudo apt install flatpak gnome-software-plugin-flatpak 

gnome-software

$ sudo flatpak remote-add --if-not-exists flathub https://

flathub.org/repo/flathub.flatpakrepo

This add support for Flatpak programs in the Gnome 

Software GUI, also installed by the first command. So 

you’ll be able to search for Extension Manager there 

after a reboot. Note that Gnome Software is distinct from 

the usual Ubuntu Software tool. It’s just called Software 

and has a shopping bag icon. Alternatively, if you’re 

enjoying the terminal the required incantation for 

installing and running (sans need to reboot) is:

$ flatpak install com.mattjakeman.ExtensionManager

$ flatpak run com.mattjakeman.ExtensionManager

You’ll see that Ubuntu uses three Gnome extensions 

(for desktop icons, appindicators and the dock) and that 

two of these can be configured. And if you navigate to 

the Browse tab you can find many more. You might 

already have some favourite Gnome extensions,  

and hopefully most of those have been updated to 

support version 42. Extensions Manager will display 

“Unsupported” if not. The popular “Blur my Shell” is 

available. Likewise GSConnect, a Gnome-centric take on 

the popular KDE Connect utility for talking to your phone 

from the desktop. 

The shortcut bar on the left isn’t to everyone’s taste, 

although fans claim it is more efficient than having it 

along the bottom. You might prefer to get rid of it 

altogether and make the desktop more like the vanilla 

Gnome you’d find in the likes of Fedora. Wherever you 

want your dock, it can be configured by starting the 

Settings application (either from the menu at the top-

right or from the Activities Overview) and navigating to 

the Appearance section. 

The screenshot shows a slightly more orthodox 

arrangement, except there doesn’t seem to be a way to 

move the Applications Grid shortcut to the left, which is 

where traditionalists might prefer to find the thing which 

most closely resembles a classical application menu. 

The new Dark Theme (which now should work 

universally) can also be enabled from the Appearance 

section of the Settings app.

Ubuntu can 

make your 

various 

workspaces 

work how you 

want them to. 

across multiple 

monitors.

 What’s up, dock? Here we’ve put the Dock at the 

bottom, removed various clutter, and made it shorter.
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W
ayland by default was tested in Ubuntu 17.10, 

but that was perhaps a little ambitious. Now 

the technology has matured and Canonical is 

confident that it’s – to dredge up an irksome phrase – 

“ready for prime time”. Extensive testing has taken place 

and the team are confident that the Wayland experience 

will be good for all. Yep, even those using Nvidia 

hardware. If it’s not, well, that’s fine. The old X11 session 

is still there. 

Wayland has been fairly misrepresented in the  

press, (who, me?–Ed) historically. The most egregious 

falsehoods were that remote desktop sessions, screen 

sharing and even humble screenshotting are impossible 

with Wayland. Do not believe such myths. The problem 

wasn’t Wayland, it was programs that didn’t support it. All 

the screenshots in this feature would not be here if that 

were the case.

One change mulled for 22.04 but which in the end 

never made it is the replacement of PulseAudio with 

PipeWire. The latter is a whole new multimedia 

framework which, as it happens, enables desktop 

sharing and screen recording on Wayland. Programs 

may still depend on PipeWire (particularly web 

browsers), but venerable PulseAudio remains the 

default sound server. If you want to change this (for 

example, if you’re having difficulty with Bluetooth 

Tweaking and rewiring
Some final edits to perfect your installation, plus a little Ubuntu nostalgia.

headsets), you can install the PipeWire session with  

 $ sudo apt install pipewire-pulse . Then if you log out 

and back in and run the command:

$ pactl info

you should see (among other lines):

Server Name: PulseAudio (on PipeWire 0.3.xx)

Additional libraries may be required for some 

Bluetooth audio codecs. Try:

$ sudo apt install libfdk-aac2 libldacbt-{abr,enc}2  

libopenaptx0

if you run into difficulties. Alternatively, seek more 

up-to-date documentation, we are unfortunately static!

Ubuntu has used Gnome as its default desktop  

since 18.04 LTS. If you pine for the Unity desktop,  

then you might be interested in the Extended Security 

Maintenance (ESM) that’s available for the previous 

LTS, Ubuntu 16.04 (Xenial Xerus). The official support 

period for this expired in May 2021, but since this 

version is still widely deployed Canonical offers paid-for 

support to organisations. This is achieved through its 

Ubuntu Advantage for Infrastructure program. Personal 

users are allowed ESM on up to three machines for free, 

so if you want to keep the Xerus alive you can now do so 

in a safe and (semi) supported manner.

We were feeling nostalgic, so we fired up Ubuntu 

16.04 on our XPS. This hadn’t been booted for some 

time, and had problems seeing our new-fangled USB-C 

dock (or the network cable plugged therein). But once 

we’d updated it, enrolled the machine in Ubuntu 

Advantage and updated again everything worked more 

or less fine. Don’t let anyone tell you nostalgia is not a 

good reason for running old software. Especially when 

you’re entitled to run three instances for your own 

pleasure. If you were looking for actual phone and ticket 

support, then this starts at $150/year for a single 

desktop installation or $750/year for a server. 

It’s not really intended to help beginners get 

their printers or Wi-Fi working. Ask nicely on 

https://ubuntuforums.org or https://

askubuntu.com for that sort of support.

Booting back into the new release  

was much quicker and smoother by 

comparison, which to be honest you’d 

expect after six years of UI 

development. This release 

might not have the kind 

ground-breaking features 

that we used to enjoy, but 

that’s probably a good 

thing. All those features 

and breaking changes 

we used to love five to  

15-years ago were a 

consequence of desktop 

Linux still being rather 

new. Now that Ubuntu’s 
 One thing that was quite hard to screenshot (but for once not because of 

Wayland) was the new screenshot tool. Oh the irony!

WE’RE IN GNOME’S GOLDEN AGE
“The stutters and memory leaks 
that dogged Ubuntu Gnome’s 
performance for so long are well 
and truly gone.”
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Latterly there seems to have been a bit of a 

trend for Linux-leaning social media channels 

to announce they’re “no longer 

recommending Ubuntu” or other such things. 

Reasons are varied, we suppose, but the 

triumvirate of Snaps, Wayland and Gnome 

don’t seem to be to everyone’s taste.

We’d still heartily recommend Ubuntu to 

anyone, beginner or otherwise – as it “just 

works”. Even if you don’t like it, as we’ve seen 

it can be customised, extended or otherwise 

bashed around to your taste. Lots of the 

distros these channels recommend in 

Ubuntu’s stead are themselves based on 

Ubuntu – for example Linux Mint, Pop!_OS 

and Elementary OS. All great distros that offer 

something which is hard to recreate on 

Ubuntu Linux, but ultimately distros that 

depend on its packages, infrastructure  

and documentation. 

Until now, perhaps…

Mint’s latest Debian Edition (LMDE5) is 

rapidly gaining traction. Pop!_OS has moved 

its PPA repositories away from LaunchPad 

and is working on a new Rust-powered 

desktop environment (with a view to moving 

away from Gnome). And Elementary OS has 

had its own app store for ages and has 

likewise sided with Flatpaks over Snaps. In 

sum, if Ubuntu doesn’t do it for you, there 

are plenty of derivatives you can switch to 

without having to learn a whole new way  

of working. 

We’re excited to see more people trying 

Fedora. It’s now more accessible, particularly 

as regards installing non-free software. 

Together with its rapid release cycle this  

makes it a great platform for gaming. Well 

worth checking out if Ubuntu is no longer 

serving you.

desktop is established, like it or not, 

it doesn’t make sense to go 

changing it. Instead, we should take 

comfort in the fact that after four 

years of using Gnome for its flagship 

desktop, the experience is now 

second to none. The stutters and 

memory leaks that dogged Ubuntu 

Gnome’s performance for so long 

are well and truly gone.

A common Theme
Gnome themes have come under 

the spotlight since the introduction 

of GTK4 (inaugurated with Gnome 

40). Did we say themes? Ah, we 

meant theme, because custom 

theming of Gnome applications is 

now verboten. The default GTK3 

theme was called Adwaita, a Sanskrit 

word often translated as ‘the only one’, (literally ‘not 

two’). But it wasn’t really the only one, because 

developers could happily write their own CSS stylings. 

In GTK4 this theme has been promoted to a platform 

library, libadwaita, which Gnome developers say will 

guarantee conformance with their Human Interface 

Guidelines. And (like the characters often say in 

Highlander) there can be only one. GTK3 applications 

will still respect custom themes, but GTK4 ones will only 

support the limited changes (for example, background 

and accent colours) permitted by libadwaita. 

For Ubuntu 22.04 this might be bad news, because 

at present it uses a mix of Gnome 42 applications 

(libadwaita-based) plus some from older releases (such 

as Files, which is based on GTK3 and libhandy). This 

may change prior to release, otherwise there are going 

to be some cosmetic inconsistencies. If this bothers 

you, then you might want to run away from Gnome 42 

for the next little while, in which case there are some 

suggestions in the box (see below).

 Menus in 

titlebars. Amazon 

search results in 

the HUD. Ubuntu 

16.04 had some 

crazy ideas!

The old Gnome Tweaks tool is still available in the 

repo, but like the EGO website it can no longer manage 

Gnome extensions. That’s okay, because it can do most 

everything else, including cleaning up the mess our 

Gnome fonts ended up in post installation of KDE 

Plasma. Tweaks also enables you to manage startup 

programs, change titlebar button visibility (or move 

them to the left, MacOS style) and adjust legacy 

theming. You can install Tweaks with:

$ sudo apt install gnome-tweaks

This will install a different Extensions tool, currently 

in beta form. At the time of writing this doesn’t let you 

install new extensions, otherwise we could do away with 

the previous tool. For even more tweakability, try Just 

Perfection, found in Extension Manager. It allows for 

parts of the shell theme to be overruled (including 

removal of the top bar) to make matters more minimal. 

We don’t go for Gnome extensions ourselves (despite 

having two programs for managing them), let us know 

what we’re missing out on. Enjoy Ubuntu 22.04! 

Looking elsewhere?

 Fedoras and the distribution of that 

name are all the rage right now.



Introducing the
Ubuntu desktop
Ubuntu’s desktop might seem a little alien to new users, 
but it’s very easy to get the hang of.

L
ike Windows, the desktop of Ubuntu 

is where you’ll spend most of your 

time. It’s where you can open your 

programs and interact with them, and you 

can also customise your desktop with 

wallpaper backgrounds. However, while the 

Ubuntu desktop and the Windows desktop 

share some things in common, there are 

also many differences between them. Once 

you get used to it, though, you’ll find that 

the Ubuntu desktop isn’t just easy to use, 

but it has loads of great features that will 

make you quickly forget about Microsoft’s 

way of doing things.

When you first load up the Ubuntu desktop, 

you’ll see the Launcher menu, which runs 

down the left-hand side of the screen. This 

is where you can quickly access all of your 

favourite apps. Pre-installed apps such as the 

Firefox web browser and Libre Office appear 

here, and you can add other programs by 

searching for them and dragging their icons on 

to the Launcher bar.

To search for programs, files and more on 

your PC, you need to use Dash, which can be 

opened by clicking on the Ubuntu icon at the 

top of the Launcher. Once Dash is open, you 

can simply type in the name of what you are 

looking for, and Dash displays the results. One 

of the best things about Dash is that it doesn’t 

just search your PC; it can also offer up 

suggestions from the internet as well.

If your searches are bringing back too many 

results, you can choose what sort of files or 

programs you’re after by clicking on one of the 

icons along the bottom of the Dash screen, 

which bring up so-called Lenses, which filter 

your results. For example, you could search 

your applications, documents, videos, music or 

photos individually.

File management
Below the Dash icon on the Launcher is the 

Files icon. This opens up Ubuntu’s file manager, 

which is a lot like Windows Explorer. Here you 

can easily find, open and modify your files and 

folders directly from the Ubuntu desktop. As 

with Windows, Ubuntu helps you keep things 

organised by creating folders such as 

Documents and Music to store your files.

On the Launcher menu, you’ll also see an 

orange shopping bag icon with a letter A on it. 

Clicking this opens up the Ubuntu Software 

Center, which enables you to find, download 

and install new applications for Ubuntu. We 

take a more in-depth look at the Software 

Center later in this bookazine.

Underneath that is an icon for Amazon, 

which takes you to the popular online store. Its 

inclusion is a little contentious among Linux 

users, so if you don’t like it being there, right-

click on the icon on the Launcher menu bar 

and select Unlock From Launcher.

Beneath that is the Settings shortcut, which 

opens up Ubuntu’s settings. From this window 

you can alter the way Ubuntu behaves, and 

with some careful tweaking, you’ll be able to 

get the operating system working exactly how 

you want it to.

You’ll also occasionally see an icon with a 

big A and a circle of arrows. This lets you know 

when there are updates for Ubuntu. Although 

Ubuntu (and Linux as a whole) is a lot more 

secure than Windows, it’s worth keeping it 

updated to make sure any security flaws or 

performance issues are fixed.

Finally, at the bottom is an icon of a trash 

can. This works in exactly the same way as the 

Recycle Bin in Windows, so if you delete a file 

that you later want to restore, check here 

before you tear your hair out. 
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Ubuntu settings

Clicking Settings on the Ubuntu desktop enables you to customise your PC.

Appearance
Ubuntu is an attractive 

operating system, but if you 

want to tweak its look and 

give it a personalised feel 

with your own desktop 

background, click here to 

change its appearance.

Power
If you’ve installed Ubuntu on your 

laptop, then the Power settings are 

essential, because they can help you 

preserve the battery life of your 

device when it’s not plugged in.

User Accounts
If you share your Ubuntu machine with 

other people, you can create extra user 

accounts for everyone, which lets them 

configure Ubuntu the way they want, 

without messing with your own settings. 

It also keeps their files and folders 

separate from your own.

Brightness & Lock
If you want to save energy and 

have your monitor power down 

when you’re not using your PC, 

click here to set when to turn off 

your screen, as well as making it 

necessary to enter a password to 

unlock your PC.

Displays
This enables you to change the 

resolution of Ubuntu to better suit 

your screen. If you have more than 

one monitor, you can also select the 

order they display Ubuntu from this 

screen as well.

Backups
This setting enables you to set up a 

schedule for Ubuntu to back up your 

files and settings. This is great if 

something goes wrong and you need 

to restore your machine to a previous 

working version.
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to Settings > Appearance and you’ll see controls for switching 

wallpaper, with 14 images supplied (you can add your own 

pictures by clicking the + button – remember to make sure 

the image is at least the size of your desktop resolution). If 

you’d rather set a plain or graduated colour background, click 

the ‘Wallpapers’ drop-down menu and choose ‘Colours & 

Gradients’ – choose the type of effect first, 

You’ll also see a Theme drop-down menu for making 

changes to the design and colour of windows and menu bars. 

Three themes are provided: just select one and the desktop 

will instantly update to that theme. The choice is rather 

restrictive, but the good news is that you can download more 

themes online. You can’t apply these using Appearances, but 

the powerful Unity Tweak Tool allows you to do this as well as 

apply other customisations not supported by Ubuntu’s 

Settings panel. See the box for more details, and keep an eye 

out for more references throughout this tutorial.

You’ll find many themes online, but a good place to start is 

www.ubuntuthemes.org. It applies a registration and 

checkout process for obtaining and downloading themes, but 

most are completely free; simply browse for those you like 

and add them to the cart. Once through checkout, a link to a 

compressed archive containing the theme’s files is provided, 

which you can click to download to your Downloads folder. 

The contents of the archive need to be extracted to the  

/usr/share/themes folder – this requires elevated access, 

so open Terminal and type the following:

$ cd Downloads

Then, if the file extension is .tar.gz, type:

$ sudo tar xf filename.tar.gz -C /usr/share/themes

If you have downloaded a zip file instead, use the following 

command instead:

$ sudo unzip filename.zip -d /usr/share/themes

In both cases, substitute ‘filename’ with the actual name 

of the file. Once extracted, open Unity Tweak Tool and select 

The Desktop
We reveal how to give your Ubuntu desktop a makeover, plus tweak its 

settings to better suit the way you work and make it your own.

U
buntu’s Unity desktop is a radical departure from 

many Linux desktops in that it doesn’t attempt to 

emulate the bog-standard Windows user interface 

with a taskbar running along the bottom of the screen 

complete with Start menu. Nevertheless, there are still plenty 

of common elements that make it reasonably intuitive to 

grasp. Once you’ve familiarised yourself with the basic layout, 

you’ll no doubt be itching to give it your personal touch. 

As you’d expect, Ubuntu can accommodate just about any 

type of tweak you’d like to throw at it. Some of these can be 

applied from within Ubuntu’s own Settings panel, but if you 

find its limited set of tools restrictive, we’ll show you how to 

use a more powerful tool to take things to the next level.

The most obvious form of customisation is to change the 

background wallpaper and change other desktop elements 

like windows and menu bars in terms of colour and font. Go 

If you don’t like 

Launcher’s default 

place, you can move 

it using the Unity 

Tweak Tool. Launch 

the tool and select 

Appearance, then 

choose ‘Bottom’ 

under Position to 

have the Launcher 

run along the 

bottom of the 

screen instead.

Quick
tip

The Unity Tweak Tool
If you want to take your desktop customisation to the 

next level, open the Software Centre and search for 

‘unity tweak tool’. This powerful free app gives you 

much greater control over the look, feel and 

behaviour of the Unity desktop.

Once launched you’ll see it closely resembles the 

Settings tool, with a series of icons split into various 

sections. Select Launcher and you’ll see it mirrors all 

the options found under Settings > Appearance, plus 

adds more of its own (see the Top Tip above). Switch 

to the Search tab to tweak both the Dash’s look and 

behaviour, or customise the main menu bar from the 

Panel tab, including making it semi-transparent and 

choosing which elements appear in the top right-

hand corner of the screen.

There’s a whole section dedicated to Unity’s 

window manager – choose ‘Window snapping’ to 

determine how windows behave when snapped to the 

sizes or corners of the screen, and Hotcorners to 

create hotspots for switching workspaces, toggling 

desktop view and spreading windows. Use the 

Additional tab to control behaviour when double-

clicking title bars.

The tool also gives you more granular control over 

themes, allowing you to mix and match icon sets, 

cursor designs and fonts. One final highlight is 

‘Desktop Icons’, which allows you to place your choice 

of Home Folder, Network, Rubbish Bin and connected 

device icons (such as removable drives) on the 

desktop for quick access.

 The Unity Tweak Tool gives you 

far greater control over how your 

desktop is customised.

 Spread your cluttered application windows across four (or more) virtual 

desktops to make them easier to manage.
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Theme under Appearance, where you should find your new 

theme is available to switch to.

Customise the Launcher
Install a new app from the Software Centre, and its icon will 

automatically be pinned to the Launcher. Other icons will 

appear temporarily while an application is running, then 

disappear when the app is closed – you can make these 

permanent fixtures by right-clicking the app icon and 

choosing ‘Lock to Launcher’. Unwanted icons can be removed 

by right-clicking and choosing ‘Unlock from Launcher’.

You can rearrange icons simply by clicking and dragging 

them up and down the Launcher to their desired location – 

you’ll see the other icons helpfully shift to make room. Let go, 

and the icon moves to its new home.

If you find the Launcher distracting, open Settings via its 

Launcher icon and choose Appearance. Start by changing the 

size of the icons displayed on the Launcher using the 

‘Launcher icon size’ slider – to fit more on, decrease the size.

To go further, switch to the Behaviour tab and flick the 

‘Auto-hide the Launcher’ switch to On. The Launcher will 

vanish, only appearing when you drag the mouse over to the 

left-hand edge of the desktop – use the ‘Reveal sensitivity’ 

slider to tweak how quickly the Launcher will pop up, or 

change its trigger area to the top-left corner of the screen if 

you prefer by selecting the appropriate radio button. Tick the 

‘Add show desktop icon to the launcher’ box if you’d like to be 

able to clear the clutter with a single click (it works like 

Windows: all app windows are minimised on the first click, 

then click again to bring them back).

Virtual desktops
If you frequently have three or more app windows open, your 

desktop can soon start to feel a little cluttered. If you’re 

looking to keep things relatively clean, or introduce a 

secondary layer of organisation, you need to look at Ubuntu’s 

workspaces feature. Workspaces are virtual desktops, and 

you can drag and drop application windows between them to 

free up space on individual desktops or to group related 

applications together (for example, your email, chat and 

Solitaire apps for those work break moments).

To enable workspaces, go to Settings > Appearance > 

Behaviour tab and tick ‘Enable workspaces’ and a new button 

will appear in the Launcher. Click this (or press the [Win] + 

[S] keys) and the screen divides into four. Drag open windows 

from one virtual space to another to move them, then click 

the desktop you wish to jump to. The Launcher remains in 

place across all windows, so simply click the Workspaces icon 

again to access this screen to switch back.

The beauty of workspaces is that the Launcher remains 

consistent across all your desktops, so you can easily switch 

between apps on different desktops by clicking the app icon 

in the Launcher – Ubuntu will then magically switch to the 

correct desktop. You can also move between desktops by 

holding the [Ctrl] + [Alt] keys and pressing the cursor keys to 

move around – a mini thumbnail of all four desktops will 

appear on-screen to guide you to the desktop.

Four virtual desktops should be enough for most people, 

but you can increase this number if you’re the type of person 

who has multiple apps open at once. When you invoke the 

workspace switcher you’ll see the desktops are arranged in a 

square table, equating to two rows and two columns. To 

increase the number of available virtual desktops, use the 

Unity Tweak Tool – click ‘Workspace Settings’ under ‘Window 

Manager’ to increase the number of available desktops by 

adding extra rows or columns to the workspace manager.

And there’s more…
One of Ubuntu’s quirks is that the window controls – such as 

minimising, maximising or closing the window – aren’t 

displayed on the window’s title bar itself, but appear in the 

main menu bar at the top of the screen when you roll the 

mouse over it, along with an application’s menus. If you’d 

rather the controls were placed within the in-app menu bar 

instead, go to Settings > Appearance > Behaviours tab and 

select ‘in the window’s title bar’. Finally, select ‘Always 

displayed’ to force a program’s menus to be permanently on 

display instead of only appearing when you roll the mouse 

over the menu bar.

One last tweak: if you’ve got two or more displays set up, 

head over to Settings > Screen Display to customise how 

they work – you can choose to mirror displays or (more likely) 

extend the screen display between both monitors. Click and 

drag the displays into the desired placement based on their 

physical location (so the left-hand display sits on the left, for 

example). Most controls are logical, but the Sticky Edges 

feature (on by default) refers to whether or not to maximise 

windows by dragging them to the edge of the screen – if you 

don’t like this behaviour, flick the switch to off. 

Scale your display
If you’re fortunate enough to own a 

high-DPI display such as a 4K monitor, 

you’ll need to tweak settings to make 

the display comfortable to read. Start 

by going to Settings > Screen Display 

and experimenting with the ‘Scale for 

menu and title bars’ slider to make the 

menus and title bars more readable. 

Now go back to All Settings and select 

Universal Access. Flick the ‘Large Text’ 

switch to On. Switch to Appearance and 

scale up your Launcher icons using the 

‘Launcher icon size’ slider. Finally, if your 

cursor is too small, open Unity Tweak 

Tool and tick ‘Use large cursors’ in the 

Cursors section of the tool.

 Give your 

desktop a more 

radical makeover 

by applying a 

new theme to it 

alongside other 

Unity Tweak Tool 

enhancements.

 Use the Settings to adjust how Unity works.
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modern phone. The whole process is seamless. Apple has 

brought the system to Mac OS X, and Windows converts  

may know that Microsoft has been trying a similar scheme 

since Windows 8: the Microsoft App Store. Cynically, you 

might look at that as a way for Microsoft to control its 

software ecosystem, and you’d probably be right to be 

cynical, but it’s also a way to get hold of (some) programs 

without the hassle – and potential danger – of downloading 

random things from the internet. It makes sense. It hasn’t 

really worked, but the theory is sound.

Ubuntu’s desktop package manager is called Software 

Centre. It accesses a number of sources – known as 

repositories – to grab the right version of your chosen 

program for your computer. Or at least it does for now – 

Ubuntu will soon be replacing it with an alternative, GNOME 

Software, in the 16.4 release of Ubuntu. But for now, let’s look 

at how you might use Software Centre to download, install 

and remove software – GNOME Software’s interface and 

philosophy barely differ, so this will stand you in good stead.

Central reservation
As you can see from the annotation above right, there’s not 

really an awful lot to Ubuntu Software Centre’s core interface. 

A big categorised list of software, buttons so you can see 

what’s available, installed, what you’ve done and how 

downloads and installations are getting on. The key element 

for us is the search box at the top right of the window. It 

doesn’t only search by software names – handy, considering 

the baffling monikers of most Linux packages – but by 

descriptions, too. So, for example, if we wanted to find  

a game, we might search, yes, ‘game’. And everything with 

‘game’ in its title, short description, and long description will 

pop up. Obviously that’s a very broad example, but imagine 

you’re looking for a new email client: it makes a lot more 

sense to type ‘email’ and find what you’re looking for than it 

does to type ‘MBoxImporter’.

Teeth-grindingly annoying nomenclature aside, then. Let’s 

install something. And why don’t we get a bit meta? Before 

Software Centre, Ubuntu featured a program called Synaptic 

Package Manager, which we’d wager will still be available  

after the move to GNOME Software. It does the same things 

Programs:  
How to install 
new software
Getting fresh programs onto your Linux system is, despite what you may 
have heard, utterly straightforward, foolproof and safe. 

Y
our Linux system comes pre-installed with a whole 

host of useful applications and software, but there 

will come a time – there always does – that you want 

something new. There are various complex ways of getting 

hold of new things, and perhaps they’ll be routes you explore 

later on in your Linux life. For now, there’s a much easier way 

to find new programs for your computer: a package manager.

Package managers deal with everything for you. They 

retrieve the very latest versions of your desired software  

from the internet. They sort out any dependencies – items 

your computer might be missing – that are required for  

you to be able to run that software. They install everything 

automatically. And, once your software is firmly ensconced in 

your PC, they deal with the process of upgrading or removing 

it later on. You never have to get your hands dirty. And, all 

being well, everything will work perfectly first time. 

You might have come across something similar on your 

smartphone. Apple’s App Store and the Android Play Store 

are each examples of package managers – it’s unlikely you’ve 

ever had to manually download and install any apps on a 

 Installing software requires that you have admin rights to your system – it’s  

a good way of stopping other users from installing software you don’t want!

You can also 

install software 

from Ubuntu’s 

dashboard. Click 

the search button 

at the top of the left 

hand bar, the apps 

icon at the bottom, 

and search for what 

you want. 

Quick
tip
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 Otherwise-redundant dependencies will be automatically removed when you 

uninstall packages – and sometimes you’ll have to remove additional things too.

Most graphical 

package managers 

are just a front-end 

for terminal apps 

like apt-get, which 

you can use directly. 

We have more on 

this starting on p60.

Quick
tip

Inside the Ubuntu Software Centre

Categories
Once you’ve chosen a category in All Software, 

that category’s subcategories are displayed, 

meaning you can drill down further to the 

software you really want.

Everything
To return to the main menu of Software 

Centre, click this button. You can also use 

its menu to select where the software 

comes from – official Ubuntu releases or 

from Canonical’s partners.

See it all
Wondering just what there is to choose from in 

your current category? Click here to see the 

whole confusing list.

Past tense
What has Software Centre actually installed? 

Not just the big packages, but the little ones? 

The history page will let you know.

Top picks
The best (or at least the highest rated) apps in each 

category are listed here along with their average 

ratings and number of reviews (in brackets).

Search bar
Searching is vital if you’re not sure of a package 

name, or not sure what category your chosen 

package is in. Just type in here and hit [Return].

(searching for packages, fixing dependencies, upgrading and 

the like) with a lot more information on hand. Perhaps it’s not 

the best for Linux newcomers, but it’s handy to have around 

when you take the next step. 

Typing ‘package manager’ into the search box doesn’t do 

us an awful lot of good. Synaptic is in the list, sure, but it’s not 

easy to find. So hit ‘All Software’ and let’s see if we can find it 

in a slightly more organic way. It’s actually nestled in the 

typically opaque category ‘Themes and Tweaks’, so click that 

in the left hand column of the main page and you should see 

it listed in the top rated section of the window that follows. If 

not, click the All button at the top and you should see a much 

more manageable list.

Actually Installing
Click on Synaptic Package Manager and you’ll see a host of 

information about it, a link to its web site, a screenshot (isn’t it 

pretty?) and, on the right, an Install button. Before you go 

ahead and click it, scroll down a little – Synaptic comes with  

a host of add-ons that you might be interested in, and these 

can be installed simply by marking their individual check 

boxes. Scroll a bit further and you’ll find reviews of the 

package – very useful if you’re installing an unknown bit of 

software, as fellow users are rarely shy about sharing negative 

experiences – and Software Centre doesn’t exactly have a 

stringent cruft filter – so these can be a big red flag in a lot of 

cases. When you’re ready, hit Install. Type your password, hit 

Authenticate, and Software Centre will do the rest.

Head to the History panel to see what changes have 

actually been made. You should see that a package called 

synaptic has been installed, but look at items installed at  

a similar time; the list will include a host of Synaptic’s 

dependencies that have also made their way onto your 

system without you having to lift a finger. Beyond the finger 

you used to click the install button, that is.

Once removed
Let’s reverse the process, while we’re at it. Click the Installed 

button at the top of the window to find a list of software 

divided by category. We know that Synaptic Package Manager 

is in Themes and Tweaks, so click the arrow to the left of that 

category to expand it and find Synaptic in the list. Click it once 

and you see a pair of buttons appear – More Info, which is 

especially useful if you’re weeding your system and can’t 

remember what a particular bit of software actually does, and 

Remove. Click the latter.

If applicable, Software Centre will now warn you of things 

which also must be uninstalled at the same time. In this case 

it’s a package called update-manager, which we can reinstall 

later using the same technique we used to install Synaptic 

Package Manager. Click Remove All, enter your password,  

and the removal will happen – check the History tab for 

confirmation. Now go ahead and experiment with Software 

Centre. Install some games, remove some of the default  

apps, go crazy!  
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Libre Office (MS Office)
Don’t worry about missing Microsoft Office when you jump to Linux, 

because Libre Office does everything that Microsoft’s office suite can, 

but it’s less bloated, doesn’t have the annoying Ribbon interface and, 

best of all, it’s completely free.

GIMP (Photoshop/Paint)
If you’re a keen photo and image editor, then GIMP should definitely  

be on your list of apps to download. It’s simple enough to replace 

Microsoft Paint, but also has enough depth to give Photoshop a run  

for its money.

Audacity (Audio editor)
If audio editing and music creation are more your thing, Audacity is an 

excellent replacement for professional tools such as Cubase and 

Sibelius. Even if you’re not particularly musically talented, Audacity is 

handy for editing voice memos and other sound files.

Thunderbird (Outlook)
Do you use Outlook to manage your emails in Windows? Then you’ll 

want to install Thunderbird, which is an incredibly versatile desktop 

email client. Like Firefox (they are both created by the same company), 

you can install add-ons to tailor it exactly to your needs.

Firefox (Internet Explorer)
You won’t find Internet Explorer on Linux (which some people would 

say is a good thing), but handling the web browsing duties by default 

on many versions of Linux is Firefox, which is faster, more secure and 

allows you to install add-ons to improve its functionality.

VLC (Media Player)
If you use Windows Media Player or a third-party application such as 

Cyberlink PowerDVD, you can use VLC to solve all your media-playing 

woes. It’s much more flexible than WMP and can play a huge variety of 

media files, and unlike PowerDVD, it’s completely free.

Twelve Linux replacements for   
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Gtkpod (Apple iTunes)
Got an iPhone or iPod? You might be worried that because you can’t 

get iTunes on Linux, you won’t be able to sync your music with your 

device, but never fear, because Gtkpod can help you manage your 

iPod and iPhone library.

Amarok (Media Player)
Do you use iTunes or Windows Media Player to just listen to music? 

Then you’ll want to get Amarok, which will help you organise and listen 

to your digital music collection on your computer. It can also help you 

import and export music to your MP3 player.

Evince Viewer (Acrobat reader)
PDF is one of the most prevalent file types online, and just because 

Linux doesn’t have Adobe Reader, you’re not left out. Evince Document 

Viewer is faster, lighter and does everything Adobe’s software can. It’s 

also installed by default on many Linux distros.

OpenShot (Movie Maker)
For any budding directors out there – don’t worry about the lack of 

Windows Movie Maker or Sony Vegas and the like, because OpenShot 

is a versatile and powerful video editor that will help transform your 

home movies when using Linux.

K3b (CD/DVD writer)
If you use Windows Explorer or a third-party program such as Nero 

Burning ROM to write CDs and DVDs with your own data, then K3b is 

an excellent alternative that does the job just as well, and once again 

it’s completely free.

F-Spot (Image Viewer)
For organising your photos, tagging them, making light edits and then 

sharing them with the world, F-Spot is the perfect replacement for 

Windows Image Viewer. This is the ideal program for photographers 

with hard drives bursting at the seams with digital snaps.

  common Windows programs



34  |  Linux Format Presents: Ubuntu

Linux apps

rip CDs, add album art to digital files automatically, purchase 

songs online and stream from another PC or network 

attached storage. 

Before you start using Rhythmbox, however, there’s one 

important thing you’ll need to bear in mind. By default, 

Ubuntu doesn’t include the software codecs required to 

playback the common MP3 format which many people use to 

store songs diigtally. Because many parts of the MP3 codec 

are still protected by patents, Linux distributions are unable to 

include it as standard without paying a licence fee. 

Fortunately, the way around this is simple. Open up the 

Ubuntu Software Centre and search for “Ubuntu Restricted 

Extras”. If it’s not installed yet, click to download and there’s 

little your PC will left unable to play. 

Back to Rhythmbox, and the first time you open it up  

you’ll want to point it at the place where you keep your song 

files stored in order to build up its library list. Open up the Edit 

menu and click Preferences, then Music. Click the Browse 

button to direct Rhythmbox to your Music library folder if it’s 

not the default one, and then put a tick in the box “Watch  

my library for new files”. Now any songs and albums in your 

library will be added to the Rhythmbox home screen, and  

any time you rip a CD, purchase music through Rhythmbox  

or add music from a portable player it’ll be saved to the  

same physical place. 

You’ll also see options in this screen to select the  

format and quality for ripping music, and also for the  

naming convention you prefer in filenames that are 

automatically generated. 

Once you’ve loaded some music up, the main view for 

Rhythmbox is fairly straightforward (see boxout above).  

You’ll notice that the column on far left is pretty sparse 

initially, with some basic library options for selecting music, 

podcasts (see boxout) or internet radio stations. You can  

also see what’s coming up in the play queue.

To start adding extra options here, you’ll need to visit  

the Plugins menu, which you’ll find if you click on Tools in  

the menu bar. 

Rhythmbox comes with extra features which are  

disabled by default. In this menu you can turn extras such  

as Last FM scrobbling and the Jamendo music store. The 

selection of plugins is fairly limited initially, but you can add 

more with ease. 

The one essential plugin to install is the Grilo suite, which 

will enable you to stream from other computers and libraries 

on your network. If Grilo isn’t already installed, open up the 

Software Centre and search for grilo-plugins, then install the 

Rhythmbox: 
Playing media
Get your music collection blasting from your speakers and super-organised, 
then watch some videos too, it’s all in a day’s work for Ubuntu!

R
emember the days when we used to buy CD players 

with built-in radios, or cassette tapes for listening to 

our music? No? You’re not alone. When it’s possible  

to carry around a lifetime’s worth of tunes on your phone, and 

stream audio wirelessly to your TV or HiFi system wirelessly, 

why on Earth would you invest in something so archaic? 

We’ll wager everyone needs a good media player on their 

desktop, however. Whether it’s to enjoy music or internet 

radio while you work, or watch a movie on your laptop while 

travelling by train, digital media should be enjoyable 

whenever, wherever and however you need it. 

And fortunately, Ubuntu has all the tools you need for 

playback built-in. If you’re coming from Windows, there is one 

key adjustment you’ll have to make. Microsoft’s operating 

system comes with the all-encompassing Windows Media 

Player built-in, which is a hub for both music and video played 

back from a local source – like a hard drive or USB key – or  

a networked drive. For entertainment purposes, Ubuntu has 

separate applications for video and music playback.

For music, that application is Rhythmbox, which can 

manage your audio library, stream from remote services or  

a household server, and rip CDs directly to your hard drive. 

For video, the Totem player – which appears in the Unity 

launcher under the name Videos – serves similar purposes.

Living in a Rhythmbox
As far as audio goes, Rhythmbox is as fully featured as you 

need. It can be used to playback music from a local library,  

 Probably the 

best Ubuntu 

video player, VLC 

is a must-have 

install.

When it comes 

to online music, 

there’s a desktop 

client for Spotify 

that can be added 

to Ubuntu and 

Google Play Music 

works through the 

browser. Netflix can 

be accessed if you 

install the Chrome 

browser, or use the 

User Agent Override 

add-on in Firefox.

Quick
tip
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Base package from there. Enabling this in the Rhythmbox 

Plugins section should result in any shared libraries on your 

network popping up in the left-hand menu. 

Totem-ic 
While Rhythmbox is reasonably well featured, Totem – the 

video player – is less so. It’s fine for playing back videos 

selected directly from the file browser, but as a library 

manager it doesn’t really cut it. You can add videos one by 

one, but there’s no option to import a whole folder of videos 

or to automatically detect UPnP servers on your network. 

Totem does have one very useful feature though. If you 

open up it up by selecting Videos from the Unity launcher and 

click the Channels option at the top of the screen, you’ll get  

a selection of web videos including the latest movie trailers 

from Apple. You can add more from the Plugins menu.

For videos, we’d recommend installing VLC. It has a 

reasonably good library manager, and is also more bulletproof 

when it comes to playing back odd file formats than Totem. 

Plus, it handles remote libraries over UPnP well. 

The best all-round media manager, though, is arguably 

Banshee. If you’re moving from Windows and want something 

that looks and feels like Media Player, this is certainly worth 

downloading and trying out. It handles music, video and UPnP 

better than the default apps, plus it can connect directly to 

the Amazon music store. 

One thing that Ubuntu is very good at, however, is 

controlling your music or video while the player app is in the 

background. Once a song is playing in Rhythmbox or Banshee 

(or even Spotify) just click on the volume icon in the task bar 

and you’ll get per-app volume controls and full playback tools 

without having to re-open the app itself. 

 A good alternative to Rhythmbox, Amarok includes a more colourful interface and more add-ons. 

Rhythmbox will 

automatically check 

for and download 

your favourite 

podcasts. Go to 

Podcasts > Add 

and you can search 

the iTunes and 

Miroguide libraries, 

or add your own 

via RSS. 

Quick
tip

Exploring the Rhythmbox interface 

Library
From here you can select local libraries, 

UPNP shares, internet radio or podcasts. 

Album art
Rhythmbox will automatically pull album art 

from the net, but you might have to  

set-up the plug-in first. 

Add a source
The plus and minus buttons let you add a 

source for you library. This can be a folder 

on your hard drive, a URL or a shared drive.

Play queue
This list tells you what’s up and 

coming on your playlist.

Artist list
On the left is the artist list, on the right their 

albums and in the main window a track listing. 
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used by professionals. Don’t be put off though, it’s easy to get 

a grasp of the basics. 

The first thing you’ll notice is that not one but three  

windows have appeared on your desktop. In the classic 

layout, you’ll find the tools menu in a thin window on the left, 

the main workspace in the middle and a window for extra 

controls like layers, colour channels and brushes on the right. 

It can be tricky at first to work in three different windows 

simultaneously, and there’s an option to display everything in 

one Window if this is putting you off. Just go to Windows and 

tick Single Window Mode. This will give you a simpler layout 

that you may be more accustomed too. 

If you can bear with it, however, we’d strongly advise 

sticking to separate windows for all the docks. It allows you  

to create a working area on your desktop that’s exactly 

customised for your needs, and if you have more than one 

monitor you can put the tools on one screen with the image 

full width on another.

Colour correction
Gimp is, as we’ve said, a very powerful piece of software. It 

includes tools for cutting out parts of an image, creating layer 

masks, the classic clone and heal brushes loved by art editors 

for removing traces of humanity from a model’s skin and  

a wide range of filters and plug-ins – plus support for more – 

for adding effects and punishing pixels into submission.

To get you started, though, here’s an easy exercise in 

brightening up an underexposed photo. First, you’ll need to 

get your photo into Gimp. A quick note – while Gimp does 

support RAW files from cameras, we wouldn’t recommend it. 

Better to convert your image to JPG, TIF or PNG first.

Now you can open your pic up just by dragging its icon 

from the Files browser over the Gimp launcher or into the 

workspace itself if Gimp is already running. You can also open 

an image using the File menu if you prefer.

Our underexposed image is a little dark, but we’re not just 

going to increase the brightness. That would be crude and 

have the effect of removing some of the dynamic range 

leaving you with a flat, washed out looking shot. We want to 

try and keep rich shadows and preserve as much detail 

without leaving the picture looking washed out.

The way to do this is to click on Colours and select Levels. 

This is the tool that professionals use to correct exposure. 

What you can see is a histogram which describes the “tonal 

range” of your image. The left side of the graph represents  

the amount of pixels in dark areas areas of the shot, and  

the right side light.

Gimp: Editing 
photographs
Think you need professional tools to do a professional job? Think again: Linux 
includes the best free photo editor around.

T
here’s one name which dominates digital photo 

editing all around the world. Adobe, and more 

specifically its Photoshop package, has been so 

popular for so long it’s synonymous with the task and has 

become a verb. To “Photoshop” a picture is the same as 

conflating “to Google” for internet search or “to Hoover” for 

vacuuming the floor.

The bad news is that the vast majority of Adobe products 

aren’t available on Linux operating systems. Photoshop 

certainly isn’t and probably never will be. 

Is that it then? The joys of Ubuntu and its ilk are not for 

photographers or those who like to tweak and digitally 

develop their snaps before sharing them with the world? 

Of course it doesn’t. 

Get your Gimp on
We’d wager that even on Windows most people who 

“Photoshop” their pictures aren’t using Photoshop. It’s  

an expensive piece of software after all and there’s lots  

of alternatives. One of the best, which is available on  

Windows and Linux, is the wonderfully named GNU Image 

Manipulation Program.

Gimp is astonishingly powerful, so much so that it really is 

almost as feature rich as Photoshop and certainly as capable 

for almost every task. It’s installed by default in Ubuntu, but if 

you don’t have it you’ll find it in the Software Centre. 

When you first open Gimp up, it can be a little intimidating. 

This is a professional piece of software and designed to be 

 The Levels dialogue is the first port of call for photo fixing. 

For those who like to 

shoot in RAW mode 

on their cameras, 

there’s two 

excellent options 

for processing on 

Linux. Darktable is 

a fully open source 

RAW editor you’ll 

find in the Ubuntu 

repositories, 

while Corel’s 

AfterShot Pro is 

a well supported 

commercial 

contendor.

Quick
tip
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You’ll notice three markers under the graph: one at either 

end and one in the middle.A well exposed shot will have 

readings all the way along the tonal range, depending on the 

contrast in the image captured. If a photo is underexposed, 

however, all the readings will be bunched up at the left- 

hand side of the graph with a flatline towards the right.  

The best way to correct this is to drag the marker from  

the right towards the area where the tonal values kick in, 

reducing the tonal range of the image to those values  

that have readings. 

If you’re lucky, this will brighten the picture without 

destroying detail. Because the midpoint will also 

automatically adjust, it should retain a good contrast too, 

which merely changing the brightness would wash out.

As if that wasn’t enough, this single tools can also act to 

correct the “white balance” of your picture. If you’ve taken a 

photo indoors, for example, you might have captured a yellow 

cast from the overhead lights. To remove this, you can use 

one of the three pipette symbols in the same Levels dialogue. 

From left to right, these allow you to select the black 

 point, gray point and white point of an image. Gimp will  

work out what the other colours should look like from there. 

The white point is the easiest to use – just click it then zoom 

in on a detail you know should be close to pure white. Teeth  

or eyes are are good, as are clothes or table clothes. Select 

that as your white point and watch the whole image adjust  

to something more natural looking. 

And don’t worry if you don’t get it right first time. Just  

click on an different part of the image or the Reset button  

if all goes wrong. 

That’s really just scratching the surface of what Gimp  

can do. In the basic toolbox you can scale images, select 

areas, draw paths, rotate or add text. The only way to learn 

more is to try it out. 

 Gimp’s Unsharp 

Mask is every 

bit as good at 

picking up detail 

in images as 

Photoshop’s.

Remember that for 

quick photo fixes 

there are tons of 

online photo editors 

that work in a Linux 

browser just as 

well as they do in 

Windows. Pixlr.

com is the best 

known, and great 

for quickly fixing red 

eye etc.

Quick
tip

Gimp key features

Tools
The tools are a standard photo editing 

kitbag. Everything you’d expect is here. 

Filters
The Filters menu has a host of tools 

for everything from adding blur to 

cartoony frames. 

Options
Beneath the tools themselves you’ll 

find a full array of customisation 

options for tweaking their use. 

Layers
The Layers window acts much the same as 

Photoshop. You can split an image, add extra 

layers and edit areas here.
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it’s simply a way for you to save your work as you go in 

OpenShot. Creating a video will come later in the tutorial.

Next, click the green + icon to import media files such as 

video clips. In the example below, a single video clip has been 

used but you can select multiple clips by holding down Ctrl 

and clicking on each file to select. Click on the ‘Add’ button at 

the bottom right to import the files. You will see they will 

appear in the ‘Project Files’ window at the top left.

Tracks, titles and timelines
Once your media has been imported, the next step is to drag 

them into the ‘tracks’ on the timeline. This is fairly self 

explanatory as the timing is displayed along the top and you 

can place your clips anywhere; for instance you may want one 

clip to begin playing after 3 seconds and another immediately 

after the first clip is finished. By default the timeline marks 

every 8 seconds though you can change this by sliding the 

bar at the top right. 

You will notice there are two tracks displayed at first where 

you can copy content. You don’t have to use more than one 

track, but if you plan to use more advanced features like 

transitions, titles and background music then it may be 

simpler to devote a track to each clip. Click the green + icon 

above the timeline to add more tracks if you wish. 

It’s advisable to have a dedicated track for any 

background music. Simply click the + button and drag an 

audio file into the new track. Unless you want the original 

video’s sound to play too, click the loudspeaker icon on the 

left hand side of the video track to mute the audio. 

At this stage you may also want to give your video a title. 

To do this, hold down Ctrl + T to open the Title Menu. Click the 

menu under ‘Start Here’ to choose the font and layout of your 

title, then ‘Create New Title’ to set the text. The title will 

appear in the Project Files and can then be dropped onto the 

timeline wherever you need it.

Openshot: Start 
video editing
Easily create home videos and slideshows with backing tracks using the 
OpenShot open source video editing package.

I
f you believed that switching to using Ubuntu Linux 

means giving up the ability to create videos and photos, 

rest assured nothing could be further from the truth.

The OpenShot Video Editor which is available from the 

Ubuntu Software Centre can be mastered in a few minutes 

but allows you to create high quality videos.

Although OpenShot isn’t by any means the only video 

editor that will work well in Ubuntu, it strikes an effective 

balance between being simple to pick up, but having features 

advanced enough to create a professional looking video.

In this tutorial we will explore how to import both video 

clips and pictures into OpenShot, then export them as video. 

In order to proceed, you will need to have imported the 

video, pictures and music you wish to use to your computer 

either via downloading it from the internet or digital camera.

Once your media is safely on your computer, click on the 

‘Ubuntu Software’ icon to open the Software Centre and 

search for ‘OpenShot’. Click ‘Install’ to download the program. 

Once complete a button marked ‘Launch’ will appear.

Your first step when launching OpenShot should be to 

create a new project. Either click the ‘New Project’ button at 

the top left or hold down Ctrl + N. A window will appear 

allowing you to name the project and choosing where to store 

the project files e.g in your Videos folder.

At this stage do not worry about the video settings under 

‘Project Profile’ as they can be changed later. Choose ‘Save 

Project’ when you are done. The folder you chose will save a 

project file detailing the name of your project and the location 

of any media you have imported using the file extension .osp. 

This is not a video file and cannot be played in a media player, 

 Click the ‘New Project’ button at the top left to choose a location to save your 

projects. This doesn’t have to be the same place where you export  your video.

 Background music has been added to Track 1, a cat video 

is on Track 2. Note the original audio has been muted.

Other popular 

Ubuntu editors 

include Pitivi and 

Kdenlive. Both are 

available to install 

from the Software 

Centre if you want 

or need a more 

advanced editor.

Quick
tip

If you want to trim a 

clip, consider using 

the ‘Resize Tool’ 

to the right of the 

Razor Tool. Move to 

the edge of a clip 

and then hold your 

left mouse button 

to resize.

Quick
tip
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Sometimes you may wish only to create a video with short 

clips from a larger recording, for instance to play speeches at 

a wedding. The Razor tool can be activated easily by clicking 

the scissors icon at the top of the timeline. Once you have 

done so, you’ll notice that the cursor will change to a picture 

of a razor blade with a blue dotted line.

Left click your mouse to split your video into any number 

of clips. You can then right-click on individual clips and choose 

‘Remove Clip’ to delete them altogether. If you want to move 

snipped clips around, click on the ‘Arrow Tool’ on the timeline 

to deactivate the razor tool and then move the clips to 

elsewhere on the timeline or a new track.

Effects and transitions
OpenShot contains dozens of built in video effects to enhance 

clips. Simply right-click on the clip in question and select 

‘Properties’. Next click the ‘Effects’ and the green + button on 

the bottom left to add an effect from the menu. 

A mini preview of your video clip will display on the left-

hand side. Click on the play button to see what your intended 

effect will look like before clicking ‘Apply’. Remember you can 

apply more than one effect to the same clip. OpenShot 

helpfully places a small star on video clips which have been 

enhanced with effects. You can remove them at any time by 

going into the clip properties, highlighting the effect name 

with your mouse and clicking the red – button. 

While you’re inside the Clip Properties window, take time 

to explore the other tabs such as ‘Speed’ and ‘Layout’ to see 

where it’s possible to fine tune the settings for each clip. This 

may be important if you wish to time your video exactly to 

music or simply change the length without using the razor 

tool. Click ‘Apply’ when you are done.

Transitions are particularly useful for moving between 

images or video clips in a stylish way. Click the ‘Transitions’ 

tab at the top-left to see the various kinds available e.g 

Vertical Bars and drag onto the timeline. It can be helpful to 

use different tracks for the transitions to avoid overlapping 

clips. If you wish to fine tune the settings for a transition, right 

click and select ‘Properties’. You will be able to specify a new 

position, length and even direction for your transition. 

Exporting videos
You can use the Play button on the built-in video player to 

check the project has been done to your satisfaction. You can 

also navigate by clicking the timeline and use the space bar to 

play and pause if you need to examine a specific section.

Once you are satisfied, click the red ‘Export Video’ button 

at the top of the window. Specify a filename for your video 

and choose a location e.g your Desktop. When it comes to 

choosing a profile if you plan to share the video online choose 

‘Web’. You can further fine tune the settings for individual 

websites e.g Youtube by using the ‘Target’ menu. Click the 

‘Export Video’ button when done. The file will appear in your 

chosen folder once the progress bar is complete.

Further Reading
This guide only scratches the surface of the power of 

OpenShot. For more information on additional features visit 

the official manual at www.openshotusers.com/help/1.3/

en/. For further help from friendly users and to see some 

stunning examples of videos created in OpenShot head over 

to the forum at http://openshotusers.com/forum/.  

 Click the ‘Transitions’ tab to drag and drop between video clips or photos. 

Right click on a transition and select ‘Properties’ to fine tune.

 Use the Play button in the ‘Clip Properties’ menu to 

experiment with different effects. Don’t be afraid to 

explore the other tabs if you need to modify your clip.

Remember that 

If you have many 

different types 

of media it can 

be confusing to 

navigate them all. 

Click on the ‘Video’, 

‘Audio’ and ‘Image’ 

button to show only 

that type.

Quick
tip

OpenShot Slideshows
If you wish to create a video from a series of 

photos, place them in a folder and make sure 

they are sequentially numbered. Most digital 

cameras will do this for your automatically.

Use the ‘Import Files’ button to load all the 

files into the ‘Project Files’ window. Next hold 

Ctrl+A to select all the files and right click them. 

Choose ‘Add to Timeline’.

This new window that opens allows you to fine 

tune the video settings. The ‘Timeline Location’ 

section lets you alter the time at which the 

images are displayed – you may wish to leave a 

few seconds delay if you are going to add a title.

The ‘Fade’ section allows you to choose if the 

photos will fade in and out as well as set the 

duration, as the name suggests. Finally the 

‘Transition’ section allows you to choose a 

transition between photos. This saves you the 

time and trouble of inserting transitions 

individually, but naturally it will be the same kind 

of transition e.g Vertical Blinds for every photo.

By default the odd numbered photos will be 

added to track 1 and the even numbered to track 

2, although you can change this if you wish in the 

‘Timeline’ location section. Click ‘Add’ when done.

At this point you may wish to add an 

additional track for background music. 

Slideshows are exported as video in the usual 

way by clicking the ‘Export Video’ button at the 

top and you’re all done. 

 Use the arrow keys on the left to change 

the order of the pictures.



40  |  Linux Format Presents: Ubuntu

Linux apps

find out exactly how to extract those bookmarks. Time to look 

at your options for Ubuntu!

Browser history 
The most established browser on Linux is probably Firefox 

which, although it’s lost a little market share in recent years, 

displays the entire web perfectly and includes some neat 

features. Newer versions allow you to synchronise your tabs 

between devices if you sign in to all of them with the same 

Firefox Account, for example, so it’s easy to pick up where you 

left off if you’re jumping from machine to machine – or even 

user account to user account. Similarly, you can use the 

Firefox Hello system to browse the web simultaneously with 

other Firefox users, which is great for remote working, 

planning, or just hanging out online.

You may also find a browser named Iceweasel – this is, for 

all intents and purposes, Firefox in all but name. Certain minor 

elements and trademarks attached to Firefox, such as the 

logo, have been changed due to them violating the 

requirements of free software distribution. Also rebranded 

were email client Thunderbird (Icedove), ‘internet application 

suite’ Seamonkey (Iceape) and seemingly abandoned 

calendar app Sunbird (Iceowl). Expect these frigid alternatives 

to disappear soon, as distro creators seem to be working out 

their differences with Firefox’s parent company Mozilla.

Second to Firefox is Chromium, an open-source browser 

(available in a number of user-developed flavours) that forms 

the basis of Google Chrome. It doesn’t include all of the 

Web browsers: 
Pick the best
How do you see the web? Seems a simple question, but you might be 
surprised at the difference when you check out the best browsers available.

W
hat is a computer if not a portal to the internet, 

these days? Accessing the online world is 

absolutely essential, and Linux is not short of  

web browser options. Many of them will be familiar if you’re 

used to going online in other operating systems, some are 

variations (based on the software, but not exactly the same) 

and some are fairly unique, unusual browsers to try as well.

The good news if you’re fairly established with your 

current browser is that it’s usually rather easy to transfer your 

bookmarks over, so you won’t lose those vital links. So before 

we look at your options, let’s back these up from another 

system so that we can import them later on.

Backing up bookmarks
In Google Chrome, click the three-lined hamburger menu 

icon, go to Bookmarks, and click Bookmarks Manager.  

Click the ‘Organize’ drop-down menu and select Export 

Bookmarks. This will create an HTML file which you can  

later import into the browser of your choice. 

If you’re using Internet Explorer you’ll find the setting in 

File/Import and Export/Export Favourites. Microsoft Edge, 

despite being newer, isn’t quite as friendly, but thankfully 

Firefox can import Edge bookmarks. To get them (and the rest 

of your bookmarks) out of Firefox, click the bookmarks  

icon, Show All Bookmarks, and follow the steps within  

Import and Backup.

Sadly we’re not made of space here, so users of other 

browsers will have to hit up their favourite search engine to 

Each browser 

has a different 

way of importing 

bookmarks – 

check your chosen 

browser’s help file 

for more details  

on how to do it.

Quick
tip

Alternative Browsers
Lynx
lynx.browser.org 

Classic text-mode 

browsing, run from within 

a terminal window. Lynx is 

mostly a curiosity these 

days due to its archaic 

makeup, and it’s only 

really useful on machines 

which absolutely cannot 

output anything other 

than text mode, but it can 

be interesting to see how 

the web looks without 

images or modern 

rendering techniques.

Midori
midori-browser.org 

Using the GTKWebKit 

engine (a fork of the  

Blink rendering engine 

that powers Chrome, 

Chromium and Opera), 

Midori is the default 

browser of the xcfe 

window manager and 

features in a number of 

lightweight distributions 

(Bodhi, SystemRescueCD, 

Manjaro Linux). It does 

well on the tests we’ve 

listed in this article.

NetSurf
www.netsurf-browser.org 

Originally coming from 

RISC OS – an ARM-based 

operating system that 

grew out of the Acorn 

Archimedes – NetSurf 

has been ported to a 

number of platforms 

since, including AmigaOS. 

It’s not the absolute best 

browser, but it uses its 

own unique rendering 

engine, so if your Linux 

install struggles with 

others, give it a try.

Opera
www.opera.com 

So often the browser 

bridesmaid but never  

the browser bride, Opera 

is a clean, fast and quite 

wonderful program  

that deserves more 

recognition than it gets. 

The Opera Turbo feature, 

which compresses your 

web traffic, is particularly 

useful if you’ve got a slow 

internet connection or if 

your ISP blocks access to 

certain sites.

Pale Moon 
www.palemoon.org 

A notable fork of Firefox 

that will please those who 

aren’t too happy about 

the modern browser style, 

this clings to an old-

school, fully-customisable 

user interface and uses its 

own rendering engine, 

Goanna, which forked 

from Gecko, the Firefox 

rendering engine. It’s 

actively updated and high-

performance, so well 

worth a look.
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features of its big trademarked brother – usually missing 

things which use proprietary non-open technology like Flash 

player – but it runs the same rendering engine, which means 

web sites look just as good. It also manages memory in the 

same way, allocating a portion for each of your open tabs, 

which is both a blessing and a curse. A blessing because if 

one tab has a problem it doesn’t bring down the rest with it, 

but a curse because Chromium requires a relatively large 

amount of memory to run multiple tabs.

While you’re unlikely to find big-boy Chrome in your 

distro’s package manger, it’s simple to get hold of the real 

thing. Just head to google.com/chrome, click Download 

Now, and select the appropriate file for your distro (usually 

64-bit deb, if you’re using Ubuntu). Click Accept and Install, 

then open the resultant file with your package manager to get 

it installing. You’ll need to run it from a terminal the first time; 

launch one by clicking the search button, searching for 

‘terminal’ and selecting the Terminal application, then type 

google-chrome-stable to start it up. Once it’s run once, it’ll add 

its icon to your launcher so you can start it more easily.

In both cases here we’d suggest it’s best to run Firefox  

and Chrome over their open source alternatives. While this 

doesn’t match the freedom philosophy of Linux, you’re 

probably not in this for philosophical reasons. Having the 

absolute latest version of your chosen web browser is vital for 

security and compatibility reasons, and sometimes forked 

software just doesn’t keep up with the times.

There are numerous other browsers available for Linux 

which all serve different purposes. Well, OK, usually they’re 

there to provide you with a browsing experience that requires 

a smaller memory footprint for lower end machines. You’ll 

find out more about these in the ‘Alternative browsers’ box.

Testing capabilities
How well does your browser actually perform? Different 

browser options render online elements in different ways, so 

it’s worth testing your chosen browser (and its competitors) 

thoroughly to make sure you’re getting the best experience. 

Head first to the Acid tests at www.acidtests.org, a long-

standing series of rendering engine-

stretching challenges which will prove 

how well your browser adheres to 

particular web standards or, at least, it 

shows how well your browser performs 

these particular tests.

A more modern benchmark is the 

HTML5 Test, found at html5test.com. 

While this doesn’t animate any pretty 

pictures or give you a visual 

representation of your browser’s flaws 

(boo) it does give you a detailed list of 

everything your browser can or can’t do, 

with a score to match. Many Linux 

browsers are going to lose a few points 

for leaving out closed source 

technologies, so bear this in mind 

before you rush to uninstall your current 

option. The vast majority of websites 

include fallback options away from 

proprietary software anyway, and many 

of these are now becoming the norm 

rather than the alternative.

To the extreme
The most extreme rendering test we could find lives at  

web.basemark.com. Browsermark, for that is its name,  

runs a series of heavyweight tests that push your browser’s 

performance in a number of ways, beyond just HTML5  

or CSS, and might also give you some clues about the 

performance of your PC. Make sure your machine doesn’t  

go to sleep while it’s running, which should take about five 

minutes. When it’s complete, you’ll be given a final score,  

see which percentile your browser and desktop combined  

sits on, and even get a bit of information about the 

performance of your ISP. 

While we’ve made some vague recommendations here, 

your choice of browser is really going to come down to 

personal taste and what works best for your Linux system. All 

computers and desktops perform differently, so you’re 

always encouraged to experiment, install, test, and find the 

best choice for you. Once you’ve done that, the internet is 

your oyster. Happy browsing. 

  Chrome probably isn’t available in your package manager, so you’ll need to 

head to its website (in a different browser) to get hold of it.

 The HTML5 test is a great way to see how muscular your browser truly is, but it’s not the be all and 

end all of browser performance.

Don’t fret if your 

browser doesn’t 

max out every 

test – if you’re 

happy with the way 

it displays pages, 

that test result 

doesn’t really 

matter!

Quick
tip



42  |  Linux Format Presents: Ubuntu

Linux apps

Careful now
Do not install Steam via the Valve website. Valve in the correct 

way does offer a Linux install package on its Steam website, 

this will appear to install but due to required additional 

dependencies won’t work. It also doesn’t provide any useful 

error messages to help you work out the problem.

The correct way to install Steam is from the Ubuntu 

maintained repositories. We’ll show you below, it involves the 

Terminal but don’t worry it’s really easy. You may also wonder 

why you can’t find Steam in the official Ubuntu Software 

store, due to the cutting-edge release of Ubuntu 16.10 not all 

packages can be found here yet. So we have to revert to the 

traditional Terminal-based install.

Use the Dash Search (top-left icon) and type Terminal, 

click the Terminal icon to open the black text interface. Here 

type the line below, press enter and enter your password:

$ sudo apt-get install steam

You’ll get a stream of text alluding to the required 

packages that need to be installed and a final line along the 

lines of below, type Y to accept:

0 to upgrade, 43 to newly install…

Need to get 22.4MB of archives.

After this operation, 190MB of additional disk space...

Do you want to continue? [Y/n]

A host of more text will scroll by, which is the Terminal 

installing all of these packages. A text dialog will appear, press 

tab to highlight YES and press return. Select I AGREE using 

the down arrow key and press Return to install Steam itself.

Steam is now installed, you can type Steam and press 

return in the Terminal to launch it. More easily you can open 

Steam: Play 
games on Linux
Linux is fun, no really! You can even play games and these days that’s not just 
years old remakes, but same-day release big-name AAA releases.

L
inux is great for work. Linux is great for servers. Linux is 

great for old PCs. No one says Linux is great for 

gaming, or do they? Go back just four years to 2012 

and it’s true, Linux was bereft of almost any native games. 

About the most fun you could have with Linux was 

recompiling the kernel to patch the latest zero-day exploit. 

Then Steam arrived, released in late 2012 the biggest digital 

gaming platform landed on Linux and gaming life was never 

the same again…

Several years on and Linux now offers over 2,000 gaming 

titles on Steam, a number that continues to grow steadily 

with over 500 titles being added during 2016 alone, including 

big-name titles such as Mad Max, Deus Ex 2, Rocket League, 

Life is Strange and the new Tomb Raider reboot. We’ll take a 

look at how you can safely install Steam on Ubuntu 16.10 and 

get gaming as easily as possible.

Before we start we should say that not only is there a 

plethora of choice when it comes to gaming on Linux, it’s now 

easier than ever to get started. Although Valve’s proprietary 

storefront has its issues – such as game DRM– it does make 

installing and running games an incredibly simple process. It’s 

also not the only game in the Linux-verse, Good Old Games 

(www.gog.com) is another service that sells games for Linux. 

It offers a mix of classic games (that have been made 

compatible with modern computers), new games and has a 

no-DRM policy. Another online store that lets you have fun 

and give to charity is www.humblebundle.com and offers a 

range of DRM-free Linux games.

 Bring your Steam library with you, any Linux games will appear as if by magic
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the Dash Search, type Steam and launch it from there. This 

will place an icon in the Launcher dock.

Steam will download more of its own files - as it would on 

Windows – but with this you can log in (or create an account) 

and gain access to your gaming library, though restricted to 

Linux supported games.

Performance
Gaming is one of the more demanding things a home user 

can do with their PC. Modern games use more memory, 

processor power and 3D graphics resources than almost any 

other program. Most games offer a recommended and 

minimum specification. Take the latest Deus Ex 2 game, it has 

an incredibly high requirement of 16GB of memory and only 

the latest graphics cards just to play at 1080p resolutions.  

Linux does have something of a disadvantage against 

Windows, as currently few games are optimised for Linux, so 

many tend to perform around 20% slower on Linux. Now that 

Linux is established we’d expect newer games to provide 

better optimisations in the future.

Certainly though if you want to play any 3D games you will 

need a suitably powerful 3D graphics card. Newer Intel and 

AMD processors do have basic 3D capabilities that are able to 

power games on basic settings at 720p resolutions. Ideally 

though we’d recommend you to invest in a dedicated 3D 

graphics card such as the Nvidia GeForce 1050 or the AMD 

Radeon 460. Both of these cards costs around £120 and will 

provide great 3D performance. Just ensure you enable the 

proprietary drivers.

Ideally the rest of your PC needs to be up to scratch as 

well, otherwise having a lovely shiny new graphics card will be 

something of a waste. You’ll want at least 4GB of memory but 

8GB these days is more the thing. The processor also needs 

to be something that was made in the last five or six years 

and be at least dual core. This is as much about the overall 

speed of the system as it is just ensuring the system as a 

whole is fast enough to play modern games. 

Of course, if you’re more interested in older titles then an 

older, slower system will work just fine. But in that case you 

likely don’t need the fancy new graphics card either! The 

Linux and open source world is awash with classic emulators 

so you can run classic software for the Amiga, ZX Spectrum, 

C64, classic arcade machines and even recent consoles. It’s 

just a case of installing the emulator you’re after, grabbing a 

few games that you own of course and firing it up. Most of 

these classic emulators don’t require much power and even 

15-year old systems should be able to cope! 

 Ensure you choose the terminal install to make sure everything works.

Windows games on Linux

Wine (see page 58 for a guide) is a compatibility layer 

that enables many Microsoft Windows programs to 

run on Linux. Although it’s usually used for running 

office suites and other programs that haven’t made it 

to Linux (or don’t have an open source alternative), it 

can also be used for running Windows games in Linux 

as well. Of course, there’s a performance impact to 

running a game via Wine rather than natively, so it’s 

not really recommended for graphically demanding 

games – unless you have one hell of a machine. 

However if you have CDs of some old Windows 

games lying around, or you want to try an indie title 

that hasn’t made it to Linux just yet – then Wine is a 

great possible solution.

To install, open up the Terminal and type

sudo add-apt-repository ppa:ubuntu-wine/ppa

sudo apt-get update

sudo apt-get install wine1.8

and a window will pop up asking you to read and 

agree to a EULA by Microsoft. You might have hoped 

you’d left all this behind, but it’s a necessary step to 

using Wine. Once you’ve scrolled down and agreed, 

type in  $ winetricks . To run the graphical user 

interface for Wine. You may have to install additional 

packages, and Wine will take you through the 

process. With ‘Select the default wineprefix’ selected 

click ‘OK’ and then you can begin installing required 

software to run Windows games in Linux.

If a game isn’t available then 

perhaps you can just run the 

Windows version?

 The gaming police will be checking to see if you’re running Linux or not and 

quite possibly mock you for gaming on a server platform. The future is harsh.
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Flickr is an image hosting service similar to Picasa but is 

run by Yahoo. Anyone can access photos and videos 

uploaded to the website without an account but users must 

register in order to share their own content. 

If you have a Yahoo e-mail address then you will be able to 

sign into Flickr right away. Click on Add Account on the left 

hand side of the Online Accounts window, then on Flickr. You 

will be asked to sign in with your Flickr ID.

Once you are signed in, the Photos Search feature will 

work in the same way as for Google Photos. Simply click on 

the Ubuntu search icon and enter your search terms.

If you use Ubuntu’s photo manager Shotwell, you can also 

publish photos to Flickr and Google Photos from within the 

app itself. Simply highlight your photos or videos of choice 

and choose File … Publish. If you have not previously used 

Shotwell to manage your photos, you can see more 

information on this in the official manual. 

Desktop notifications
Certain websites like Gmail, Twitter and Facebook support 

push notifications that show a small pop-up even when you 

don’t have their web page open. For instance Facebook can 

show an alert when you get a new message or notification. 

This feature is available in Firefox but has not been fully 

implemented, so if you’d like to see pop ups for new Facebook 

notifications, tweets or e-mails, try installing the Chromium 

web browser from the Ubuntu Software Centre. Once 

Chromium is installed click the icon to launch it and visit your 

website of choice. You will be asked to agree to allow desktop 

notifications for that site. Click Allow for the notifications to 

appear. Each time an alert pops up you can click on it to be 

taken to the site in question. 

Instant Messaging
There are a number of applications available in the Ubuntu 

Software Centre that will connect to multiple instant accounts 

such as AOL Instant Messenger or Google Hangouts without 

having to visit each website individually.

Previously Ubuntu came with the messaging client 

Empathy pre-installed, however this has been dropped in the 

most recent version the operating system. Fortunately it’s 

very easy to install. Open your web browser and go to 

https://apps.ubuntu.com/cat/applications/empathy, 

then click the red button marked available in the Ubuntu 

Software Centre. A new window will open click Open Link to 

begin installing Empathy. 

Once Empathy opens click Account Settings to open the 

Online Accounts window. You will see that there is a new 

Social: Network 
with friends
Integrate your social networking accounts into your Ubuntu Desktop.

T
he Firefox browser in Ubuntu can be used to access 

any number of social networks, however you may find 

it easier simply to access them from your desktop. 

Ubuntu’s Unity desktop integrates well with Google Drive, 

Flickr and Facebook to blend your online and offline data. 

To get started, click the Search button at the top left of the 

screen and type in Online Accounts. Click the Online Accounts 

icon to launch the window. By default it will show accounts 

that are compatible with all applications on your computer. 

Integrating
Google Account Users can double click on the word Google to 

configure their account. Enter your username, then your 

password. You will then be asked to authorise Ubuntu to 

access your data. Click Allow to permit this.

Once setup is complete the online accounts window will 

list the applications that can integrate with your account. By 

default they are switched on individually. One of the most 

handy features is the Photo Search Plugin. This allows you to 

use the search icon to look for photos stored in Picasa (now 

known as Google Photos). Searches for files can now also 

include those stored in your Google Drive. 

If you have any online Google calendars, the Calendar 

application in Ubuntu will also import them automatically. 

Take a moment to check they have been displayed correctly. 

The application is bidirectional in that any add or modify in 

Ubuntu will also update your online Google calendars.

 Click on Google to sign into your own account. You can control which 

individual applications will integrate with the Ubuntu desktop. 

If your Google 

Account uses Two 

Step Verification, 

you may need to set 

up an app-specific 

password for the 

Ubuntu Desktop. 

See http://bit.ly/

LXF26social

Quick
tip
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option for Empathy Messenger. Empathy is very easy to use 

but if you run into difficulties, there is plenty of support 

available from the GNOME website at https://wiki.gnome.

org/Apps/Empathy.

Although Empathy integrates well into Ubuntu’s desktop, 

it doesn’t support many different types of messaging 

protocols, nor is it very customisable. 

Users who want to set up additional accounts and/or have 

more control over their messaging can install Pidgin. Pidgin is 

a very popular messaging program for Linux and supports 

AOL Messenger, Yahoo,ICQ, MSN Messener, Google 

Hangouts, Apple’s Bonjour protocol and many more. 

To install Pidgin visit http://bit.ly/LXF26pidgin and 

click the red APT Install button, then Install. 

On the first run, Pidgin will give you a variety of accounts 

to set up, choose accordingly and set up your accounts. 

Pidgin supports cross messaging from one account to 

another as well as a variety of plug ins. (For instance there is 

one that lets you chat to Skype users). You can find help with 

getting started by reading Pidgin’s manual at https://

developer.pidgin.im/wiki/Using%20Pidgin. 

Social setbacks
Ubuntu is designed to work well with social networks, so it’s 

unlikely you will have any problems with your desktop. If after 

setting up an account you find that the connection is not 

working e.g your Google Calendar isn’t appearing in the 

Calendar application, try logging out and in again as this 

usually fixes the issue.

If you choose to use desktop notifications for Twitter, 

Facebook, Gmail and so on with Chromium, although you 

don’t need to have the pages for those sites open, Chromium 

itself needs to be running for you to see the alerts.

Neither Pidgin, nor Empathy support messaging via 

Facebook. This is because in April 2015 Facebook dropped 

support for the open XMPP (Extensible Messaging and 

Presence Protocol ) which allowed third party apps to 

connect to their chat servers. Fortunately you can still access 

your Facebook messages via https://facebook.com or 

https://messenger.com. 

Most Linux Messaging programs however do support 

XMPP (also known as Jabber), which uses a number of 

servers around the world to allow people to communicate 

with each other freely. Visit www.jabber.org for more 

information and tips for registering an account. 

If you like using a particular program to manage your 

media or communications, don’t worry if there doesn’t seem 

to be a version available for Ubuntu. First check the website 

to make sure that is really the case ; there is a Linux version of 

Skype for instance (see Setting up Skype above). 

If there’s no downloadable application for your program of 

choice, you may be able to access it through your browser. 

Whatsapp for instance can be run from inside a Firefox 

window by visiting https://web.whatsapp.com and 

scanning in a code on your mobile phone. 

If there’s no Linux or web version, search in the Ubuntu 

Software Centre and on http://askubuntu.com to see if 

there’s an equivalent program for what you need. 

Remember that if you integrate social networking into 

your desktop or browser then anyone logged into your 

account will be able to see your profile and messages. Always 

ensure that you have a strong password and either suspend 

your session or log out of Ubuntu completely each time you 

leave your computer. 

 Click Allow on supported websites to show an alert on 

your desktop each time someone interacts with you. 

Remember that 

Online Accounts 

supports publishing 

to Facebook 

through Shotwell 

as well as searching 

through Facebook 

photos. Click Add 

Accounts then 

choose Shotwell 

from the drop down 

menu. Next click 

Facebook to set up 

your account.

Quick
tip

 Click Add Account on the left hand side of the window and choose Empathy 

from the drop down menu to show which messaging protocols are supported.

Setting up Skype
As Skype is currently developed by Microsoft and 

doesn’t release its source code, you won’t find it 

in the Ubuntu Software Centre. 

Nevertheless, if you visit www.skype.com you 

will see that there is a version available for 

Ubuntu. Click on Choose your distribution and 

then Ubuntu 12.04 multiarch to begin 

downloading. A prompt will appear asking if you 

want to open the file with software install. Click 

OK. Once the file has downloaded open your 

Ubuntu Software Centre to see the entry for 

Skype and click Install. Launch Skype by typing 

the name into your search bar. 

The official Skype Linux client is rather dated; 

the most recent major version was released in 

2014. Skype Developers are trying to address this 

by launching a test alpha version. This version is 

still in an experimental phase and will have some 

bugs but if having Skype is important to you, you 

can help by installing and providing feedback. 

Visit http://bit.ly/LXF26skype and click 

Download Skype for Linux Alpha Deb. The alpha 

version is capable of calling Skype users on 

mobile devices and Windows and Mac computers 

but cannot call people using the official Linux 

client available from the main page. 

There are a number of video conferencing 

programs available for Ubuntu besides Skype 

such as Gajim and Psi, both of which can be 

installed via the Software Centre. 

 Choose Ubuntu 12.04 to get the installer 

for the official Skype 4.3 Linux Client.

If you are trying 

to set up Google 

Hangouts to work 

with Pidgin, click the 

Advanced tab in the 

setup screen and 

change the blank 

Server field to chat.

google.com.

Quick
tip
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What happens to your email archive if that provider goes 

bust, or a hacker forces their way in and changes your 

password? These, and many other reasons, are why it  

makes sense to use a desktop email client that can be  

backed up, store your messages offline, and live – if you  

have such a facility set up – in an encrypted partition away 

from prying eyes. 

Positive Outlook
If you’ve been around computers for a while, it’s probable  

that you’ve used Microsoft’s Outlook or Outlook Express, 

packages which do just the job we’re looking for: downloading 

mail from servers, storing it, sending new mails and replies, 

and backing up your inbox. Funnily enough, Microsoft’s 

flagship mail package isn’t available on Linux platforms,  

but Mozilla’s well-weathered Thunderbird is just as capable 

and should be quite familiar to former Outlook users. We’ll 

take you through installing it, configuring it to connect to  

an account, and beyond.

Let’s start by getting hold of it. Many distributions will  

have it installed by default – including Ubuntu, which we’re 

using here – but if you don’t have it head to your local friendly 

package manager and search for Thunderbird Mail. Install as 

usual (see the start of this chapter for more information on 

package managers) then run it from its icon. 

Postmaster
When you run Thunderbird for the first time, you’ll be given 

the option to sign up for a new free email address – we’re 

going to skip this particular step for this tutorial, so click  

Skip. Next, fill in your current email details. Your email address 

and password are the important parts here, the ‘Your name’ 

field doesn’t have to match the name you usually use for  

the account, but it’s useful to use your real name here so 

recipients know who’s emailing.

Brilliantly, Thunderbird now queries a database of  

server information. If you’re using a recognised provider  

like gmail.com or outlook.com, it’ll automatically grab the 

correct ingoing and outgoing server details so you don’t have 

to worry about it. More obscure providers may not be in the 

database, however, so you may have to fill in the blanks 

yourself. Your ISP or mailbox provider will provide the 

appropriate information; we can’t tell you precisely what to 

Thunderbird: 
Email made easy
Set up your very own desktop email client and keep your messages and 
contacts close at hand rather than losing them in the cloud.

E
mail is one of the internet’s oldest technologies.  

It outdates the web, it outdates instant messaging  

and it even outdates the internet’s predecessor, 

Arpanet. MIT, so often the innovator in these fields,  

started using software called Mailbox and SndMsg to  

leave messages for each other in 1965. The @ symbol was 

introduced to route mail to specific computers during the 

development of Arpanet in the early 70s; by 1974 the US 

military was a heavy user, and by 1978 75% of all Arpanet 

traffic was email. You could even reasonably give credit to 

email for inspiring the earliest development of the internet: 

this was a closed-system technology that the public  

couldn’t wait to use.

We’d stake money on you having at least one email 

address, and if you’ve been around for a while you probably 

have several. While most email accounts now have some kind 

of web interface for accessing your inbox and sending new 

messages, it’s arguable that this may not be the best way to 

manage your mail. Say you lose your internet connection: 

your inbox, stored entirely online, will be completely 

inaccessible. So many of us rely on old messages to remind 

us of information, this probably isn’t acceptable.

Security, too, should be a concern. How well do you trust 

your webmail provider not to snoop on your messages?  

Thunderbird 

supports multiple 

email accounts 

at once – just 

go to File > New 

> Existing Mail 

Account to add 

another.

Quick
tip

 Adding an account, if you’re with a recognised provider, could not be easier – 

just add your email address and password.
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put here, because very ISP is different. You can now choose 

whether to use POP3 or IMAP with your account – see the 

box above for more details on each – and hit Done. You may 

have to authorise the use of your email account in a further 

window, but you should only have to do this once.

A quick note for Gmail users: if you have Google’s two-step 

authentication switched on (and you should do), you’ll need 

to generate an app-specific password and use that, rather 

than your regular account password, to log in to your email 

through Thunderbird. 

Split personality
Thunderbird’s default main screen lists your email account 

and its subfolders on the left, and has a main window on the 

right split into two: the top pane contains the contents of  

your inbox, and the bottom pane contains the currently 

selected email. Try clicking on your inbox in the left column. 

Thunderbird will download all of your email from the server 

(this could take a while) and, if you’ve used IMAP, you should 

retain the read/unread status of your messages. By default, 

the inbox view displays messages in date order with the 

oldest at the top, but you can quickly re-sort your messages 

by clicking the column headers at the top. 

Click on a message and you’ll see it appear in the bottom 

pane of the main window. If this is a bit small, just hover your 

mouse over the bar between the panes and drag up to give 

yourself a bit more space. Still not enough room? Double-

click the message and it’ll open up in a tab of its own, giving 

you the full height and width of your Thunderbird window to 

play with. Click on the Inbox tab (or close the message tab) to 

get back where you were. Further layout options can be found 

in the View menu at the top of the screen.

In the book
While you have a message open, you’ll see all the usual email 

functions (reply, reply all, forward etc.) lined up along the top 

of the window, and you can always hit the Write button to fire 

up a new mail. 

If an email includes embedded images linked from the 

internet, you’ll also, at least initially, see a bar with a 

Preferences button. Thunderbird is restricting these images 

because, unlike plain old email, senders can use images to 

glean information about your computer, and whether  

you’ve read the message. Hit Preferences and you can  

choose to view images in just that email, for all messages 

from that address or domain, or head to the main Remote 

Content Preferences section where you can switch off this 

feature altogether.

When you’re creating a new message, you’ll probably 

discover that Thunderbird doesn’t actually have an address 

book to start with, even if you’ve been using one with your 

webmail account. Manually importing your address book 

(Tools > Import) is the only way to get this done. The process 

is going to differ depending on your source, but it’s not 

incredibly difficult.

Different versions of Outlook tuck away the export options 

in slightly different menus, but you should be able to find 

them buried somewhere deep within the File menu. Make 

sure you that export your address book as Comma Separated 

Values or .csv, as Thunderbird is happy to accept this format. 

In Gmail, the process is much more straightforward. Simply 

select the contacts section from the top left of the main 

window, (just above the Compose button), click More then 

Export to find the option. 

POP3 vs IMAP
There are two ways to receive email: POP3 (Post Office Protocol) and IMAP 

(Internet Message Access Protocol). POP downloads messages to your 

computer and (usually) deletes the originals from the server. It’s the 

classic method, and good for those using a single machine or with a 

security-conscious bent: if the mails are gone from the server, it’s going to 

be a lot more difficult for them to be traced or spied upon. There are big 

disadvantages when it comes to using POP3 on multiple machines – since 

it’s a one-way transaction, there’s no synchronisation between mailboxes, 

so you won’t get an indication of the messages you’ve read or replied to, 

and your filing systems won’t match up.

IMAP is a a two-way protocol, and probably the better choice if your 

provider offers it. Folders, read status and message deletions will all match 

up between the server and your mail client, meaning you can use the same 

account on multiple machines – and indeed use webmail and Thunderbird 

at the same time while keeping things synchronised.

 Use the preferences button to determine which images you can see in emails 

you’re sent – you can get quite specific.

You can set up a 

signature to add to 

the bottom of all 

of your outgoing 

messages in the 

Edit > Account 

Settings menu.

Quick
tip
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need, so in we’re going to take a look at not just the default 

tools for GNOME and KDE, but also a selection of third-

party programs that take screen captures to the next level.

The quickest way to capture your current screen is with 

a single keypress: the aptly titled Print Screen or PrtScr 

key. In older versions of Ubuntu – including 20.04 LTS – 

pressing this key results in the sound of a camera shutter, 

the screen will flash and an image of your entire desktop 

titled Screenshot from YYYY-MM-DD HH-MM-SS.png 

will be saved to your Pictures folder using the GNOME 

Screenshot tool. Double-click this to view a picture of your 

desktop sans mouse cursor.

It’s quick, dirty and not particularly elegant. For 

starters, a 1:1 screen capture of a typical Ubuntu desktop 

produces a file around 2.1MB in size. That’s fine if you need 

to capture the entire desktop, but in many cases you’ll only 

want to capture a specific part of it, such as a program 

window. The good news is that GNOME Screenshot has 

anticipated this very need: press Alt+PrtScr and only the 

currently active window will be captured. But what if you 

want to select a specific part of the screen – say one with 

overlapping windows? You’re covered here, too: press 

Shift+PrtScr, then click and drag to select the area you 

want.

If you need more control over your screen captures, 

there’s a separate screenshot portal tool accessible via the 

Launcher. This displays a dialog enabling you to select 

what you want to capture – full screen, application window 

or rectangular selection – but it also makes it possible to 

add a delay to the capture, so you’ve time to set things up 

as you need to. It also gives you the option of including the 

mouse pointer and a border around your application 

window if required. After capture, you’ll also be able to  

save the screenshot to a specific folder with your choice  

of filename.

New and shiny
The latest LTS build of Ubuntu unveils a new version of 

Gnome Desktop and with it a new screenshot tool. Now 

when you press PrtScr the tool pops up as a floating  

widget in Selection mode, with part of the screen pre-

selected inside a resizable bounding box. Next to Selection 

are Screen (full desktop) and Window, which pulls out all 

open windows and invites you to select which one you  

want to grab.

Beneath the selection tools you’ll see three further 

controls. On the left is an option to choose between simple 

S
creen capture tools are a useful in anyone’s 

armoury. You don’t need to be a Linux Format 

writer to benefit from being able to show 

someone part or all of your screen. Whether trying to 

demonstrate a particular feature or get help from an 

expert by sharing a visual representation of your 

computer’s ills (such as a specific error message), a 

screen capture program is the tool you need.

The ability to grab your screen is an integral part of the 

Linux desktop, whichever one you use. However, the built-

in screenshot tool doesn’t always have all the features you 

Ksnip:Improve
screengrabs
See how easy it is to take screengrabs and annotate them using a 
combination of Ubuntu’s built-in tools and third-party utilities.

1   Main toolbar
You can easily create, save and copy 

images to the clipboard from here, 

as well as reverse unwanted 

changes.

2  Crop images
If you need to crop into a specific 

part of your captured image, click 

this button to do so using a resizable 

bounding box.

3  Markup tools
Ksnip supports a decent range of 

annotation tools. These range from 

arrows and pens to text, blurred

areas (for redactions) and

even emojis.
4  Select object type

Click the down arrow next to a tool to 

choose what type of object you want 

– for example, a blur or pixellate tool 

for redactions.

5  Formatting toolbar
This toolbar displays options and 

tools based on the selected 

annotation object, such as font, size 

and effects for text-based objects.

6  Objects
Each annotation is treated as an 

independent object, enabling you to 

select them individually to move, 

Annotate with ksnip

1 2

3

4

5

6
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 If you’re running Ubuntu 22.04 on Wayland then your screenshot tool must 

be able to invoke the GNOME Screenshot Portal to capture grabs.

 Ubuntu 22.04 LTS unveils a new desktop screenshot tool 

– simply press the PrtScr key to invoke it.

screen capture or video capture. On the right you’ll see a 

mouse pointer – it’s excluded from the capture by default, 

so select this if you need to include it (for example, you 

want to draw attention to a specific option within a  

program window).

The cental button is the actual capture tool – it’s a 

white shutter for screen captures, a red record button  

if you opt to record video. Press the white button to 

capture a static screenshot. You’ll hear the familiar click, 

and then you’ll be notified the image has been copied to 

the clipboard for pasting elsewhere. It’s also saved into a 

Screenshots folder inside your Pictures folder using a 

similar naming convention as the older screenshot tool.

If you’re capturing video, after clicking record, the 

screen remains dimmed, but you can perform whatever 

action you like – you’ll see a record meter appear in the 

menu bar, so click this to end the recording when you’re 

done. Video clips are stored in .webm format inside a 

special Screencasts folder inside Videos following a 

similar naming convention to screenshots: ‘Screencast 

from DD-MM-YY HH:MM:SS’.

Those keen to capture the entire desktop or just the 

active window – as before – will be pleased to learn that 

the new tool offers two keyboard shortcuts that do just 

that: press Shift+PrtScr to capture the entire desktop, or 

Alt+PrtScr to capture the currently selected window.

Beyond screenshot
While the new screenshot tool is easier to use than its 

older precursor, it lacks several key features. For starters 

you can’t choose where to save your screen captures or 

even change their name, and you also lose the ability to 

delay screen captures to give you time to set up your 

screen before capture if required.

Thankfully, you’ll find several third-party screen capture 

tools exist to fill in these – and other gaps. KDE users 

should check out Spectacle (see the box, overleaf), which 

replaces the Gnome Screenshot tool. GNOME users can 

install Spectacle through the Software Centre, but it’s not 

compatible with GNOME’s implementation of the Wayland 

protocol, so doesn’t work in Ubuntu 22.04 unless you 

switch back to Xorg – see the box for more details (below).

The same restriction applies to several other screen-

capture tools we’d have otherwise recommended, 

including Kazam (https://launchpad.net/kazam). This 

offers all the features found in the original GNOME 

screenshot tool, including the ability to delay captures with 

optional countdown timer and save files manually, plus 

some additional features of its own. The most notable of 

these is the ability to configure Kazam to save screenshots 

automatically to a folder of your choosing using your own 

choice of filename prefix.

You can still use Kazam to capture the entire desktop 

screen in Wayland, but its screen-casting tools don’t work 

and it’ll crash if you attempt to capture a window, making 

it an impractical solution unless you switch  

back to Xorg.

Getting ksnip
Thankfully, you don’t need to abandon Wayland to access 

all of Spectacle’s features in GNOME. There are two 

Wayland-friendly tools offering both screen capture and 

You can expand 

ksnip with plugins. 

Visit https://github.

com/ksnip/ksnip-

plugin-ocr/releases 

to download a 

package to add 

OCR capabilities to 

the tool. Use it on 

scanned documents 

to extract editable 

text via the 

Options>OCR 

menu.

Quick
tip

The trouble with Wayland

For those stepping into the world of Ubuntu 

22.04 for the first time, a potentially nasty 

surprise awaits: Wayland, the new desktop 

protocol that replaces X11. For the most  

part it’s a good switch – Wayland is faster  

and more secure, but it’s that additional 

security which poses a problem for  

screen-capture tools.

On a desktop running the Wayland 

protocol, many screen-capture tools are 

unable to grab screens using their own 

capture tools. That’s because they’re not 

engineered to work with Wayland’s more 

robust permissions structure, and you can 

see this in action when you attempt to install 

and launch Spectacle through an Ubuntu 

22.04 install running the GNOME desktop on 

Wayland – when the program opens, you’ll 

be told it “could not take a screenshot”.

The problem doesn’t occur with 

Spectacle in its native KDE environment 

because it’s been fixed to work with Plasma 

Wayland since May 2021. Because GNOME 

is stricter about what programs can access 

screen-capture capabilities, other tools have 

been forced to adopt a different approach.

In the case of ksnip and Shutter, both 

authors have engineered a workaround 

whereby the tools use the GNOME 

Screenshot Portal in Wayland instead of 

their own more flexible screen-capture 

capabilities (including support for global 

hotkeys), which continue to work in X11.
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KDE’s spectacle

If you’re a KDE desktop user, then KDE ships 

with the default Spectacle screen-capture 

tool, which goes a bit further than Gnome’s 

standard Screenshot tool. Press PrtScr to 

invoke it, at which point you’ll see a preview 

of the entire desktop appear along with 

options to set up another screengrab. 

In addition to the usual Full Screen and 

Rectangular Region options, Spectacle 

offers two options for capturing windows 

or dialogs. Active Window works in the 

same way as other screenshot tools, while 

Window Under Cursor captures whichever 

window is beneath the cursor when it’s 

taken. Look for the ‘Capture the current 

pop-up only’ option, which works with this 

to enable you to selectively grab items like 

pull-down menus.

Beneath this is a ‘Delay’ option, for either 

setting a timer before the snap is taken or 

ticking the On Click box so that when you 

click ‘Take a New Screenshot’, Spectacle 
waits for the next mouse click before 

capturing the screen. Other features include 

the ability to choose which file format to 

save your grabs in, along with an Export 

button for opening captures directly in your 

choice of image editor or to transfer 

elsewhere, with Bluetooth, email, NextCloud 

and other devices all available as 

destinations.

Spectacle also offers a built-in annotation 

tool. This enables you to apply effects and 

mark up your captured images. You can 

configure its save and capture settings, as 

well as assign keyboard shortcuts for super-

fast screen captures.

Once you’ve taken your first screengrab, the ksnip 

window expands to reveal the image and a selection of  

tools for performing post-capture editing. From here, you’ll 

see a selection of markup tools to the left of the image, 

which are summarised in the annotation opposite. Each 

added element is created as an independent floating 

object, and the Select tool at the top of the tools list 

enables you to click existing objects to move, resize, edit or 

delete them (press the Del key) using their own context-

sensitive controls. 

Beneath the Select tool is the Duplicate tool. After 

selecting this, click and drag on a portion of your image, 

which will be duplicated as a separate layer sitting on top 

of the main image. This can be moved or resized. For more 

advice on using ksnip as an editing and markup tool check 

out the step-by-step guide (opposite).

Snap with shutter
If you can’t find the markup tool you need in ksnip,  

then take Shutter for a spin (install it through Ubuntu 

Software). The tools share many similarities – including a 

shared reliance on the GNOME Screenshot Portal in 

Wayland – and while we prefer ksnip’s workflow, there are 

a few reasons why you might want to try Shutter.

First up is its support for exporting your screengrabs 

directly to a series of supported online accounts: Imgur, 

vgyme, Gyazo, Dropbox and ToileLibre are all supported 

along with FTP. Second, Shutter supports a wider range of 

graphics for ‘stamping’ on your images – whereas ksnip 

gravitates towards a selection of smileys, Shutter provides 

more practical icons such as errors, information, questions 

and even a selection of callout graphics, inside which you 

can combine with a text object to form a label. Note that 

they’re bitmaps and don’t scale up well – see the Quick Tip 

for a way to add more scalable vector stickers to ksnip.

Third, Shutter’s plugin repository has seen it benefit 

from more than a dozen post-capture effects being added, 

including effects like turning your grab into a Polaroid 

photo complete with caption to a wider range of border 

effects. The plugins crashed when running in Wayland, but 

worked fine once we switched to Xorg. Apply them from 

the main Shutter window via the ‘Screenshot>Run a 

plugin…’ before clicking Edit to annotate your grabs. 

post-capture annotation tools to choose from, each with 

their own unique features, and both programs can be 

installed through Ubuntu Software. They are Shutter  

and ksnip.

Let’s start with ksnip. In Wayland, it’s unable to capture 

screenshots using its own tool; instead, it relies on the 

GNOME Screenshot Portal, which works in a similar way to 

the old GNOME Screenshot tool. It can be installed any 

number of ways – through Ubuntu Software (choose the 

ubuntu-jammy-universe version over the snap in Ubuntu 

22.04), or you can visit https://github.com/ksnip to 

discover how to obtain it as a flatpak, DEB/RPM package 

or standalone AppImage.

Once installed, open ksnip through the Launcher and  

it’ll place its icon on the menu bar. Click this to reveal a 

pop-up menu with various options: Show Editor, 

Screenshot Portal and Open (which works with any image 

file, not just screen captures). 

To take a screenshot, choose Screenshot Portal and it’ll 

immediately capture the entire screen and open it in the 

separate Screenshot Portal application. Ignore this initial 

capture and click the Options… button to configure the 

portal to grab the entire screen, the current window or a 

user-selected area. You can also set a delay timer in 

seconds, plus capture the cursor and add a border effect 

to any captured windows, just as with the old Gnome 

Screenshot tool.

Once you have configured your choices, click  

Take Screenshot and a new capture will be taken. If  

you’re happy with your grab, click Share to transfer  

it to the ksnip editor; if not, click Options… to try again.

 KDE’s built-in screenshot tool is flexible 

and powerful, and ideal for KDE desktop. 

 Shutter 

provides a wider 

choice of icons 

for labelling your 

screengrabs 

with, but 

beware: they’re 

bitmapped, so 

don’t scale well. 

Shutter may ship 

with more stickers 

than ksnip, but the 

latter supports 

scalable vector 

graphics (in SVG 

format). You can 

add your own via 

Tools>Settings 

>Annotator> 

Stickers. You’ll find 

loads of free vector 

art online – start 

your search at 

https://openmoji.

org/library.

Quick
tip
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Quick tips with ksnip

1  Go native
If you’d like to give ksnip’s own screen capture tool a go, log out  

of Ubuntu. Click your username followed by the cog in the  

bottom-right corner, then select Ubuntu on Xorg and log in. 

Launch ksnip to reveal a New option with five capture types as 

shown above. It also has its own global shortcuts: use Alt+Shift 

instead of just Shift.

3  Crop to perfection
Sometimes it’s easier to crop an image after capture. Thankfully, 
ksnip includes a dedicated Crop tool for this very purpose. After 
capturing your image, click the button and your image will be 
enclosed in a bounding box – you can resize this through click and 
drag, or use the X, Y, W and H fields at the bottom to set it 
manually. Click Apply when done.

5  Rearrange items
Every annotation you place on your image is treated as a separate, 
movable object. Click it to select it, where you’ll find  
you can resize and move it easily. By default, newer labels sit  
on top of older ones, but if you right-click the currently selected  
object and open the Arrange sub-menu you can choose how  
items overlap each other.

6  Add a watermark
Protect your images with an image-based watermark. Select Opti
ons>Settings>Annotator>Watermark and click Update to select 
your image file, such as a scan of your signature. Ignore the 
cramped look in the box – the image’s original aspect ratio will be 
respected when you choose Edit>Add Watermark. A faded copy 
of the image will be shown, which can be resized and moved.

4  Copy and paste
When you create a new object, ksnip always reverts to its default 
settings, including font and size. To get around this, select your 
existing object, right-click it and choose Copy, then right-click 
where you want the new object to go before choosing Paste. A 
duplicate will be created for you to modify – if it’s a number, it’ll 
automatically go up in sequence.

2  Resize windows quickly
Want to resize a program window to a specific size before 

grabbing it? First, install wmctrl ( sudo apt -y install wmctrl ), then 
open Settings and navigate to Keyboard>View and Customise 
Shortcuts>Custom Shortcuts. Create your shortcuts using the 
following command, changing 1280 and 720 to your desired width 

and height:  wmctrl -r :ACTIVE: -e 0,200,200,1280,720 . 
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USB drive and can be often purchased online or in store. 

Once you insert the media and boot the computer, a series of 

steps will guide you through the installation.

The version of Windows that you choose to install 

shouldn’t matter, whether it’s Windows 7, 8 or 10. The type of 

program that’s used to get the system started after turning it 

on, either legacy BIOS or EFI boot, may matter in some cases 

but on most modern systems this won’t cause any major 

issues. Let’s get some basic terminology out of the way. 

EFI stands for Extensible Firmware Interface, and most 

modern system partitions are in this format, which adheres to 

the UEFI (Unified Extensible Firmware Interface) standard. 

UEFI replaces the Basic Input/Output System (BIOS) that 

most PC devices used before. This is important mostly for 

more advanced users who wish to manually set partitions for 

more customised setups. Since most modern systems use 

UEFI, we’ll work on the assumption that you will too.

Each hardware manufacturer has a different 

implementation of UEFI and each has its own unique quirks. 

Most have the same basic functions and structure, which 

allow for the installation of different operating systems. 

However, Different UEFIs can manifest major problems for 

some and instant success for others. Different button 

settings, boot menus, and startup sequences can cause 

problems when you are trying to mess with the boot 

sequence. It’s best to research your manufacturer’s UEFI 

manual beforehand and familiarise yourself with the settings 

before you try to change anything. Most system boot 

Dual boot: Set 
up two OSes
Afnan Rehman dives deep into the world of dual-boot systems to bring you 

the simplest solution to the two OS problem.

W
e live in a world where multiple operating systems 

hold a share of the desktop market and 

applications aren’t always available on every 

platform that you want them to be, it’s often necessary to 

have more than one OS available ready to boot. Virtual 

machines offer only a partial solution to this problem as do 

compatibility layer technologies such as Wine. The solution is 

to dual-boot two OSes on the same machine. 

The boot managers of modern day OSes can manage 

multiple systems and allow the user to choose which one to 

boot at startup. This way you can have Windows OS and a 

Linux distro, so that you can keep the beautiful experience 

that is Linux while also accessing applications that still only 

work well on for work or play. (Not every game supports 

SteamPlay on Steam for Linux, although we’re getting closer). 

In this tutorial, we’ll focus specifically on dual-booting a Linux 

distribution (distro) with Windows. We will be using Ubuntu. 

However, the steps in this tutorial can be adapted to other 

Linux distros.

First, let’s talk a little bit about why we dual boot. There are 

many reasons people pursue a dual-boot solution, the key 

reasons being performance and compatibility. As most users 

will tell you, it’s best to run things natively with access to the 

computer’s hardware resources. The fact is, virtual machines 

will severely restrict the amount of resources that you can 

use. When you implement a dual-boot system, you’re able to 

boot as if Linux is the main OS and Windows weren’t there 

and vice versa. That gives you access to all the processing 

cores, all system RAM and all expansion cards that the 

computer has to offer, making it easy to run intensive 

programs without slowdown. You also get access to all disks 

and externally connected devices such as USB devices at full 

speeds (as long as the OS supports them, of course).

How dual-booting works
For the sake of brevity, we will assume you are able to install 

Windows without a detailed explanation. It’s safe to say that if 

you’ve ever installed a Linux distro, you are more than ready 

to install Windows on your own. If you’re a newcomer to Linux 

– welcome! – and you’re likely to have Windows installed on 

your current system (given that the Windows family still has 

around 90% of the market) and can proceed directly to 

creating a dual-boot system as a fresh reinstall of Windows 

isn’t required. If you haven’t tried installing Windows before, 

the process is simple and there are many guides online to 

help you. The installation media is usually sold on a disk or 

 The Disk Management tool provides an easy to 

understand graphical interface for partitioning and 

managing storage on all disks that the OS has access to.

Make sure to 

disable Fast 

Startup before 

installing Ubuntu 

to avoid issues with 

GRUB detecting 

the Windows 

installation. You 

can disable it in the 

Windows power 

management 

advanced settings 

under ‘Shutdown 

settings’ where you 

can uncheck ‘Turn 

on fast startup’.

Quick
tip
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pick and choose what to save for later. It would be best to 

save this backup on a separate physical device, such as a 

different hard drive, a different computer or possibly cloud 

storage if you have enough space and a fast enough 

connection. The simplest way to back up everything you need 

to back up is to make a recovery disc which will back up 

Windows itself and set up a File History backup to take care of 

personal files. There are wizards located in the Control Panel 

that will guide you through both of these backup processes. 

The recovery disc will help you restore Windows system and 

boot files in case something goes wrong with the operating 

system. File History will automatically back up personal files 

to a designated device in case the worst comes to pass and 

your entire drive partition gets corrupted.

Now that you understand the basics, let’s get to work. 

The first thing you’ll need to do is choose your distro of Linux 

that you want to install. For this tutorial, we’re using Ubuntu 

16.04. The most important thing you will need to start is a 

copy of Ubuntu live CD on a USB flash drive or compact disc. 

You can download your preferred version of Ubuntu from its 

website at www.ubuntu.com/download. Here you can 

download an ISO file that you can use to create a DVD or 

bootable USB flash drive. We recommend creating a bootable 

flash drive as it’s more versatile than a DVD, especially with 

optical drives getting phased out of many newer systems to 

save space, weight and power. Once you have a flash drive 

made you can move on to getting your partitions in order to 

prepare for the installation. 

Of course, now you will only be able to resize the Windows 

partition if there’s a decent amount of available space on it, so 

make sure you have room before you commit to undertaking 

this project. If your computer is running multiple hard drives 

you also have the option of installing Linux on an entirely 

different drive, leaving your Windows partition untouched. 

Now before you run out and purchase a brand new hard drive, 

I’ll remind you that the two installations are perfectly capable 

 The diskpart tool allows you to accomplish partitioning and storage tasks with 

a command line interface for more advanced users and those who might wish 

for more custom settings.

Always keep a copy 

of the Ubuntu live 

CD and Windows 

installation disc on 

hand. These two 

discs are essential 

and will save your 

bacon should the 

worst happen. 

The tools and 

functionality will 

help reverse most 

common issues 

and can be used to 

help recover data in 

a pinch.

Quick
tip

What to do when you mess up
Should you need to repair the Ubuntu bootloader 

after trying to install a dual-boot system, the 

Ubuntu wiki has some great instructions for 

helping to repair the bootloader. The link is 

https://help.ubuntu.com/community/

RecoveringUbuntuAfterInstallingWindows. 

The recommended way would be to use an 

Ubuntu live CD or USB that you created when 

first installing Ubuntu. The simple graphical way 

is to insert your disk or flash drive, reboot the 

computer and boot into the live CD environment. 

From this environment, you can choose the Boot 

Repair tool which is built into the Live CD.

The boot repair guides you through solving 

more frequent problems, such as those 

associated with dual-boot and can also generate 

error reports that you can share on forums or 

email to your genius friends who are more Linux 

savvy to get help with the issue. For recovering 

Ubuntu, you can click ‘Recommended Repair’ 

and allow it to work its magic. Then all you have 

to do is reboot and the usual boot menu should 

appear. If not, you can hold left Shift key while 

booting to select between the two operating 

systems. You can also try to repair it by opening a 

terminal. When you are given a standard Bash 

prompt, type:

# sudo grub-install /dev/XXX

Replace  XXX  with your Ubuntu install device 

(eg. /dev/sdb).

sequences will feature a splash screen where you can press a 

function key to gain access to boot settings menus (for 

example, it’s F9 for HP, F12 for Dell and Lenovo, F8 in Amibios 

and F11 in an Award BIOS) and you’ll need to know which key 

it is to open which menus and which settings to change. 

Knowing these things beforehand can save you a lot of 

headache should the need for troubleshooting arise.

Partition standards
You’ll also hear the acronyms GPT and MBR thrown around. 

These terms relate to how partitions in the hard drive are 

organised and recorded. MBR, which stands for Master Boot 

Record, refers to the information stored in the first sector or 

partition of the hard drive that identifies how and where an 

operating system is located so that it can be loaded into the 

computer’s main storage or RAM.

GPT, which stands for GUID Partition Table, is similar in 

function to MBR in that it stores partition information for the 

hard drive. This information includes where the partition starts 

and ends so that the OS knows which sectors belong to which 

partition and which ones are bootable. MBR, which was first 

introduced back in 1983, can only handle drives that are up to 

2 terabytes in size and can support up to four partitions per 

drive. GPT is a newer standard that has been gradually 

replacing MBR and handles drives that are far larger and allows 

for a nearly unlimited amount of partitions. If you have Linux 

the GRUB bootloader, which handles OS booting just like the 

Windows boot loader, is often stored in the MBR or GPT. It’s 

important to note that Windows can only boot a GPT drive on a 

UEFI-based machine. All current versions of Windows, Linux 

and Mac OSX support GPT and it’s generally recommended to 

use this scheme on any new installs for the sake of 

compatibility and to avoid issues that MBR might bring.

There are benefits and drawbacks to either installing 

Windows or Linux first and every system is different. In this 

guide, we will be taking you through the process having 

Windows installed first. It’s possible to install Ubuntu first, but 

there are far fewer issues when having Windows installed first, 

as the Linux GRUB bootloader can adapt easily to 

accommodate Windows. In contrast, the Windows bootloader 

will almost always disregard the presence of another existing 

OS, often overwriting the existing bootloader and rendering 

the other OS useless until it’s repaired.

It’s important to note that while most of Linux distros are 

good at handling dual-boot situations, there’s always room for 

something to go wrong. We highly recommend performing a 

backup of any existing data to a separate storage device just 

in case the worst happens. Any files, settings or applications 

can be backed up in a variety of ways that will allow you to 

https://www.ubuntu.com/download
https://help.ubuntu.com/community/RecoveringUbuntuAfterInstallingWindows
https://help.ubuntu.com/community/RecoveringUbuntuAfterInstallingWindows
https://help.ubuntu.com/community/RecoveringUbuntuAfterInstallingWindows
https://help.ubuntu.com/community/RecoveringUbuntuAfterInstallingWindows
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When backing 

up your data, 

make sure your 

backup storage is 

separate, reliable, 

and spacious. 

By keeping it 

physically separate 

from the main 

device, and making 

sure it is reliable 

and spacious 

enough to hold all 

of your data, you 

will reduce potential 

issues with the 

backup failing.

Quick
tip

 The shrink 

volume dialog 

box in Disk 

Management 

allows you to 

shrink a partition 

size, and also 

warns you if your 

desired shrinkage 

is too small.

of running in harmony on different partitions of the same 

physical drive.

Partitioning methods
There are a few ways to handle partitioning, so I’ll explain the 

one that assumes you have Windows already installed. If you 

already have Windows installed, the easiest method is to just 

use the diskpart utility built into Windows to help with this 

process. Every drive is different, and it’s likely you’ll have 

multiple partitions already existing on the hard drive, such as 

recovery, OEM and primary etc. Be careful resizing or deleting 

these partitions as messing with the wrong one will lead to 

major issues. Usually, the partition labelled ‘Primary’ is the 

largest and is where most of your files and data are held. Any 

partitions labelled ‘System’ or ‘OEM’ should not be modified 

at all, as those hold Windows system files and cannot be 

changed, lest you risk the entire system being corrupted. The 

Primary partition could be resized to give you space for your 

Linux installation. The easy way to do this is to go into the 

Disk Management application, find your drive with the 

primary Windows installation, right-click the partition and 

select ‘Shrink Volume’. After that, just follow the onscreen 

instructions and you’re good to go. Now you’ll see a section of 

the drive with a black bar above it labelled as ‘Unallocated’. 

This is where your shiny new Linux installation will go. 

Alternatively, if you’re feeling brave you can lose any partition 

named ‘Recovery’ and install there. However, make sure you 

know what you’re getting yourself into when you do this.

Now, you can restart and boot from a USB or disk into the 

Ubuntu live CD by holding down the Shift key while rebooting. 

On booting, hit the appropriate function key to load the boot 

menu, where you can select which device to boot from. Find 

your flash drive and hit Enter to commence the boot process. 

You’ll be loaded into the Ubuntu live CD environment with its 

basic feature set. Here, you can start the installation process.

Now follow the onscreen instructions to install Ubuntu. 

Make sure to choose options that would allow for the Ubuntu 

install to exist alongside the existing Windows installation. 

Don’t try to overwrite it, because that would be disastrous. 

This step will involve you as the user deciding how much 

space to allocate for your Linux installation. You’ve already set 

aside space for the Ubuntu installation in Windows Disk 

Management, but you also have the option to use more or 

less space depending on how you want to do things. In 

Ubuntu, there are two ways to install alongside Windows. 

First, there’s an option labelled ‘Install Ubuntu alongside 

Windows’ which will handle everything for you. Some other 

Linux distros, such as those using Calamares installer, offer 

similar options to simplify the process. Otherwise, you can 

also make and resize partitions using the installer. If you 

choose this route, you can select ‘Something Else’ when 

prompted for installation type. You can resize the partitions 

based on your needs and use case. If you’re mainly using 

Linux to experiment, you may not need as much space as if 

you were, for example, heavily invested in Linux gaming or 

dealing with other large amounts of data. Make sure that the 

boot loader remains the Windows Boot Manager.

The installation process itself will vary depending on the 

Linux distro that you want to use. For Ubuntu, the process is a 

fairly simple step-by-step walkthrough. You can choose to 

install updates during the installation, however, you can skip 

this if you have a poor internet connection or just want to 

install them later. At the very end, you’ll be asked to restart. 

At this point, you’re done and can start using your Ubuntu 

Install. Switching between OSes would involve a simple 

reboot. When booting you’ll be given the option to load either 

Windows or Ubuntu, usually with a default option that will 

automatically boot after several seconds. If you’re not 

receiving these options, try some basic troubleshooting by 

retracing your steps.

Sometimes you may find that you need to remove the 

Linux install for whatever reason. Remember, when removing 

Linux from the dual-boot process you must be very careful so 

as not to break your bootloader and, in turn, create a massive 
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headache which can possibly go as far as rendering the 

Windows install unusable. 

Removing Linux
To start, you’ll need your Windows installation or recovery CD 

or an Ubuntu live DVD. To remove the GRUB bootloader, open 

the command prompt from the installation or recovery media 

environment. Next, type: 

> bootrec /fixmbr

Reboot and boot into Windows. Then move onto using the 

Ubuntu live CD. Boot from the CD and choose Boot-Repair. 

If it isn’t installed then you can try to install through a few 

simple terminal commands that you can type one by one:

$ sudo add-apt-repository ppa:yannubuntu/boot-repair

$ sudo apt-get update

$ sudo apt-get install boot-repair

Next, simply  boot-repair  and click the ‘Recommended 

Repair’ option.

Last, to remove the Ubuntu partitions you’ll need to head 

back into Windows, reboot and boot into Windows and open 

Disk Management by searching for it in the Windows menu. 

In disk management, right click the Ubuntu partitions and 

select ‘Delete’. This is the point of no return so make sure 

you’re good to go before you click that button. If you plan to 

just keep using Windows then right click the Windows 

partition and select ‘Extend Volume’. This will increase the size 

of the Windows partition to fill up the free space. That should 

be all that is needed to restore the machine to using only one 

operating system. 

Now that you know how to add and remove operating 

systems to and from a computer in a dual-boot situation, 

you are ready to tackle your own project with other distros 

and combinations. As a final note, there’s also the possibility 

of adding more OSes to your boot sequence, creating triple-

boot or multi-boot systems. Adding systems essentially 

follows the same basic steps of partitioning and adding as 

space allows to the hard drive. With more operating systems 

comes more versatility and using the bootloader to your 

advantage can allow you to truly make your computer your 

own and design an environment suited to your needs. 

Re-ordering the Boot Manager
You’ll notice that when you boot from a 

shutdown state there’s a certain order to things. 

The Windows operating system or the Linux one 

will be given priority and unless you press keys 

during startup you’ll end up automatically 

booting into one system or the other, whether 

you wanted to or not. 

This is a common issue that’s easily remedied. 

You can use the EFI Boot Manager tool that you 

can access from an Ubuntu Live CD. Once in the 

Live CD environment open a terminal and install 

EFI Boot Manager with the following:

 $ sudo apt-get install efibootmgr 

Next use the following command to find out 

the current boot order situation:

 $ sudo efibootmgr .

You’ll get an output that looks something like 

this, with the boot order listed:

BootOrder: 0004,0001,0002,0005

Boot0001 Windows Boot Manager

Boot0002 Network

Boot0004 ubuntu

Boot0005 Hard Drive

Boot0006 CD/DVD/CD-RW Drive

To change the boot order, we will have to use 

the numerical codes which correspond to the 

boot device that we want first. For example, 

in this case we want the system to try to boot 

from CD first, followed by Ubuntu and Windows. 

So, we will use the following command to 

change the boot sequence:

$ sudo efibootngr –o 0006, 0004, 0001

That’s it, you’re now ready to go.

 The manual partitioning tool in the Ubuntu installer is 

similar to many partitioning GUI tools.

 The Ubuntu 

live environment 

allows you to 

try Ubuntu right 

off of the disc, 

so you can use 

it to test some 

features and 

prepare your 

machine before 

writing anything 

to disk.
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support and Wine offered the best way to enjoy Windows 

gaming without Windows. At the end of 2012 Valve Software 

started offering Linux support for its Steam platform and 

today a large number for indie and big-name games are 

available directly for Linux through Steam, GoG.com and 

other services. But for older games and applications Wine is 

still entirely relevant.

Start Wining
The way Wine works can be a little confusing, but Wine isn’t 

something that runs in the background. You use it to run your 

Windows EXE files, this includes their original install files. 

Wine then sits as this “compatibility layer” between the 

Windows program and the strange, alien landscape of 

Ubuntu. This layer is pretty comprehensive but largely 

invisible, the most visibly obvious aspect of this is that Wine 

recreates the standard Windows file structure (the C: drive, 

Program files folder, Windows folder etc) within its own Linux 

Ubuntu folder.

This is for multiple reasons, not least this is how programs 

will expect things to be placed, but also the Linux and 

Windows file systems are incompatible. To start, Windows is 

Wine: Windows 
plays on Linux
Moving to Linux doesn’t mean totally abandoning Windows, there is still a way 
to run some Windows programs right within Ubuntu.

U
buntu does provide everything a happy and free 

computer user should need, but being pragmatic 

sometimes it’s not possible to totally cut ties with 

every Windows programs. For those programs that you still 

need there is a system called Wine – Wine Is Not an Emulator 

– that can attempt to provide an in-Ubuntu solution. 

What it is and what it isn’t: Wine is a compatibility layer, 

that’s to say it inserts itself between Ubuntu and the Windows 

program making that program think it’s still running under 

Windows. As it says it’s not an emulator, in many ways an 

emulator like VirtualBox might do a better job, but takes more 

resources to work. Being a compatibility layer means Wine 

works with varying levels of success.

If there’s a specific program you want to try to run with 

Wine it’s advisable to first look at the Wine application 

database https://appdb.winehq.org this ranks compatibility 

using Platinum, Gold, Silver, Bronze and Junk statuses. While 

there will also be a detailed outline of what does and does not 

work. Anything ranked Bronze or Junk is highly likely not to be 

worth trying.

You’ll notice that a lot of the entries are for games. Up until 

the end of 2012 Linux was very poorly serviced with gaming 

Here’s the 

Windows version 

of Picasa running 

under Ubuntu.
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case insensitive that’s to say a program called “HELLO” looks 

the same as one called “hello”, under Linux they are treated 

as two entirely different files. Another oddity is under 

Windows folders are distinguished with a backslash \ under 

Linux it’s a forward slash /.

These are more things to be aware of rather than worry 

about as for the basic use we’re covering it shouldn’t be an 

issue. Occasionally though when locating files from within 

Ubuntu, Wine and other Windows programs it’s useful to be 

aware of this.

We’ve created a basic walkthrough that shows you how to 

install and run a standard Windows tool onto Ubuntu and 

then run it. We’re using Wine at its very basic level, there’s a 

whole world of more complex features that can improve 

compatibility but it’s beyond this beginner’s guide. Instead we 

can point you in the direction of some pre-build versions and 

bolt on paid-for services that try to make Wine work better.

The first and your first port of call should be www.

PlayOnLinux.com this is a front-end to Wine and offers a 

large list of pre-built and tested configurations for many 

Windows games and programs. The PlayOnLinux system 

makes it very straightforward to install and launch your 

1  Install Wine
Open the Ubuntu Software program (it should be in the dock) and 

search for Wine. Oddly it’s called Configure Wine, select this and click 

Install. Installation can take a while, but once it has completed before 

you do anything launch Wine. This enables Wine to do its initial 

configuration, such as building the base Windows folder system.

2  Ignore the GUI
You can nose around the Wine GUI, but at this point there’s nothing 

you need change. It’s useful to note that you’re able to map more 

Ubuntu drives to standard Windows drives letters – ie add a D drive – 

through its Drives tab. Instead we’re going to download a standard 

Windows program, Notepad++ and install it.

3  Install Notepad++
Grab this from a reputable download site like www.filehippo.com/

download_notepad save the install EXE to your desktop or Download 

folder. Once finished locate the file and right-click on it then select 

Open in Wine. Wine needs to handle the installation so it can set up the 

charade that Notepad++ thinks it’s in Windows land.

4  Run Notepad++
You’re able to place Windows icons on the desktop – if you choose – 

and Wine is able to ensure they work correctly. Once the install has 

finished all that’s left is to double click the desktop icon. Otherwise you 

can locate the program through the Dash Search. More technically 

files are stored under the standard ~/.wine folder.

Wine - get started

Windows programs. But why wouldn’t you install this over 

Wine? First it requires Wine anyway and secondly it only 

supports a limited number of programs that are known to 

work well. 

The commercial arm of Wine is a product called 

CrossOver available from www.codeweavers.com it’s aimed 

at businesses and provides a dedicated support service for 

running Windows programs on Linux.

Another option to keep in mind is that the version of Wine 

maintained by Ubuntu is v1.6, the latest stable release is 

actually v1.8.x. It’s worth reading the release notes to see if 

that improves compatibility for games or programs you want 

to use. Getting the latest version is a matter of following a few 

basic terminal commands, though ensure you uninstall any 

version via the Ubuntu Software tool, if you’ve already done it 

that way. A handy guide can be found at https://wiki.

winehq.org/Ubuntu.

Really, Wine isn’t the answer, we’d strongly suggest 

seeking out native Ubuntu apps rather than continuing with 

trying to use a Windows program. We’ve listed a number of 

common alternatives on page 34, but thousands more are 

out there just waiting to be discovered. 
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Terminal: How 
to get started

emulator – technically it’s emulating a TeleTYpe (TTY) 

session. It has all the functionality you’ll need, but both XTerm 

and UXTerm are worth noting because although they are 

more minimalist tools and neither require any dependencies 

to run. This means if anything stops the main terminal from 

running, you can use either as a backup. As an aside, the only 

difference between the two is that UXTerm supports the 

expanded Unicode character set.

How Bash works
The Linux shell uses the Bash shell and command language 

to perform tasks, and it uses a relatively straightforward 

syntax for each command: utility command -option .

The ‘utility’ portion of the command is the tool you wish  

to run, such as  ls  for listing the contents of a directory, or  

 apt-get  to trigger the APT package management tool. The  

 command  section is where you specify exactly what you 

want the utility to do, eg typing  apt-get install  instructs the 

package management utility to install the named package, eg:  

apt-get install vlc .

The  -option  section is where one or more ‘flags’ can be 

set to specify certain preferences. Each flag is preceded by 

one or two dashes (--) and the most useful of all is the  --help  

option, which provides a brief description of the utility, plus 

lists all available commands and options, eg  ls -l .

Flex those fingers and dive head first into the inky darkness of the terminal. 
Let us show you how to start handling its mysterious commands.

T
he terminal is an incredibly important part of your 

Linux desktop. It doesn’t matter how wedded you are 

to point and click over the command line, at some 

point you’re going to have to dip your toe in the terminal’s 

dark expanse and use it. Don’t worry, though, because the 

terminal isn’t as scary as it might appear, and if you take the 

time to learn the basics you’ll discover it can be a far quicker 

and more effective way of getting certain tasks done.

As you’d expect, a terminal effectively gives you access to 

your Linux shell, which means it works in exactly the same 

way using the same language (Bash). This means you can do 

anything in the terminal you’d normally do at the command 

line, all without leaving the relative comfort of your desktop. 

That makes learning how to use the terminal – and Bash – 

doubly advantageous as it gives you your first glimpse into 

working with the underlying Linux shell. 

We’re basing this tutorial on Ubuntu, so start by opening 

the Dash and typing ‘terminal’ into the search box. You’ll find 

the terminal of course, but you’ll also see two entries called 

UXTerm and XTerm too. This highlights the fact there are 

multiple terminal emulators that you can run in order to 

interact with the shell. There are differences between them, of 

course, but fundamentally they do the same thing.

For the purposes of this tutorial we’re sticking with the 

default terminal, which is basically the gnome-terminal 

 The --help flag can be used with any command to find out what it does, plus 

what arguments to use.

If you’re struggling 

to type the right 

command, you can 

wipe all previous 

actions from view 

simply by typing 

clear and hitting 

Enter. Note this 

won’t affect your 

command history.

Quick
tip

Speed up text entry
It doesn’t matter how fleet of hand your typing skills are, the 

command line can still be a time-consuming, frustrating 

experience. Thankfully the terminal comes equipped with 

lots of handy time-saving shortcuts. This issue let’s take a 

look at how you can easily access previously used 

commands and view suggestions:

 Up/down arrows Browse your command history.

  history  Use this to view your command history

 Ctrl+r Search command history. Type letters to narrow 

down search, with the most recent match displayed, and 

keep pressing Ctrl+r to view other matches.

 Tab View suggestions or auto-complete a word or path if 

only one suggestion exists. Press ~+Tab to autofill your 

username, @+Tab to autofill your host name and $+Tab to 

autofill a variable.
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The  -l  flag tells the list directory tool to provide detailed 

information about the contents of the folder it’s listing, 

including: permissions; who owns the file; the date it was last 

modified; and its size in bytes. Utilities can be run without any 

commands or options – eg  ls  on its own provides a basic list 

of all folders and files in a directory. You can also run utilities 

with a combination of commands and/or options.

Restricted access
Open the terminal and you’ll see something like this appear: 

username@pc-name:~$ . This indicates that you’re logged on 

to the shell as your own user account. This means that you 

have access to a limited number of commands – you can run  

 ls  directly, eg, but not to install a package using  apt-get , 

because the command in question requires root access. This 

is achieved one of two ways – if you’re an administrative user, 

as the default user in Ubuntu is, then you can precede your 

command with the  sudo  command, eg  sudo apt-get install 

vlc . You’ll be prompted for your account password, and then 

the command will run. You should find that you can run more  

 sudo -based commands without being re-prompted for your 

password (for five minutes) while the terminal is open. On 

some distros you can log on to the terminal as the root user 

with  su   – you’ll be prompted for the root password at which 

point you’ll see the following prompt:  root@pc-name:~$ .

Once logged in, you can enter commands with no 

restrictions. We recommend you use the  sudo  command 

rather than this approach and if you’re running Ubuntu then 

you’ll find  su  won’t work because the root account 

password is locked for security reasons.

When installing some distros or adding new users to 

Ubuntu, you may find your user account isn’t added to the  

 sudo  group by default. To resolve this, you need to open the 

terminal in an account that does have root access (or use the  

 su  command if supported) and type  sudo adduser 

<username> sudo . You can also add the user to other groups 

with the command by listing all the groups you wish to add, 

eg:  sudo adduser <username> adm sudo lpadmin 

sambashare .

Another handy tool is gksudo, which allows you to launch 

desktop applications with root privileges. It’s of most use 

when wanting to use the file manager to browse your system 

with root access:  gksudo nautilus . Make sure you leave the 

terminal open while the application is running, otherwise it’ll 

close when the terminal does. When you’re done, close the 

application window, then press Ctrl+c in the terminal, which 

interrupts the currently running program and returns you to 

the command line.

We’ve already discussed the  --help  flag, but there are 

other help-related tools you can use too. First, there’s  

 whatis  – which you can type with any command to get a 

brief description of it and any specified elements, eg  whatis 

apt-get install vlc  will describe the apt-get tool, the install 

argument and what package vlc is. Flags are ignored.

If you’re looking for a full-blown manual, then the man 

tool provides access to your distro’s online reference manual, 

which is started with  man intro . This provides you with a 

long and detailed intro to the command line. Once done 

press q to quit back to the terminal. For more advice on 

navigating the manual, type  man man  or pair it with a tool, 

eg  man ls .

Now you’ve taken your first steps into the world of the 

terminal, check out the box (Your First Terminal Commands, 

above) for some useful package management commands 

you can work with. Next, we’ll look at how to navigate your 

filesystem from the terminal, plus launch programs and delve 

into more useful shortcuts to help speed up the way you 

interact with the command line. 

Your first terminal commands

While it’s possible to install and manage software using a 

combination of the Software Center and Ubuntu’s Software 

& Updates setting panel, it’s often quicker to make use of the 

Advanced Package Tool (APT) family of tools. Here’s some 

key ways that they can be used (see sudo use below): 

  $ apt-cache pkgnames  Lists all available packages from 

sources listed in the /etc/apt/sources.list file.

  $ sudo add-apt-repository ppa:<repository name>  Adds a 

specific Launchpad PPA repository to the sources list.

  $ sudo apt-get update  Gets the latest package lists 

(including updated versions) from all listed repositories.

  $ sudo apt-get install <package>  Installs all the named 

package. This will also download and install any required 

dependencies for the packages.

  $ apt-get remove <package>  Use this to remove an 

installed package. Use  apt-get purge <package>  to also 

remove all its configuration files, and  apt-get autoremove  to 

remove packages installed by other packages that are no 

longer needed.

  $ sudo apt-get upgrade  Upgrades all installed software – 

run  sudo apt-get update  before running this. Other useful  

 apt-get  commands include  apt-get check  a diagnostic tool 

that checks for broken dependencies,  apt-get autoclean , 

which removes Deb files from removed packages.

 The apt-cache package can also be used to search for specific packages or 

reveal a package’s dependencies.
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Terminal: 
Work with files

the folder begins with a capital letter – as your personal 

Documents folder does, eg – you’ll get an error about the 

folder not existing if you type it all in lower case, eg,  cd 

documents . You can also move down several levels at once 

using the following syntax:  cd subfolder/subfolder2 . To move 

back up to the previous level, use  cd .. , you can also use the  

 /  character to move up multiple levels at once, eg  cd ../..  

moves up two levels.

What if you want to go somewhere completely different? 

Use  cd /  to place yourself in the root directory, or navigate 

anywhere on your system by entering the exact path, 

including that preceding  /  character to indicate you’re 

navigating from the top level, eg  cd /media/username .

The  ~  character works in a similar way to  / , except this 

places you in your home directory. So typing  cd ~/

Documents  is the same as typing  cd /home/username/

Time to turn our attention to navigating your file system and  
manipulating files and folders from the beloved Terminal.

P
reviously we introduced you to the basics of using  

the Terminal. We opened by revealing it works in the 

same way as your Linux shell; how commands are 

structured (utility command -option); plus gave you the tools 

to manage software packages and get further help. This time, 

we’re going to look at how you can navigate your file system, 

work with files and folders and learn some more time-saving 

shortcuts in the bargain.

When you open a new Terminal window, the command 

prompt automatically places you in your own personal home 

folder. You can verify this using the  ls  command, which lists 

the contents of the current folder. The default Terminal 

application displays folder names in blue, and filenames in 

white, helping you differentiate between them. The  ls  

command can be used in other ways too. Start by typing  ls -a  

to display all files, including those that begin with a period 

mark ( . ), which are normally hidden from view. Then try  ls 

--recursive , the  --recursive  option basically means that the 

contents of sub-folders are also displayed.

If you want more detail about the folder’s contents – 

permissions settings, user and group owners, plus file size (in 

bytes) and date last modified, use  ls -l . If you’d prefer to list 

file sizes in kilobytes, megabytes or even gigabytes depending 

on their size, add the  -h  option—so use  lh -h -l  instead. 

There are many more options for  ls  and you can use the  

 --help  option to list them all.

Navigating your file system is done using the  cd  

command – to move down one level to a sub-folder that’s 

inside the current directory use  cd <subfolder> , replacing 

<subfolder> with the name of the folder you wish to access. 

Remember that folder and filenames are case sensitive, so if 

Speedier navigation
In last part we revealed some handy keyboard 

shortcuts to help you enter commands more 

quickly, but the following keys will help you 

navigate the Terminal itself more efficiently:

 Home/End Press these to jump to the 

beginning or end of the current line.

 Ctrl+left/right cursor Move quickly 

between arguments.

 Ctrl+u Clear the entire line to start again.

 Ctrl+k Delete everything from the cursor’s 

position onwards.

 Ctrl+w Delete the word before the cursor.

Accidentally omitted  sudo  from your command? 

Just type  sudo !!  and hit Enter to repeat the last 

command with  sudo  applied to it. And if you 

make a typo when entering a command, instead 

of retyping the entire command again, just use the 

following syntax to correct the mistyped word (in 

the following example,  dpkg  was originally 

mistyped as dkpg):

^dkpg^dpkg

 Make good use of ‘ and \ characters when folder paths 

contain spaces and other special characters.
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Documents . One final trick —you’ve jumped to another 

directory, but how do you go back to the previous directory 

quickly? Simple, just type  cd -  to do so.

Working with files and folders
You can now list directories and navigate your file system, 

but what about doing something practical, like moving and 

copying files? You’ll find a range of different commands exist, 

and the tricks you’ve learned about navigation will hold you in 

good stead here too.

Let’s start by looking at commands for copying ( cp ) and 

moving ( mv ) files and folders. The same options apply to 

both commands. The basic syntax is cp/mv <source> 

<target>. The source and target can be complete paths 

following the same rules for the  cd  command, but it’s 

generally good practice to first navigate to the folder 

containing the file or folder you wish to copy or move. Once 

done, you can simply specify the file or folder name as the 

source, like so  cp invoice.odt ~/Documents/Backup .

This creates a copy of the file with the same name. 

The following copies the file to the specified directory and 

renames it too:  cp invoice.odt ~/Documents/Backup/invoice-

backup.odt . If you want to create a copy of the file within the 

same file, simply use  cp invoice.odt invoice-backup.odt .

Substitute  mv  for  cp  in any of the above commands, 

and the file is moved, moved and renamed or simply 

renamed. What happens if there’s already a file called 

invoice-backup.odt in existence? It’ll be overwritten without 

as much as a by your leave, so make sure you’re asked if you 

want to overwrite it by adding the  -i  flag like this  mv -i 

invoice.odt invoice-backup.odt .

You can also copy folders using the  cp  or  mv  

commands. Here, you need to include the recursive option, 

which ensures the folder is copied across with all its contents 

and correctly arranged in their original locations relative to 

the parent folder:  cp -r ~/Documents /mnt/sdb1/Backup/ .

If the Backup folder exists, then the Documents folder 

will be recreated inside it; if not, then the Backup folder is 

created and the contents of the Documents folder are copied 

into it instead.

Use the  rm  command to delete a single file, eg  rm 

invoice.odt . The  rmdir  command deletes folders, but only 

empty ones. If you want to delete a folder and all its contents, 

use the command  rm -r foldername .

You can also create new folders with  mkdir  command – 

simply type  mkdir  folder, replacing folder with your chosen 

folder name. Use the  touch  command to create an empty 

file, such as  touch config.sys .

Wildcards are often used to speed things up in searches, 

and can also be applied to file commands too – the asterisk  

( * ) character can be used to quickly access a folder with a 

long name, eg  cd Doc* .

This works fine if there’s only one folder beginning with 

Doc, but if there are two (say Doctor and Documents), then 

the command would open the first matching folder, which is 

Doctor in this instance. To avoid this, use  cd Doc*ts  instead 

(unless you have a folder called Documents and Doctorists).

Two characters that are more useful when navigating are 

the single quotation mark ( ‘ ) and backslash ( \ ) characters. 

Use single quotation marks around files or file paths that 

contain spaces, such as  cd ~\Documents\Doctor Who .

You should also use quotation marks when creating 

folders in this way, eg simply typing  mkdir Doctor Who  will 

actually create two separate folders called Doctor and Who, 

so type  mkdir ‘Doctor Who’  to get the folder you want.

You can also use the  \  character to get around this too, eg 

 mkdir Doctor\ Who  works in the same way, because the  \  

character instructs  mkdir  to treat the following character (in 

this instance the space) as ‘special’.

We finish off by revealing some handy characters that 

allow you to run multiple commands on a single line. The  &&  

argument does just that, so you can do the following to 

quickly update your repos and update all available software:

sudo apt-get update && sudo apt-get upgrade

 &&  is like the AND command in that the second 

command will only be performed if the first completes 

successfully. If you wanted the second command to only run 

if the first command failed then you’d use  ||  instead. If you 

want the second command to run after the first regardless of 

what happens, then use the  ;  eg,

sudo apt-get update ; sudo apt-get remove appname

instead: of  && . 

Boost your learning
Now you’re starting to flex your muscles in 

Terminal, how about expanding your knowledge 

by instructing it to display information about a 

random command each time you open it? To do 

this, you need to edit a file, so open the Terminal 

and type the following:

nano ~/.bashrc

This opens the file in the nano text editor. Use 

the cursor keys to scroll down to the bottom of 

the file, then add the following line to it:

echo “Did you know that:”; whatis $(ls /bin | 

shuf -n 1)

Press [Ctrl]+[o] to save the file (just hit Enter to 

overwrite it), then [Ctrl]+[x] to exit nano. Now 

close the Terminal window and open a new one to 

get a brief description of a command. Just type 

the following,  with the actual command listed for 

a longer description:  <command> --help .

Some file managers 

allow you to 

right-click a folder 

and open the 

Terminal at that 

location, but you 

have to manually 

add this option to 

Ubuntu’s Nautilus 

file manager. 

Install nautilus-

open-terminal 

from the Software 

Center, then open 

a Terminal window, 

type nautilus -q 

and press Enter. 

The option will 

now appear.

Quick
tip

 Use ls to find out more about the files and folders in a current directory.
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Scan and print: 
How to start

Once installed, Click the ‘Add’ button to see if your printer 

is visible and supported. If your printer is connected via USB, 

but not showing up – as is likely – then you’ll first need to 

locate suitable drivers for it. Start by looking for Linux drivers 

on your manufacturer’s website and for your particular distro 

(you may need to find a unified package). Hopefully your 

exact distro (including version number) will be supported, 

but don’t panic if it’s not; we successfully installed a Dell 

B1265dnf all-in-one printer in Ubuntu 14.04.3 LTS using a 

unified package that only promised support up to 11.04.

If you’re lucky, the driver may be supplied in a Deb 

package, in which case downloading and double-clicking it 

should launch the setup wizard. If your driver is provided as a 

tarball (with a .tar.gz extension), then it’ll probably contain a 

shell script (.sh) installer, in which case follow the step-by-

step guide opposite to discover how to get it up and running. 

Once done, re-open the CUPS front-end under System 

Settings and your new printer should be visible.

Network setup
If you’re adding a networked printer, then you should be able 

to spot it without having to first source drivers. Click ‘Add’, 

expand ‘Network Printer’ and wait or click ‘Find Network 

Printer’. After a short pause any detected printers should 

show up. Select yours and you’ll see a choice of connection 

protocols appear. (See What Connection Type? box, over the 

page for details of which one to choose if you’re given the 

option.) Select IPP if it’s available, otherwise choose LPD or 

visit your manufacturer’s website to see if it provides a driver 

that will likely offer an IPP connection if you install it.

If you’re happy to proceed with the options offered by 

CUPS, click ‘Forward’ and it’ll look for drivers, selecting them 

automatically if available. If it can’t find any you’ll be given 

three choices: select from database, provide a PPD file or 

search for a driver to download. Start by selecting your 

printer manufacturer to see if an exact match is available. 

If not, try a search – again, you may want to expand your 

search to your web browser, as it’s limited in scope.

You can also use a PostScript Printer Description (PPD) 

file if your printer is a PostScript model and you can source 

one (search for your printer name and model and the word 

‘PPD’). This provides CUPS with a description of its 

capabilities, which it can use when outputting files.

If all else fails, don’t worry: choose ‘Select printer from 

database’ again, but this time select ‘Generic 

(recommended)’ and click ‘Forward’. A generic PCL driver will 

Let’s run through some tips to get your printers and scanners up and running 
using systems and tools such as CUPS, SANE and XSANE.

T
hese days, it’s almost mandatory to have a printer 

and scanner attached to your PC, but getting them 

set up in Linux can be a little tricky. Don’t worry, 

though, because armed with the right drivers and tools  

you can quickly get things up and running. There are two  

core tools built into most Linux distributions (distros) that 

help simplify the process: CUPS for printers and SANE for 

scanners. CUPS provides a centralised management tool for 

adding and configuring your printers while SANE allows you 

to interface with your scanner in much the same way, as  

well as providing the tools you need to preview and scan 

images. We’ll be focussing on these for this tutorial, coupled 

with some useful tools that mean you don’t need to go into 

the terminal should you need to access or tweak them.

With other operating systems, you can usually plug and 

play your printer or scanner – the drivers will either already 

be pre-installed or you’ll be prompted to download a driver, 

or insert a manufacturer’s disc. While it’s not quite that 

simple in Linux, the fact is that armed with the right 

procedure you shouldn’t have to spend hours getting things 

set up.

The good news is that you don’t need to start your search 

at your manufacturer’s website when installing your printer. 

If you’re lucky, you may find the drivers are already in place, 

particularly if your model is a network one, in which case all 

you need to do is open the CUPS front-end and see if it can 

detect your printer.

CUPS should be pre-installed with later versions of 

Ubuntu – including 16.04 LTS – and you can access it from 

System Settings by clicking ‘Printers’. If it’s not there, install it 

through the Software Centre (search for ‘printer’ and select 

Printers) or via the terminal using  sudo apt-get install cups .

 Network 

printers can 

often be set up 

even without 

drivers thanks 

to CUPS.
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be pre-selected, so try this first: either the pxlmono or 

pxlcolor option depending on whether your printer is mono 

or colour. Click ‘Forward’ to install it – in most cases this will 

provide all the core functionality you need.

Whichever route you go down when adding your printer, 

you’ll be prompted to provide a name, description and 

location for it, then asked to print a test page – we 

recommend this to verify the connection is working. Once 

done, you’ll be taken to the printer’s configuration screen, 

where you can examine its settings and see what control you 

can wield over it.

Tweak printer settings
The main Settings tab allows you to change your printer’s 

description and location, plus change its URL. If you click 

‘Change…’ next to ‘Device URI’ you can attempt to connect 

using a different protocol. This is also where you’ll find 

options for printing test pages and maintaining the printer.

The Policies tab allows you to change the printer’s state in 

terms of whether it’s enabled, accepting jobs or shared. 

You can also define what happens if the printer encounters 

an error and switch on authentication for its ‘Operation 

Policy’ if supported and required (if you go down this route, 

access the printer via the CUPS web interface to set things 

up and running).

Access Control allows you to deny (or allow) access to the 

printer on a user level. You should spend some time in both 

Printer Options and Job Options tab where you configure key 

printer defaults. Printer Options is mainly concerned with 

default quality and paper settings, while Job Options lets you 

configure things like the number of copies, page orientation, 

and individual elements such as text and images.

Finally, if your printer allows it, the Ink/Toner Levels 

provides a handy glance at your printer’s core components, 

including elements like the fuser.

Now your printer is set up, it’s time to use it. Open an 

application and when you’re ready, choose File > Print. 

Your printer should be listed, so it’s simply a case of  

tweaking whatever options are made available to you in the 

application’s own dialog and clicking ‘Print’. If you have more 

than one printer installed, the default one will always be pre-

selected; change this via the System Settings > Printers 

dialog by right-clicking your target printer and choosing  

‘Set as default’.

In most cases, the CUPS tool provided under System 

Settings should have all the options you need, but CUPS can 

also be administered from your browser: type  localhost:631 

to access it. There’s a handy overview and links to the CUPS 

forum should you need it, but use the tabs at the top of the 

page to navigate the web-based utility. Go to Printers and 

click your printer to access its settings – here, navigation is 

done through a series of drop-down menus. If you’ve 

installed a dedicated driver and were asked to assign a user 

to it, you’ll be prompted at this point to enter the username 

and password to access the required pages.

If you’ve set up a network-connected printer, you should 

also be able to access machine-level settings directly by 

typing in its IP address. If you don’t know its IP address, it’s 

 Once installed, administer your printers using the 

Printers tool under System Settings.

Struggling to get 

your printer to 

function correctly? 

Visit http://

openprinting.

org/printers and 

see if your model 

is covered. If it is, 

scroll down to the 

comments to see 

if anyone else can 

help (or post your 

own question in 

the forums).

Quick
tip

1  Obtain & extract installer
Browse to your manufacturer’s website and 

locate the required driver for your Linux distro, 

which may be packaged as a unified driver. 

Save the gar.tz file to your Downloads folder, 

then right-click it and choose ‘Extract Here’. 

Once that’s done, open the extracted folder 

and locate a file called install.sh.  

Right-click it and choose ‘Properties’ to make 

a note of its location.

3  Follow install guide
You’ll need to work your way through the  

installer wizard and make sure that you tick 

your username to allow you to access the 

printer. Once the wizard’s complete, you may 

then be prompted to configure the printer for 

CUPS and need to follow its wizard to set it up, 

entering name, description and location, if 

required, before going ahead and testing the 

printer to finish the process off.

2  Start installation
Now you’ll need to open up a terminal window 

and type in  cd <path> . You’ll need to replace 

<path> with the path listed under Location for 

the install.sh file that’s found in its Properties 

window. Now you’ll need to type the following 

command and press Enter, followed by your 

root password when prompted:  sudo sh 

install.sh . After a short pause you should see 

an installer wizard pop up.

Install a printer driver tarball package

http://openprinting.org/printers
http://openprinting.org/printers
http://openprinting.org/printers
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What connection type?

If you’re hooking up a network printer, then you’ll have been 

given a choice of connections when setting your printer up. 

But what are the different protocols and which one should 

you choose if given the choice?

The simplest protocol is AppSocket (also referred to as 

HP JetDirect). It’s usually used when no other connection is 

possible, but its simplicity also means it lacks any kind of 

fine control: eg there’s no queue management so you can’t 

abort print jobs once they’ve been sent. There’s also no way 

to find out the printer’s status, making it impossible to 

discover ink and toner levels, eg.

Next up is LPD, which stands for Line Printer Daemon 

(also known as LPR, or Line Printer Remote). This does 

implement queue management, and can tell the difference 

between different types of data, such as raw text or 

PostScript information. There’s neither support for remote 

setup nor management, though, and you can’t query the ink 

or toner (although these may be provided anyway) and your 

print jobs can’t be encrypted.

The final protocol – IPP – is the most contemporary and 

functional. It stands for ‘Internet Printing Protocol’ and is 

what CUPS uses as the basis for managing both print jobs 

and queues. It’s the preferred method of communication as 

you get more feedback from the printer and wield more 

control over it thanks to its bidirectional nature.

 Select your protocol carefully when configuring your network printer using 

CUPS, we’d suggest that IPP is the best if it’s supported.

If you’re trying to 

extract text from 

a multi-columned 

document, make 

sure you use YAGF’s 

tools for correcting 

page skew and 

selecting multiple 

columns before you 

attempt recognition 

to maximise your 

chances of having 

a successful 

extraction.

Quick
tip

under the printer’s Settings – click ‘Change’ next to ‘Device 

URI’ and expand Network Printer. The IP address will then be 

listed in brackets after your printer name. Enter the URL 

address and you’ll be given access the printer itself, giving 

you even greater control over how it functions and who has 

access to it and when (eg setting up duplex options for 

double-sided printing).

Printer classes
CUPS allows you to group multiple printers into classes. This 

is mainly aimed at networks where lots of users want to 

share a limited number of printers. Each class has a 

hierarchy with those printers added first being preferred to 

those added later. When people come to print using a class, 

they’re allocated a printer based on availability, so if one 

person is printing they’ll always get access to the first printer, 

while if two are printing at the same time, the first person 

gets the preferred printer and the second gets the next 

available one.

With this in mind, it definitely pays to work out how you 

want your printers classed: do you want the faster ones 

made available first, or are you looking to try and steer 

people towards a high-volume printer such as a laser? Once 

done, open System Settings > Printers and click the ‘ˇ’ 

button next to Add and select ‘Class’.

You’ll be prompted to provide a name, description and 

location in terms of a single printer, but it’s better to think in 

terms of the class, eg, ‘study-printers’ or something similar. 

Once done, click ‘Forward’ and you’ll be prompted to add 

existing printers to the class – remember to add them in 

order of preference. Once done, click ‘Apply’. Once created, 

you can set this class as your default in place of a single 

printer – just right-click its entry and choose ‘Set As Default’.

Linux also offers good built-in tools to help you access 

and make use of your scanner. In many cases – particularly 

with newer models – you can simply plug it in and there’s a 

good chance it’ll work. That’s due in part to built-in support 

for SANE (Scanner Access Now Easy), which provides all the 

back-ends to scanning in Linux.

To see if you’re lucky, plug in your scanner to a spare USB 

port and fire up Simple Scan to see if it detects it. If it does, 

you’re in business – skip to the next section; if it doesn’t – 

don’t panic. First, check for Linux drivers with your 

manufacturer. Follow the instructions to download and install 

 The success – or failure – of OCR is largely down to the 

quality of the original document.

 Some printers 

ship with their 

own utilities, 

which may 

provide you with 

more control over 

its settings.
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these – again, if they’re provided with an install.sh script, 

follow the step-by-step guide to get them installed.

If your scanner is part of a multi-function device than its 

drivers should be integrated with the printer’s – if you added 

the printer component of a MFP without installing specific 

drivers, then you’ll need to source and install these to get the 

scanner up and running. If you’ve installed drivers previously, 

but the scanner isn’t detected, try installing them again over 

the top of the original drivers – we found this worked with 

our Dell B1265dnf after the scanner failed to show up. Once 

installed, your drivers may provide their own utility to help 

you verify the scanner is now recognised – eg Dell users 

should see a DELL Unified Driver Configurator shortcut on 

the desktop – or you’ll need to fire up Simple Scan again at 

which point your scanner should now be visible.

For more troubleshooting advice on using SANE to detect 

your scanner, see https://help.ubuntu.com/community/

Scanners or take a look at the box on VueScan.

As we’ve seen, Ubuntu comes with the Simple Scan 

front-end for SANE, which provides you with a simple, 

no-frills interface for your scanner. It’s good for confirming 

your scanner works, but it lacks key tools like a preview 

function or the ability to fine-tune your scanner’s settings.

Time to scan
However, if you really want to push the boat out, open the 

Ubuntu Software Center and search for ‘xsane’ to locate and 

install XSane, a more powerful scanning front-end. Once 

launched it’ll display four windows – start by clicking ‘Acquire 

preview’ to create a preview of the image you’re trying to 

scan. Once done, use the Standard Options window to select 

your image – choose ‘Custom’ under Page Format and then 

crop in using the four measurements beneath it.

Next, click the 1:1 magnifying glass button in the main 

window to zoom into the preview. Use the eyedropper tools 

to select white, black and grey parts of the image for colour 

correction purposes, then use the histogram’s sliders in the 

top left-hand window to fine tune the colour balance. The 

right-hand window is where you choose where to save the 

file, what format to use and so on – choose 16 million (this is 

24-bit) colours for photos and ensure the scan resolution is 

increased from 75dpi to 300dpi or 600dpi if you want a 

hi-res scan. There are also controls for adjusting brightness, 

contrast and gamma.

By default, your scan will open in XSane’s Viewer window 

when you click ‘Scan’ – it’s a good idea to perform one scan 

like this, so you can review your image and perform further 

optimisation. Once you’re happy with your changes, click 

‘Viewer’ and change it to Save, then click ‘Scan’ one last time.

Another benefit of XSane is that it integrates with Gimp – 

this allows you to scan directly to it, and then fine-tune your 

image accordingly. Launch Gimp, choose File > Create > 

XSane to select your scanner or perform a search for 

available devices. Everything’s handled identically except for 

one critical part: there’s no output option, so once you click 

‘Scan’ the image will automatically be transferred to Gimp.

XSane also links in with the goocr tool to a built-in Optical 

Character Recognition (OCR) engine. This allows you to scan 

in printed documents and convert them into editable text. 

It’s a flexible solution, but if you want to try something else 

then install both cuneiform and YAGF from the Ubuntu 

Software Center. Cuneiform is an alternative OCR engine 

while YAGF provides a neat front-end to both cuneiform and 

tesseract and is an OCR engine that’s renowned for its 

accuracy. YAGF integrates nicely with XSane too – launch 

YAGF, click the ‘Scan’ button and it’ll open XSane. Set the 

colour to ‘Black and White – Line Art’ and set the dpi to 600. 

Click ‘Scan’ and the document will be scanned and sent back 

to YAGF. From here, review the scan quality, then use the 

controls above the scanned image to prepare it for 

recognition. Once done, click the red ‘OCR’ button next to the 

language drop-down menu. YAGF will use Tesseract by 

default to decode the page, with the editable text placed in 

the right-hand pane for you to review and correct. Don’t like 

the results? Choose Settings > OCR Settings, select 

cuneiform and click OK, then try that instead – in our tests, 

Tesseract performed better, but not by much. Be prepared to 

try and fine-tune the original scan if necessary to make the 

text as clear and legible as possible.

Once you’re done reviewing and editing the text, you can 

save it as a TXT file or copy it to the clipboard, ready for 

pasting into Writer or another editing program.

Congratulations, your scanner is now set up to perform 

both standard and text-based scans. 

It’s also possible 

to use CUPS to 

‘print’ documents 

to PDF file where 

no native PDF 

option is provided. 

Install cups-pdf 

from the Ubuntu 

Software Center – 

once done, a new 

PDF printer will 

appear as an option 

when printing.

Quick
tip

 XSane provides a comprehensive set of scanning tools.

Get unsupported scanners working

If, after your best efforts, you’re still unable to get 

your scanner set up using SANE, then take a trip 

to www.hamrick.com where you’ll find a 

program called VueScan, which promises to 

support over 2,500 scanners. 

Click the supported scanners link to browse 

by manufacturer – if your model is listed, then 

download the tarball and extract the VueScan 

folder, then double-click vuescan inside to 

launch the program proper. It should detect your 

scanner automatically, then provide you with a 

simple step-by-step wizard to preview and scan 

using the program. 

VueScan provides a lot of useful tools to help 

you get the perfect scan, and it works with many 

scanners that are already supported in Linux 

too, so if you’re struggling to get to grips with 

XSane, consider giving it a whirl. The only 

downside is that it’s not free – the Standard 

Edition costs $39.95, while the more fully 

featured Pro Edition costs $89.95 (you can 

upgrade from Standard to Pro for the difference 

at any time, too). The good news is that VueScan 

is fully functional for the purposes of evaluation 

(other than a watermark across all your scans), 

so you can be sure it’s right for you before 

making a purchase.

https://help.ubuntu.com/community/Scanners
https://help.ubuntu.com/community/Scanners
http://www.hamrick.com
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don’t really need to be backed up as you can simply insert 

your DVD again but if you are aware of other folders outside 

your home folder where you have stored data, click on the + 

button at the bottom left to add these to your backups.

If you have more than one user on your computer, while 

it’s technically possible to add their home folder here, this can 

cause errors further down the line. Complete this guide and 

then have them log into their account and do the same from 

there. You can use the same hard drive to back up more than 

one account provided there’s enough space. Click on Folders 

to Ignore, this section tells the backup manager which folders 

not to back up. By default the Downloads folder is excluded 

as these files tend to be easy to replace. 

If you use a cloud storage provider like Dropbox, you may 

also want to exclude that folder from the backup as a copy 

already exists online as well as on your computer. Click the + 

icon once again and select the folder.

Storage and Scheduling
With your folders to save and ignore carefully chosen, click on 

Storage Location. If your external USB hard drive or memory 

stick isn’t already connected, do so now.

You will see that by default backups are stored in your 

home directory in a folder named deja-dup. This is not a 

particularly reliable place to back up as if the data on your 

hard drive becomes corrupted in future or it suffers a 

breakdown, the backup would most likely be affected too.

Click on Local Folder to open the menu and select your 

external drive. Click the box besides Folder to specify a name 

for a new backup folder on the device e.g Backups1. All future 

backups will be stored in there. 

Next, click on Scheduling on the left hand side of the 

window and click the rocker switch to turn on Automatic 

Backups. By default backups are performed weekly but you 

can change this to once a day if you wish. The Keep setting 

allows you to decide whether to delete old backups after a 

Backup: Don’t 
lose your data
Make sure that your most important files are backed up simply and 
automatically with Ubuntu’s own backup manager. 

A
nyone who has worked in Tech Support will tell you 

that the most heartbreaking calls come from people 

who have lost data due to a computer error or failure. 

Ubuntu saves you this trouble by integrating a backup 

manager into its OS. With a few simple clicks of the mouse 

you can have peace of mind that your data is safe.

Before proceeding, it’s best to buy an external hard drive 

that you will use exclusively for backing up. While the backup 

program Déjà Dup is able to delete older backups in favour of 

newer ones to save space, try to get as large a hard drive as 

possible to avoid losing any important older information. 

Remember that backups exist to protect your data from 

physical damage like fire and theft, as well as software errors. 

Try to store the hard drive in a separate location to your 

computer when you’re not carrying out backups.

Backup Basics
Click the search bar and type “backups” to launch the Backup 

Manager. You will see that Ubuntu asks you to install extra 

software to begin using backups. Click Install to proceed. You 

will need to enter your password to confirm you wish to install 

the backup utility Déjà Dup.

Once this is complete, the Backup Manager will inform 

you that you have no backups scheduled and you should 

either enable automatic backups or click Backup now. Before 

choosing either, it’s important to fine tune your settings.

First click on Folders to Save on the left hand side of the 

window. By default your Home Folder is selected. This 

contains your Desktop, Documents, Pictures, Downloads, 

Music and Videos folders and is therefore likely to hold 

everything you created yourself. Other files like system files 

 Click Install to download the backup utility. Go through the options on the left 

before clicking Backup Now to control where, when and how your data is saved.

 Click “Local Folder” to change where you store your 

backups–external drive and online backups are supported.

There are dozens 

of backup utilities 

available for 

Ubuntu. Head to 

https://help.

ubuntu.com/

community/

BackupYour 

System to view a 

list of these along 

with details of their 

features.

Quick
tip

Remember that If 

you are unable to 

restore your data 

visit Déjà Dup’s 

troubleshooting 

page at https://

wiki.gnome.org/

Apps/DejaDup/

Help/Restore/

Quick
tip
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certain amount of time e.g after 6 months or only to remove 

them to make way for newer backups (Forever). 

Your first backup
In the Overview section to apply your changes and run your 

first backup. Click Back up Now to open the backup window. 

At this stage you’ll have the option to choose a password 

to encrypt backups. This is very important in order to protect 

your data, as otherwise anyone who can access the external 

drive will see your files. Try to choose a strong password to 

keep your data safe. If you are stuck for inspiration, you can 

easily generate secure passwords via the Diceware 

Passphrase Home Page (http://world.std.com/~reinhold/

diceware.html). Make sure to write down your password and 

keep it in a safe place as you’ll need it to restore your data. 

Once the process is complete, the Backup Manager 

window will tell you that the last backup was today. You can 

head over to the folder on the external hard drive to view the 

files. Inside the folder you will see a file with the extension 

.manifest and a number of files with the extension tar.gz. Do 

not worry if you do not recognise the file names, they have 

been compressed in order to save space. The information in 

the .manifest file will allow them to be restored if necessary. 

Restoring Backups
If the worst happens and you are forced to reinstall Ubuntu 

with a blank hard drive, you will need to repeat the steps in 

Backup Basics to reinstall Déjà Dup on your machine. Make 

sure to connect your external drive to your computer as well.

Open the Backup Manager and click Restore. A window 

will open asking Restore from Where? where you can give the 

exact location of your backup folder and click Forward. Next 

you will see the Restore from When? window. Any backups 

you’ve previously made will be listed in the drop down menu. 

If you had to reinstall your system due to a software bug, 

make sure to restore from a time where you’re certain your 

computer wasn’t experiencing any issues and click Forward. 

This takes you to the Restore to Where? window. Usually you 

will want files to be copied back to their original locations e.g 

your Home folder. However if there is data already inside 

those folders or you only want to restore some of your 

information, you can choose to restore elsewhere such as a 

new folder.

Finally you will see the summary window asking you to 

confirm the backup location, date and destination folder. 

Click Restore to proceed. If the backups are encrypted you’ll 

also be asked for a password at this stage. 

Backup Bothers
Although the Backup Manager is very handy, it’s important to 

schedule backups and check that they are being run every 

now and then in the Overview section.

Déjà Dup has no built in method for recovering encrypted 

backups without a password so be sure to write this down on 

a piece of paper, as if you keep it on your computer, this may 

be lost if there is an error.

Ubuntu’s Backup Manager cannot easily be configured to 

back up an entire computer including all user accounts and 

system data. If you want an exact copy of the entire hard 

drive, consider using a different backup utility like CloneZilla 

(http://clonezilla.org). There’s also no elegant way to 

restore individual files but you can choose to retrieve your 

backup and place it into a new folder on your system. Be sure 

to delete any superfluous files when you are done to avoid 

duplicating data. 

 Check the progress of individual files click the small 

triangle next to details. Click Resume Later if you need to 

log out or shut down the machine for any reason.

 Check the 

summary to 

ensure that you 

are restoring the 

correct backup. 

Here the files 

will be copied 

to a new folder 

named test1 

instead of their 

original location. 

Backups made 

through Déjà Dup 

are incremental, in 

that it backs up only 

those files that have 

changed since the 

last backup. This 

saves time  

and space.

Quick
tip

Online Backups
While keeping a backup on an external drive is 

relatively safe, you may prefer to have the peace 

of mind of storing it online. If you use a cloud 

storage provider with a sync client like Dropbox 

then anything placed inside the relevant folder 

will automatically be backed up. Simply click on 

the Storage Location tab, then Local Folder and 

change the backup location e.g home/Dropbox/

mybackups.

Déjà Dup supports other types of online 

backup. The easiest to set up is probably FTP. In 

order to use this you will need to have FTP access 

to a server. DriveHQ (www.drivehq.com) for 

instance offers free FTP accounts with 1GB.

Once you have signed up for your account 

choose FTP from the Storage Location menu and 

fill in the information given by your provider. The 

Port Number is likely to be 21 or 22. You will also 

be asked to enter your FTPP username. The 

Folder”field simply asks where on the FTP server 

you want to store your 

backups e.g /mybackups.

Return to the Overview 

tab and click Back up Now. 

The first time you do this the 

Backup Manager will ask you 

to enter the password for 

your FTP account. Check the 

box to have the Password 

Manager remember this 

automatically in future. 

If you are backing up 

online it’s extremely important 

to encrypt your backups with 

a password to make sure they are safe. If you 

have very sensitive data it might be best to use a 

hard drive or USB stick instead. 

  FTP is one of a number of supported methods to backup 

your files online. You’ll be asked for your password.
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compatible with the most recent version of Ubuntu (See 

Mastering the Backports boxout). 

Clicking the Settings icon at the bottom left of the update 

window will display the Software and Updates window which 

allows you to fine tune your updates settings.

Reading Repositories
If you have previously used Microsoft Windows, you may be 

used to having to download individual programs from 

websites in order to install new applications. This can be time 

consuming and also isn’t very safe, given that anyone can 

write a program that contains malicious code. 

For an in-depth explanation of what repositories are and 

do, feel free to read Ubuntu’s documentation at https://

help.ubuntu.com/community/Repositories however in a 

nutshell they are servers which contain sets of software 

packages. They exist to make your life easier as thousands of 

programs can be gathered into a repository meaning you 

don’t have to search around for the right application. 

Some OSs like Ubuntu take this a step further and have a 

package manager (the Ubuntu Software Centre) which allows 

you to explore the available programs and see a short 

description to help you decide what you need. This is made 

even simpler by the fact that the Ubuntu Software Centre 

groups programs into categories such as Internet and Video.

There are many repositories available but the default ones 

used by Ubuntu are listed in the Ubuntu Software tab of the 

Software and Updates window you opened earlier. The first 

repository ‘main’ includes all software created by Canonical – 

the developers of Ubuntu. The ‘universe’ repository relates to 

free software which is maintained by the community through 

a dedicated group of people that contribute in their free time. 

This is often the reason that updates for certain apps do not 

come all at once, as different programs are maintained by 

different developers. 

Updates: Bug 
free & secure
Understand why, where and how to update your Ubuntu System.

U
sers who are familiar with the rather aggressive 

manner in which Windows 10 was presented to some 

people may be wary of the Ubuntu update process. 

Updating in Ubuntu fortunately is much easier and you will 

remain in charge of the way you run updates.

There are two ways to make sure that your software is up 

to date – from the command line and using the handy built in 

Software Updater. Running commands using Terminal can 

often be the fastest and easiest way to update but the 

Software Updater is more user friendly.

Simply click the search button in your menu bar and 

search for Software Updater . Click the app icon to run it and 

the system will check for updates. If there are updates 

available a window will appear saying that new software has 

been released and asking if you wish to install.

It may be tempting simply to click immediately on Install 

Now and allow the updates to run in the background but it 

can be helpful to have a deeper understanding of updates in 

order to better understand your system.

You will see that individual applications may be listed as 

eligible for updates such as Calculator, as well as Ubuntu 

Base which is the underlying source code of your OS. You can 

untick certain boxes to update each application however you 

should only to do this if you’re certain that updating may 

break a certain feature. This can be important if you’re using 

plugins or features of a program that you know aren’t 

 You can click 

Install Now to 

apply available 

updates but 

consider clicking 

Settings first 

to configure 

your update 

preferences.

 The system has automatically selected the closest server 

for downloads, in this case in Ireland.

You can also 

update individual 

applications 

from the Ubuntu 

Software Centre. 

Simply click the 

icon, then the 

Updates tab. Click 

Install beside each 

app to update.

Quick
tip
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The ‘restricted’ and ‘multiverse’ repositories contain 

software which isn’t free  and open. Examples could include 

software developed by private companies such as a driver for 

a laptop wireless card or Oracle’s Java Runtime Environment. 

Updates for these are usually provided by the manufacturer, 

not the Ubuntu community.

Understanding the difference between various types of 

repositories helps you to make informed decisions about 

what you want. There are Linux zealots who do not use any 

kind of proprietary software for instance, using free 

alternatives or simply doing without. When you set up your 

installation of Ubuntu you usually check the box to say you 

wish to download software to support some restricted 

formats like MP3 files but if you did not, you can do so now.

It is possible to add additional repositories to Ubuntu to 

allow installing additional packages. However Canonical have 

gone to great lengths to make sure that most of the 

applications you need are available in their official repositories 

so it’s best to search the Ubuntu Software Centre first before 

adding new repositories. 

Ubuntu should automatically ‘ping’ the nearest server for 

your country and display it but if you are having difficulty 

updating or Ubuntu has it wrong, you can change that here.

Ubuntu Updates
Clicking on the Updates tab in the Software and Updates 

window allows you to  fine tune your updates further. It’s 

advisable to leave both Important Security Updates and 

Recommended Updates checked. The Unsupported Updates 

are only important if you plan to keep using an regular non-

LTS (Long Term Support) version of Ubuntu. 

It is best to leave the other settings relating to when and 

how to install updates to their defaults. This way Ubuntu will 

automatically install any updates critical to the safety of your 

system but let you choose when to install other kinds. 

If you do make any changes in the Software and Updates 

window you will be prompted to reload your settings before 

being taken back to the Software Updater window. You’ll need 

a working internet connection to apply any changes.

Once you are back at the Software Updater menu click 

Install Now to start updating. You may need to restart the 

machine to effect changes once the update is complete. 

Ubuntu Upgrades
Since 2006 Canonical have been releasing two versions of 

Ubuntu per year, one in April, one in October. Each release is 

coded by month and year and has an alliterative animal 

name. Technically it’s possible to simply insert new DVDs into 

your new computer with the latest version of Ubuntu to install 

and upgrade, but this would wipe any data already on your 

hard drive. For this reason, Ubuntu has a built in tool to allow 

you to upgrade from one version to another.

Although two versions of Ubuntu are released per year, 

every two years Canonical will release an LTS (Long Term 

Support) version of Ubuntu. These versions can be updated 

without upgrading to the next available release of Ubuntu for 

up to five years. Ubuntu 16.04 (Xenial Xerus) is an LTS 

version, which means Canonical will keep releasing security 

and maintenance updates for it until 2021. Ubuntu 16.10 is a 

regular release which means that updates will be supported 

for nine months after its release.

Using the regular version of Ubuntu makes it less likely 

that you will have a problem with recent software or new 

hardware. The LTS release however saves you the trouble of 

doing a full system upgrade every nine months.

If you wish to go ahead with an upgrade to the next 

available version of Ubuntu, first run a regular update using 

Software Updater. Next click Search and type Software and 

Updates. Click the Update tab and find the menu option 

reading Notify me of a new Ubuntu version. Choose For any 

new version. You’ll be asked to enter your password to 

confirm. Close the window and then hold down Alt+F2. Type 

update-manager in the search bar and click the icon.

The update manager will appear saying the software for 

your current version is up to date but offering you the option 

to upgrade to the latest version of Ubuntu. Click Upgrade to 

read the release information, then Upgrade again to begin. 

This will take some time to download so make sure to save 

any work you have open. 

 Leave the security settings as they are but you can 

change the frequency for other updates if you wish.

Remember that 

The golden rule of 

upgrades is always 

to make a backup of 

your current system 

beforehand. See the 

Ubuntu Backups 

section for help 

with this.

Quick
tip

Mastering the Backports
Users who use the regular versions of Ubuntu which 

are released in April and October each year, will receive 

bug fixes and security updates through the Update 

Manager for nine months beginning from the date of 

release. Newer versions of software or features are not 

supported, however. 

One solution to this is to use an LTS version of 

Ubuntu but for those who do not wish to upgrade at all, 

the backports repository offers a third way, mainly 

through providing new versions of individual 

applications which can be updated without breaking 

your system. 

Although backport packages are tested by the 

Ubuntu Community there is a risk they may clash with 

a newer feature or program on your system so they 

should be used with caution. You can enable backports 

by ticking the checkbox next to Unsupported Updates 

in the Updates tab of Software and Updates. You will 

then be able to use the Ubuntu Software Centre to 

update your applications as usual. 

There are very few situations where using Backports 

is better than upgrading to the next version of Ubuntu 

or using an LTS release. If your system is running very 

important software and you can’t afford to take it 

offline, you may prefer to use the backports repository. 

Also updating via the backports repository can be more 

cost-effective if you pay for data you download versus 

installing an entirely new OS. 

If you have used backports previously and want to 

upgrade your system, this can cause instability. Try 

disabling backports and updating your system before 

going ahead. 

 The Plasma desktop is one 

example of a program that can be 

updated via Backports in Ubuntu.
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with those switching from Windows as it utilises a similar  

style of desktop.

Spice things up
Cinnamon is highly configurable. Its main customisable 

elements – known as ‘spices’ – are its themes, applets, 

desklets (widgets you can place on the desktop) and 

extensions. These allow you to radically alter its capabilities as 

well as its look and feel – the step-by-step guide (see right) 

reveals how to tweak many of these settings.

Four other desktop environments worth looking at include 

Xfce (www.xfce.org), Gnome (www.gnome.org), LXDE 

(www.lxde.org), and KDE Plasma 5 (www.kde.org). Even if 

you wanted to use Ubuntu’s default desktop, Unity, isn’t 

available as a standalone desktop for use in other systems.

There are lots of things to consider when choosing your 

desktop. How it looks is an obvious starting point, but does 

that translate into making it easier for you to use? Some 

desktops, eg, aren’t as configurable as Cinnamon, so it’s 

important you explore all the options there are before 

deciding if a desktop has the functionality and flexibility you 

need in a package you’re happy to look at. Despite their 

differences, you’ll notice similarities between many Linux DEs. 

That’s because they are basically variants of Gnome. Unity is 

the obvious example here, sharing many of its elements, but 

Desktop: Install 
and switch DEs
Don’t like your distro’s desktop? No problem. Trade it in for an  
environment that’s better suited to your needs.

O
ne of Linux’s great strengths is its versatility, and 

unlike other operating systems that ability to 

customise extends to your desktop environment 

(DE). Each distribution (distro) of Linux ships with its own DE, 

and while they share superficial similarities – specifically the 

point-and-click WIMP (Windows, Icons, Menus, Pointer) 

interface – there can be some quite radical differences in 

functionality as well as their look and feel.

The good news is that you’re not locked into your distro’s 

choice of desktop. Whether you’re planning to switch to a 

different distro, but are put off by the desktop that it employs, 

or you’re looking for a fresh way to interact with your desktop, 

Linux can accommodate you. In fact, you can even run 

multiple desktops side-by-side, allowing you to compare and 

contrast or use different desktops for different purposes.

Desktops are distributed as software packages, containing 

all the disparate elements required to make that desktop 

function (see the Anatomy of a Desktop box, below). Once 

desktops have been installed, you switch between them from 

the login screen by clicking the desktop icon that appears in 

the logon box next to your username.

So, if you’re itching to try out some alternatives to your 

default distro, we’d say you can’t go wrong starting with 

Cinnamon (http://cinnamon.linuxmint.com). It’s the 

default desktop in Linux Mint, and is particularly popular  

Don’t like the look 

of your new Xfce 

desktop? Ubuntu 

sets the default 

GTK theme for 

Xfce, which means 

missing icons and 

ugly looking panels. 

Change this to the 

Xfce style and Tango 

icons by selecting 

Applications 

Menu > Settings > 

Appearance.

Quick
tip

The anatomy of a desktop
Your desktop is the virtual environment in which 

you work, and provides a friendlier user interface 

with which to interact with your PC. The desktop 

consists of a number of different elements to 

produce the working environment you know and 

love – or hate, if you’re switching.

The desktop typically contains icons, 

windows, toolbars, folders, wallpapers and – 

optionally – desktop widgets. Most of what you’ll 

see is provided by the window manager. As its 

name implies it determines how the desktop’s 

windowing system works by taking responsibility 

for the placement and appearance of windows 

and their component parts, such as menus, title 

bars and control buttons. The desktop’s 

graphical elements – buttons, scrollbars, icons 

etc – are stored in special libraries. These 

include the widget toolkit, which is also utilised 

by applications so they can work seamlessly 

with the desktop. Two main toolkits exist: Qt and 

GTK, and while you can run applications made in 

one toolkit on a desktop built using another, they 

don’t tend to look as good.

Many of these elements are stored in a 

theme, which makes it easy for users to change 

a desktop’s look and appearance by defining 

how key elements look in terms of shape, colour 

and other elements.

Desktops also ship with a number of core 

tools and utilities, designed specifically to work 

well with that environment. Typical elements 

include a file manager, image viewer, text editor 

and terminal emulator, as well as a tweak tool 

that allows various aspects of the desktop to 

be customised.

It doesn’t matter how sophisticated your DE 

is, they all share the same building blocks: 

toolbars, desktop, widget and windows etc.

http://www.xfce.org
http://www.gnome.org
http://www.lxde.org
http://www.kde.org
http://cinnamon.linuxmint.com
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even the likes of Cinnamon betray their roots through the use 

of similar applications, built using the GTK toolkit that Gnome 

employs. The big rival to Gnome is KDE, and its differences 

extend beyond the fact it employs the Qt toolkit rather than 

GTK. For starters, it’s one of the most configurable tools out 

there, which makes it more popular with advanced users.

There’s also a question of performance and power 

consumption. Some desktops are more resource hungry than 

others, eg Unity and KDE Plasma 5. The increased demands 

do come with benefits, such as: a wider feature set, a bigger 

range of tools and flashier looks, which are missing from 

lightweight alternatives such as LXDE. But that means they’re 

less suitable for older and low-powered machines.

The best thing to do is run a couple of them and see how 

they perform – you should notice those with a smaller 

footprint are the most responsive, particularly on slow PCs. 

They also place fewer demands on power consumption, 

which should benefit those running on batteries. Remember, 

thanks to the fact you can easily switch between desktops, 

you can mix and match – a low-powered desktop while on the 

road, with a more fully featured environment for when 

plugged into the mains.

You’re ready to start experimenting with desktops, so how 

do you install them? In some cases you can simply search for 

the desktop using your distro’s software centre, but for others 

you may have to manually add the repositories (repos) 

yourself before installing through Terminal.

In the case of Ubuntu, you’ll find Xfce (type  xfce4  into the 

Search box to locate it), Gnome and LXDE are all available 

through the Software Center. Click ‘More Info’ when you’ve 

found one – because they usually ship with optional 

components added in, you might want to review these before 

clicking the ‘Install’ button. Cinnamon and KDE Plasma 5 

require a trip to the Terminal. In the case of Cinnamon, enter:

$ sudo add-apt-repository ppa:lestcape/cinnamon

$ sudo apt-get update && sudo apt-get install cinnamon

For KDE Plasma 5, use these commands:

$ sudo add-apt-repository ppa:kubuntu-ppa/backports

$ sudo apt-get update && sudo apt-get install plasma-desktop

Working with desktops
Once you’ve installed a new desktop, log out of your account. 

When you find yourself back at the login screen you should 

see an icon next to your username. Click this and you’ll see a 

list of available desktops appear – in some cases you’ll see 

multiple options based on a single desktop. Select one, then 

enter your password and log in as normal to start using it.

When you log into a new desktop for the first time, none of 

your existing preferences will come across from your old DE 

(but don’t worry, they’re all still there, ready and waiting for you 

the next time you log back into your original desktop). One of 

the benefits of having to make changes to your new desktop 

early on is that it forces you to explore, giving you insight into 

how it works and what tweaks you can perform. 

Remove unwanted desktops
You can install as many desktop environments 

as you like – aside from taking up space on your 

hard drive, they don’t consume any resources 

unless you’re actually running one. 

But there may come a time when you’ve 

finished experimenting with desktops, settled on 

your favourite (or favourites) and want to 

remove the rest. It goes without saying you 

shouldn’t be logged into the DE that you’re 

planning to remove.

With that prerequisite out of the way, 

removing the desktop is best done from the 

Terminal, particularly if you plan to remove all 

the software the DE installed alongside itself. 

Here’s the two commands you’ll need:

$ sudo apt-get remove packagename

$ sudo apt-get autoremove

Replace ‘packagename’ with the desktop’s 

package name, which will be one of the 

following: cinnamon, plasma-desktop (KDE 

Plasma 5), gnome, lxde or xfce4 (Xfce).

1  Tweak the taskbar
The Cinnamon’s taskbar is called the panel 

and is split into three sections: menu button, 

app shortcuts and applets. You can pin app 

shortcuts to it by clicking ‘Menu’, right-clicking 

the app shortcut and choosing ‘Pin to panel’. 

Right-clicking the panel reveals more options, 

like adding new applets or adding a second 

panel (choose ‘Modify panel…’).

3  Change behaviour
Hot Corners enable you to specify actions that 

occur when your mouse goes into a corner of 

the screen, such as showing the desktop or 

displaying all workspaces. Windows is where 

you can edit the way windows behave and 

alter the display of the task switcher. Finally, 

the Extensions allows you to customise using 

third-party plugins.

2  Customise look and feel
Click the ‘Menu’ button and select the ‘System 

Settings’ button to change the way Cinnamon 

looks. In the Appearance section, you can 

change the background and system font 

(you’ll see options from other desktops you’ve 

installed too). Selecting Themes and clicking 

‘Add/remove desktop themes…’ you can 

download more themes to pick from.

Customise your new desktop
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region. More interestingly it also holds settings for how the 

time is displayed at the top of the screen and how 

appointment notifications are handled. 

Device Colour Profiles is a largely overlooked area, partly 

as it’s not always obvious why it’s needed but also as the 

systems can seem needlessly complicated. We’re not going 

to try and explain everything here but the basic idea of colour 

management is to try and match the original colours of an 

image with the output colours, be that on a monitor, projector 

or printer. Just as the colours produced by a display vary, 

colours printed are again very different from printer to printer 

– while a display generates pure white, a printer has to use 

paper white. The colour management system attempts to 

compensate for this ensuring colours in photos look correct 

when viewed on a monitor or printed. If your device offers an 

ICC colour profile you can import that through the Colour 

Management settings to get better colour reproduction. 

Alternatively if you own a colour calibration device, you can 

calibrate your monitor via this setting too.

Power consumption is unfortunately something that Linux 

often fails short of when compared to running Windows on 

the same device. It’s partly to do with companies (that’s 

largely Intel) not supplying the best chipset drivers to the 

Linux kernel, but it’s also partly the basic power support Linux 

distros offer. You’ll find a basic Suspend timer, click the 

Screen Brightness link to also access the screen off timer, but 

that’s about it here. Using the Synaptic install you can add the 

indicator-cpufreq app to add a fine-grain control to the status 

bar at the top of the screen, after a reboot.

Users
User accounts are a key part of how Linux works, more so 

than with Windows. At its heart Linux is a multi-user system, 

Settings: Tweak 
your install
Everyone likes to change the preferences to suite their own likes, we take you 
through the most important areas worth looking at.

I
t’s highly likely that system settings are very important to 

you and rightly so, they ensure you can adjust how 

Ubuntu works to suit your tastes and needs. It’s clear how 

important settings are a link to Settings is provided right 

there on the Launch bar – look for the cog and spanner icon. 

All the standard controls can be found here. A number of the 

big sections found here we look at elsewhere in this 

magazine, for example the Display and Sound (and 

Bluetooth) are looked at in the next two sections over the 

page. While Network, Printers, Backup and Updates have 

their own sections too.

Before we tackle those we’re going to take a little time to 

ensure things are set to your liking, explain how to tweak the 

settings beyond the basics and improve the accessibility for 

people with visual and audio impairments.

To kick off we can cover the vital settings for the mouse 

and keyboard. We won’t insult your intelligence for the mouse 

settings, as it’s largely movement speed and mouse click 

speeds. Though there are options for click and dragging on 

touchpads. Keyboard settings include the ability to select 

your language and keyboard layout, alongside making it 

easier to access or opt for an on-screen keyboard if you don’t 

have one attached.

Shortcuts
The most useful section is the Shortcut tab in the Keyboard 

settings. Here you’re able to look up what the existing 

shortcuts are - this includes settings shortcuts for special 

keys that keyboards often have along the top - such as 

pressing Print Screen to grab the entire screen but also Shift 

Print enables you to select an area to grab.

Time and date options include, surprisingly, setting the 

time and date. It also enables you to set the timezone and 

Tweak town
As is seemingly always the case with operating 

systems – Ubuntu, Windows or OSX – it seems the 

creators never really want you to change their beloved 

interface too much. Even with the open source, huggy, 

community feel to Ubuntu, they never let people 

actually adjust it too much. On one side you can just 

install a new desktop – see page 72 for how you can 

do that – but it’d be nice if you could just tweak the 

default desktop. Thankfully you can, by installing a 

little tool oddly called Unity Tweak Tool. The Ubuntu 

desktop system is called Unity, hence the name  

and you’re able to install it through the Software 

Centre. Just tap Unity Tweak Tool into the search  

and click Install.

One of the key points that Ubuntu users have been 

calling for was the ability to shift the Launcher bar 

from the left-hand edge of the desktop down to the 

bottom edge. The Unity Tweak Tool was the first way 

to do that, though the functionality has been added to 

the official Display section. 

 The main way to tweak Ubuntu is 

using its Unity Tweaking tool.
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so it’s been designed from the start to accommodate multiple 

users working on the same system, yet being entirely secure 

from each other. At its most basic this means more than 

person can use the same Linux system, their files are entirely 

separated from the other users and they can have their own 

settings. Alongside adding, removing and changing accounts 

you can also launch a secure guest session to enable friends 

or strangers to temporarily use your system securely.

You can configure what applications should be started at 

login, in addition to the default startup applications 

configured on the system. Use the Dash to find and open 

Startup Applications. Alternatively, you can press Alt+F2 and 

run the gnome-session-properties command. Click Add and 

enter the command to be executed at login (name and 

comment are optional). For example, to make Firefox start 

automatically, it’s sufficient to type firefox in the Command 

field and confirm with Add.

Online accounts
Ubuntu can tie directly into a range of online accounts, this 

enables the OS to drag into notifications, emails calendar 

events and more directly to the built-in notification system 

and install programs. The Online Accounts system manages 

all of these and provides support for a small but useful 

number of accounts including Facebook, Google, Jabber (a 

chat system), Flickr and Yahoo!. It usefully also enables you to 

filter the accounts by what programs they can be linked into, 

this is useful for example if you want to know which enable 

images to be managed from Shotwell, for example.

Security and privacy
People take their privacy far more seriously these days – it’s a 

huge failing of Windows 10 and Google services – and even 

Ubuntu has had its slip ups. That’s why there’s a dedicated 

Security & Privacy section that’s dedicated to ensuring your 

details stay secure and on your PC. The section kicks off with 

the usual protections over requiring a password to wake from 

sleep and a blank screen. 

The next three tabs are about securing your details better. 

File & Application enables you to select what the Dash Search 

should return. You may want to remove your chat logs for 

example or if it’s annoying, not have it search music and other 

files. The Search tab can eliminate searching online and 

Diagnostics will block sending details back to Ubuntu HQ.

There’s also the Details section which provides just that on 

your system. Once you’re familiar with Ubuntu it’s not an area 

you’ll need to use much but make yourself comfortable by 

tweaking the settings to your liking. 

k 

 The Ubuntu 

settings look 

pretty thin on 

the ground and 

in a way they are, 

which actually 

makes life easy!

Language support

Generally you’ll choose your native language and 

keyboard settings while Ubuntu is installing, so 

you can type and read things easily. If you need to 

change this post install or add additional 

languages you can do this through the Language 

Support settings. When first chosen you’ll be 

prompted to install additional support files.

By default it’ll show the current active 

languages that are used by Ubuntu in its menus 

and windows. These are listed in order of priority, 

so if the first language is not available it’ll use the 

next one down. Installed languages that are not 

active will be shown in grey. To activate a 

language drag it above the base English option, 

wait a second and it’ll activate. Use the Install/

Remove Languages button to do just that, this 

opens up a huge array of languages, just tick the 

box of the new language you want to use. Activate 

it and click the Apple system-wide button. 

The Regional Formats tab section enables you 

to control how numbers, dates and times are 

displayed. There’s no fine control here, but it 

offers a wide range of base configurations for 

local regions.

Connected to the subject of language is the 

Text Entry settings. If you need to access more 

than one style of input language source, this 

provide controls over just that. Often people 

might need access to different keyboard layouts 

and this provides ways to switch between them 

using keyboard shortcuts and the top-bar 

language icon.
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that time meaning when you return to your machine you’ll 

need your password to access your desktop again. 

Most modern monitors and televisions are LCDs and do 

not suffer from the problems plaguing old CRT screens that 

used to result in images being burned into a screen if left on 

for too long, hence there being less need for screensavers.

Nevertheless if you prefer to see something more arousing 

on your machine than a blank screen when idle, you can do 

this by installing another. First click search and launch the 

Terminal application. Remove the existing screensaver by 

typing in the following command, then pressing return:

sudo apt-get remove gnome-screensaver

You will be asked to enter your login password to confirm 

that you wish to remove it. Do this and hit return. Next, hit Y to 

confirm that you do indeed wish to remove this program. This 

will only take a few moments. Now type the following 

command to install the new program along with a colourful 

selection of screensavers:

sudo apt-get install xscreensaver xscreensaver-data-extra 

xscreensaver-gl-extra

Hit Y once again and wait for the text to scroll past for the 

install to complete. Click the search button and type 

Screensaver to launch the new application.

You will see a variety of different screensavers in the box 

on the left hand side of the window. Feel free to scroll through 

these and then click the Preview button to see what they 

would look like full screen. As you will see from the Dropdown 

Menu Mode, the default setting sees Ubuntu cycle through 

the available screensavers randomly, however you have the 

option to tell it to choose one screen saver only or never to 

power off if you wish. 

Displays: Set  
all your screens
Master the basics of configuring you monitor options such as resolution, 
visual effects, screen savers and more. 

U
buntu is designed to be easy to set up and the 

default settings for your display should make for a 

user friendly experience. However if the default 

settings aren’t optimal or you wish to personalise Ubuntu, you 

should first click on Search and go to Appearance. 

From here you will see that you can choose from various 

built in desktop backgrounds. If you have downloaded your 

own background from the internet, you can also use this. 

Simply place your chosen image in your Pictures folder and 

from the drop down menu in Appearance, click Wallpapers 

then choose Pictures Folder and select your image of choice. 

Another useful tweak you can make here is to change your 

theme. As the name suggests themes are simply the way 

your system appears from the colour of window borders 

down to the fonts used. The default Ambiance theme can be 

changed to the lighter Radiance. You can also choose the 

High Contrast theme which might be useful for visually 

impaired users. Use the slider marked Launcher Icon Size to 

increase/decrease the size of icons on your launch bar. 

Ubuntu Screensavers
More recent versions of Ubuntu don’t come with any 

screensavers built in. The monitor will simply switch off after 

a certain length of time. You can access these settings by 

going to System Settings > Brightness and Lock.

By default the screen will dim itself to save power then 

lock after five minutes of inactivity. The screen will also lock at 

 Use the Appearance application to change your Wallpaper and Theme. 

 By default Ubuntu will cycle through random 

screensavers but you can choose just one if you wish. 

If you want to 

fine tune Ubuntu 

further, install 

Unity Tweak Tool 

from the Ubuntu 

Software Centre. It 

can change system 

fonts, cursors, 

and even install 

new themes. See 

https://help.

ubuntu.com/

community/

UbuntuEyeCandy 

for more 

information.

Quick
tip
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Click the checkbox next to Lock in order to require the 

password when dismissing the screensaver. 

If you want to fine tune your power settings click the 

Advanced tab and check the box next to Power Management 

Enabled. You can suspend or switch off your display after a 

certain amount of time.

Resolution and Rotation
The display resolution is simply the number of pixels that can 

be displayed on your monitor, usually expressed as width x 

height e.g 1024 x 768. Ubuntu will try to detect the optimal 

resolution for your monitor but you may wish to change this if 

the display is too small or you have specific requirements.

Click the search button and type Displays. This application 

will allow you to change various aspects of your display 

including the resolution. Click the drop down menu to see the 

various settings supported by your monitor. Click Apply at the 

bottom right to effect your changes. 

Below the resolution menu you can change the rotation of 

the screen if you have a specialised setup. You can also use 

the slider bar to increase the size of menu and title bars. The 

remaining settings pertain to using more than one display. 

See Multiple Monitors above for more help with this.

The Refresh rate is simply the number of times a second 

that images on your monitor are redrawn, measured in Hertz. 

For normal LCD displays a value of 60Hz is standard and 

Ubuntu should automatically detect the optimal settings for 

your monitor. However, newer high-end displays support 

faster rates up to 144Hz that you might need to select here 

but only if directed to by the manufacturer.

The easiest way to view and change the refresh rate is to 

install CompizConfig Settings Manager from the Ubuntu 

Software Centre. Once installed, click the icon to open it.

Compiz manages many of the visual effects on your 

desktop (see below) and is a very powerful tool. As such you 

will see a warning when you first launch the Compiz 

Configuration Manager. Click OK to dismiss this, then on the 

General category on the left hand side. Next click Composite 

to view the settings for the monitor refresh rate. If you wish to 

manually change this, uncheck the box next to Detect Refresh 

Rate and then specify a new value in the box below. 

Visual Effects
As mentioned the Compiz Configuration Manager is an 

extremely advanced tool and allows you to do much more 

than change a monitor’s refresh rate. It also governs visual 

effects for your desktop, windows and much more.

It’s not necessary to have these but it can make for a 

much slicker look and feel for your desktop. To explore the full 

range of options, first open your Terminal application and 

install some extra visual effects with the following command:

sudo apt-get install compiz-plugins-extra

Once installation is complete, open the  Compiz 

Configuration Manager and click on Effects on the left hand 

side. You will see that certain window effects are already 

enabled such as Fading Windows. Feel free to experiment by 

enabling/disabling other effects. The Compiz Manager will 

alert you if you try to enable two effects which clash. 

Display Dilemmas
As stunning as the visual effects are, they will place a greater 

strain on your graphics card which can be an issue for older 

or budget machines. The aforementioned Unity Tweak tool 

has a handy button for restoring your settings to default. You 

can also use the Compiz Configuration Manager to disable 

effects individually. 

If you are still having issues with rich graphics overloading 

your system, consider switching to Lubuntu, a variation of 

Ubuntu which uses the same base code with the resource 

light LXDE (Lightweight X11 Desktop Environment). This uses 

a much simpler desktop and so needs far less system 

resources. See http://lubuntu.net for more information. 

 You have 30 seconds to accept settings to ensure you 

don’t select an incompatible screen setting.

 The Wobbly 

Windows 

effect isn’t 

compatible with 

the Snapping 

Windows effect. 

When effects 

directly clash 

you are given a 

choice to disable 

the old effect 

and enable the 

new or vice versa. 

Multiple Monitors

To use another monitor with your device, first of all 

connect it to you machine and log in to the Ubuntu 

Desktop. Click the search bar and launch the Displays 

app. Click on your secondary monitor and then on the 

rocker switch below to turn it on or off. If you’re 

unable to see your monitor try clicking the Detect 

Displays button. If your device has a built in display an 

alert box will show at the top left of your screen.

Once your secondary monitor has been 

enabled,feel free to drag it around to the position of 

your choice e.g you may wish to have it immediately 

below your current display. You can also choose to 

Mirror Displays if you prefer for them to show the 

same content e.g if you are giving a presentation. This 

may limit your resolution options if the displays have 

different capabilities. The General Options section 

show by default the Launcher on every display. Click 

All Displays to choose a primary monitor if you prefer.

Sticky Edges is an extremely useful feature which 

prevents you accidentally moving the mouse off 

screen onto the other monitor. When your mouse 

reaches the edge of one screen it will need an extra 

push to move to the other. By default this is switched 

on but hit the rocker switch if you want to turn this off.
 Multiple displays is easy!
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The applications tab in Sound Settings is extremely useful 

as it allows you to adjust the volume for individual programs. 

If, say, you are listening to a music CD while browsing the BBC 

website, you may not want to hear the commentary from 

news videos, so you can mute the web browser’s volume.

Input devices
Settings for Input devices like USB microphones or webcams 

with internal microphones can be accessed from the Input 

tab in Sound Settings. In the same way as for the speakers if 

your input device connects via USB it will be listed separately. 

Simply click it with your mouse to have Ubuntu use it for 

sound recording moving forward.

Take some time to look at the Settings for Microphone. 

Increasing the input volume will change how sensitive the 

microphone is. This is helpfully displayed in the Input Level 

bar below. 

At the bottom of the Sound Settings window, you can 

choose to Show Sound Volume in the Menu Bar. If this is 

unticked for any reason click it to be able to access sound 

settings easily in future. 

If you need a way to record short audio clips with minimal 

fuss, install the Sound Recorder application from the Ubuntu 

Software Centre. The interface is very basic but will allow you 

to record and play back short clips.

If you need a more fully featured audio recorder e.g for 

mixing various tracks or trimming your recordings, consider 

downloading Audacity which has many more features. Visit 

www.ubuntuupdates.org/package/core/yakkety/

universe/base/audacity and click on the red button marked 

APT install to begin the installation. Ubuntu’s bundled music 

player is called Rhythmbox. It has all the basic functions of a 

Sound: Tweak 
your audio
Explore Ubuntu’s sound settings as well as how to connect external speakers 
and make everything sound perfectly sweet.

I
n this section we will explore how your sound is managed 

in Ubuntu as well as how to connect external speakers 

and microphones to your machine. We will also discuss 

suitable programs for recording and playing back audio as 

well as how to troubleshoot sound issues.

Your Ubuntu system’s sound is managed by a program 

named Pulseaudio. Technically  Pulseaudio is known as a 

sound server which sits between your various programs and 

sound hardware. It is capable of mixing several sounds 

together or playing to multiple devices at once, provided it is 

properly configured. 

Volume and playback
For most users audio will work out of the box after 

installing Ubuntu however if you wish to connect external 

speakers or adjust settings for individual applications you 

may need to access your Sound Settings.

Volume can be adjusted two ways in Ubuntu. Firstly by 

clicking on the sound icon in the menu bar to move the 

volume switch either to the left or the right. Secondly you can 

open the Sound Settings menu from here to fine tune audio. 

If you do not see the sound icon use the search bar to open 

System Settings, then click Sound. 

Some keyboards also have volume controls. Look for the 

loudspeaker icon. You may need to hold down the 

‘Fn’(Function) key before pressing them to alter the volume.

The sound settings menu also allows you to choose your 

audio output device. Simply click on the device on the left 

hand side of the window. If you use earphones or speakers 

with a 3.5mm jack then the Play Sound Through box will 

simply display headphones.

Depending on the speaker setup you have, you can take 

this opportunity to review the various settings for your 

speakers. The slider switches you’ll find here are fairly self 

explanatory allowing you to adjust the balance, fade and 

subwoofer individually.

 Once the Sound 

Settings menu is 

open, click Test 

Sound to launch 

a window that 

will play sounds 

for each of your 

speakers e.g 

front left and 

front right. 

 As with the Output tab you can choose your device from 

the pane on the left hand side. Adjust the input volume 

using the slider switch on the right. 

If you are playing 

music through the 

Firefox browser, 

you can disable 

sound in individual 

tabs by clicking the 

loudspeaker icon 

besides the small ‘x’. 

Quick
tip
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music player such as organising and playing tracks by album 

name, artist and genre. When you first run Rhythmbox it will 

automatically search your local music folder and display any 

tracks there.

As you will see (screenshot below) from the pane on the 

left hand side, Rhythmbox also supports playing internet 

radio and comes with a number of pre-loaded channels. 

Users can also search and subscribe to Podcasts by clicking 

on the Podcast sections

You can enhance Rhythmbox even further by accessing 

the Plugins via the Tools Menu. This allows you to add other 

channels, play FM radio and play Rhythmbox over the web. 

Sound troubleshooting
If you are unable to hear sound on your machine, it’s 

important to isolate exactly where the issue lies.

If sound plays for some media but not for others, it’s likely 

you have an issue with certain formats of files. As Ubuntu is 

free software it doesn’t include software for playing certain 

media types protected by copyright or patents such as 

Quicktime or Windows Media Video. For a full list of restricted 

formats visit  https://help.ubuntu.com/community/

RestrictedFormats. 

When you initially set up Ubuntu you were given the option 

to download support for these formats. If you didn’t do so at 

the time, you can do so now by opening the Terminal 

application on Ubuntu and running the command:

sudo apt-get install ubuntu-restricted-extras

Press return to enter the command, then Y to confirm you 

want to install. If you are still having trouble playing certain 

files, consider installing vlc from the Ubuntu Software Centre. 

This media player is capable of playing virtually any video or 

audio format. 

If your sound is not working at all, first check your  

sound settings to make sure the correct output device is 

selected and the volume is turned up. If everything seems  

in order, you may need to adjust the sound for your particular 

output device.

Open Terminal on your machine and run the command  

 alsamixer . This will display each of your playback devices 

and allow you to alter the volume for each. Use the left/right 

arrow keys to move between devices and the up/down keys 

to change the volume. Press Escape to exit when you are 

done, Ubuntu will remember the new settings.

In order to fine tune your sound settings even further 

consider installing the PulseAudio Volume Control 

application from the software centre. Not only is it easier on 

the eye but you can control more advanced settings like 

Ports and latency. 

If you are having trouble connecting your bluetooth 

headset or speakers (See Pairing Bluetooth Speakers), try 

pairing them with another computer to make sure the 

discovery mode is enabled. 

If all else fails you can reset your sound settings to default 

by opening the Terminal application and entering the 

following command:

sudo rm -r ~/.config/pulse; pulseaudio -k

For more in depth troubleshooting of sound in Ubuntu  

visit https://help.ubuntu.com/community/

SoundTroubleshootingProcedure. 

 The PulseAudio Volume Control (left) and the alsamixer 

app (right). Both are ideal for checking the playback or 

recording volume for individual devices.

 Use the left pane to change between your own music 

collection, podcasts and internet radio. Portable music 

players such as iPods will also display here.

To see a full list 

of Ubuntu music 

players open 

the Software 

Centre and click 

audio under 

Categories. Next 

choose Players. If 

you’re happy with 

Rhythmbox see 

the Getting Started 

guide at https://

help.ubuntu.com/

community/

Rhythmbox. 

If you’re unsure 

if the sound is 

working for some 

files. Hold Alt + F2 

and type aplay 

/usr/share/

sounds/alsa/

Front_Center.

wav. You should 

hear a voice saying 

Front Centre. 

Quick
tip

Quick
tip

Pairing Bluetooth speakers
Ubuntu can connect and play audio wirelessly to 

most Bluetooth speakers. If you want to proceed, 

in addition to Bluetooth compatible speakers your 

computer must support Bluetooth. Use the 

search bar to search for Bluetooth if you’re 

uncertain if your machine supports this. If it isn’t 

supported you’ll see a message stating No 

Bluetooth adapters found.

Fortunately there are a number of small USB 

adapters online that you can plug in to make your 

device support Bluetooth. For a list of Ubuntu 

compatible Bluetooth USB adapters visit http://

bit.ly/LXF26blue.

The device used for this illustration (see the 

screenshot right) was a Micro 10m USB adapter 

purchased from Argos for £9.99 which worked out 

of the box on a machine running Ubuntu 16.10. 

Once Bluetooth is switched on, consult the 

manufacturer’s instructions to put your speakers 

into Discovery mode so they can be detected by 

your computer. 

Launch the Bluetooth application again from 

the search bar and make sure that both the 

switches at the top of the window are set to on,  

to activate bluetooth and make your computer 

discoverable.

Click the + button at the bottom left of the 

window to search for your bluetooth headset or 

speakers. Click to highlight when it appears in the 

pane and click Next at the bottom left. Ideally a 

message will appear saying that the new device 

has successfully been set up.

Click the volume icon to open your Sound 

Settings. You will see the Bluetooth device is now 

listed as a device in the Output tab. Select it to 

start playing sound over Bluetooth.

 Make sure to select the headset or 

speaker set as your playback device in 

Sound Settings too. 
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searching for ‘exfat’. Install ‘exfat-fuse’ followed by ‘exfat-utils’ 

if you’re running Ubuntu 64-bit, or choose the i386 labelled 

versions if you’re running the 32-bit version. If you don’t know 

which version you’re running, go to System Settings > Details 

and examine the ‘OS type’ entry to find out. Once installed, 

full read/write support to any exFAT drive will be enabled.

USB drives are registered in the same way as hard drives 

– open Disks to confirm the individual label for your drive. 

Select its volume and you’ll see it’s something like /dev/sdb1 

or /dev/sde1 depending on how many other drives are 

present. Unlike permanently attached drives, these identifiers 

aren’t constant. They’re applied on a first-come, first-served 

basis, so if you were to unplug one drive, then plug it back  

in having first attached another drive, its label will change. 

Always verify the label in Disks before performing any tasks 

that require you to identify or address it by its identifier.

Once plugged in, your drive should show up in the  

Nautilus file manager – its actual mount point can be  

found under /media/<username>/<volumelabel>,  

where <volumelabel> is the name you gave it when the 

partition was created. Unlike the drive’s identifier, this does 

stay the same.

When you’ve finished with the drive and want to remove it, 

click the eject button next to the drive name in Nautilus to 

unmount it before unplugging it. If you need to remove a drive 

from the Terminal, use the umount command. By default, the 

umount command is used to remove individual volumes, but 

by including the -a flag you can ensure all volumes for a 

particular drive are unmounted, allowing you to remove the 

drive safely even if it’s been partitioned. Point umount 

towards a specific volume or its mountpoint using the 

following syntax:

umount -a /dev/sde1 

umount -a /media/nick/RPi0

Once done, remove or eject the drive.

Read-only mount
Sometimes you may wish to access a USB drive in read-only 

mode, so data can’t accidentally be written to the drive. By 

default, Ubuntu will mount any supported filesystem in read/

write mode. The trick is to use the umount command with a 

Drives: Access 
flash and 
optical media
Your Linux install is not an island. Here’s how to access both flash 
storage and optical media using Ubuntu’s built-in tools.

L
inux handles drives differently to Windows, so if you’ve 

migrated from a Windows PC, we recommend you first 

familiarise youself with how drives are labelled and 

accessed in Ubuntu. The good news is that – once you’ve 

over the initial shock – the transition isn’t that big. And now 

you’ve understood how things work, you can go on to learn 

more about removable media, including USB flash storage as 

well as CD and DVD.

Working with USB drives
Ubuntu is more than happy to work with USB storage of  

any nature – hard drives and flash drives are treated equally. 

Just plug it in, and the drive will be automatically mounted 

and accessible, so long as it’s formatted using a supported 

file system. Ubuntu ships with built-in support for both  

FAT32 and NTFS file systems as well as its own ext-based  

file system – once mounted, you can read and write to the 

drive like any other.

Larger drives – typically 64GB or bigger – are occasionally 

formatted in the exFAT format. Support for exFAT isn’t 

included in Ubuntu by default, but you can quickly add full 

read/write support by opening the Software Centre and 

 Pop a media or blank disc into your DVD drive and Ubuntu will pop up this 

helpful dialogue box.

Verify what your 

CD or DVD drive is 

capable of doing in 

Ubuntu by opening 

a Terminal window, 

typing wodim 

-prcap and then 

hitting [Enter].

Quick
tip
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special flag (-r) to unmount the selected volume, then 

remount it in read-only mode – for example: 

umount -r /media/nick/RPi0

If you find you can’t unmount a drive using the -a 

command, you can use the -r flag instead on each mounted 

volume from that drive to remount them in read-only mode. 

This means you can then physically remove the drive without 

worrying about data loss.

Optical drives
CD and DVD drives are handled differently to regular hard 

drives. First, they’re assigned different IDs - /dev/sr0,  

/dev/sr1 and so on. You’ll also see they’re marked as read-

only by default, even if the drive itself is a burner.

How you interact with discs depends on the disc itself.  

If the disc is recognised, it’ll be mounted inside the /

media/<username> folder like other removable drives, 

making it accessible through the Terminal as well as via 

Nautilus. If the disc is a straightforward data disc, it  

should open in Nautilus, enabling you to browse and  

access its contents. 

Other types – multimedia and writable discs – are 

handled slightly different. A pop-up window will appear, 

similar to that which appears when you insert a disc in 

Windows. You’ll be asked if you want to open a specific 

application, which varies on the type of disc you’ve inserted, 

plus there are options for opening the drive in Files to  

explore its contents, or do nothing. 

Your app choice depends on what’s installed – Ubuntu 

ships with four apps that can be used from the off: 

Rhythmbox (playing and ripping audio CDs), Videos 

(watching DVD movies), CD/DVD Creator (burning data 

discs) and Brasero (burning all kinds of discs, including  

DVD, SVCD and audio CD).

By default, Ubuntu can’t play certain restricted formats, 

including encrypted DVDs. To play commercial DVDs, install 

the libdvd-pkg software from the Software Centre – once 

done, you’ll find Videos is able to play them, as will other third-

party tools, including VLC Media Player.

Burn discs
Insert a blank disc and you’ll be prompted to open CD/DVD 

Creator. This provides a similar interface to Nautilus – drag 

files onto the window, give your disc a suitable title and click 

‘Write to Disc’ to burn a data disc.

A more sophisticated tool for burning discs comes in the 

shape of Brasero. Launch this when prompted (or open it 

from the Dash) with a blank disc inserted into your drive, then 

select your project: you can create an audio CD, data disc, or 

video DVD/SVCD, plus there are tools for copying one disc to 

another as well as burning discs from support image formats 

(ISO, TOC and CUE). There’s even a built-in cover editor 

(select Tools > Cover Editor) for designing and printing a 

cover for a regular CD jewel case, plus you can erase 

rewritable discs by selecting Tools > Blank…

Brasero is simple to use as the annotation below reveals – 

it’s mostly just a case of dragging and dropping the files you 

wish to add to your disc in the correct order. There are also 

plenty of alternative burning tools out there – to create a 

video DVD with menus and try DVDStyler, for example, or 

check out K3b for a more general-purpose alternative. 

 Rhythmbox can extract audio from your CDs as well as play them back to you.

You can also attach 

MMC/SD cards to 

Linux – if these are 

plugged directly into 

a card slot  

(as opposed 

to using a USB 

adapter), they’ll 

be identified using 

mmcblkx rather 

than sdx. They work 

in the same way as 

other media.

Quick
tip

Exploring Brasero

Project type
Brasero allows you to burn all kinds of discs: audio, video 

and data, plus burn discs from image files and copy from 

one disc to another (two optical drives required).

Access older projects
Choose File > Save to make a copy of your 

project before you’re ready to burn it. You can 

then return to it for further tweaking.

File and folder controls
These buttons allow you to add and remove files to 

your project, plus perform other context-sensitive 

tweaks such as creating new folders for data discs.

File list
Review the current list of files, tracks or videos that 

you plan to burn – media tracks can be clicked and 

dragged to change their running order.

Choose media
Click this dropdown menu to switch between 

available drives or make a disc image. A handy 

guide tells you how much free space is left.

Burn disc
Once you’re ready, click the Burn button. Set your 

speed, plus tweak options like leaving the disc open. 

You can even burn several copies if required.
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by a password or wireless key. You can usually find this in the 

documentation sent by your ISP with your router or written 

on the underside of the router itself. Enter the password and 

click Connect to link your computer to the wireless network. 

If you have a Hidden Wifi network then you will need to 

enter the password and the name of the wireless network and 

the type of security used such as WEP or WPA. You can obtain 

this information from whoever set up your wireless router. 

Wireless USB
Not all wireless cards are compatible with Ubuntu as they use 

proprietary software drivers. If there is no Linux driver for your 

WiFi card you may be able to use the program Ndiswrapper 

to convert the Windows driver to work with it. See https://

help.ubuntu.com/community/WifiDocs/Driver/

Ndiswrapper for more information.

If your WiFi still doesn’t work and you are unable to click 

Enable WiFi in the network menu, you may prefer to buy a 

USB WiFi dongle. The Ubuntu website has a non exhaustive 

list of wireless USB devices which will work with Linux at 

https://help.ubuntu.com/community/WifiDocs/

WirelessCardsSupported. 

If you have more than one working wireless device such as 

an internal wireless card in a laptop and a USB WiFi dongle, 

both devices will be listed separately in the network menu. 

They can also be connected to separate wireless networks. 

This can be useful if you wish to set up a WiFi Hotspot…

Wireless hotspots
If you have another method of connecting to the internet 

besides your WiFi card e.g another WiFi device, Ethernet cable 

or Bluetooth connection, you can set up a WiFi hotspot. This 

enables other devices to connect via wireless to your Ubuntu 

computer and share the internet connection.

Networks: Get 
and stay online
Connect to your local network and the internet via Ubuntu, we explain all the 
settings you’ll need to know to manage your home network.

I
f you have previous experience with connecting your 

computer to a network then it’s unlikely Ubuntu will hold 

any surprises. The easiest and fastest connections will be 

via a wired Ethernet cable. 

If, as is more likely nowadays, you have WiFi in your home 

or office or have a more complicated setup, open the Network 

Manager by clicking the search bar and typing Network. You 

will see all available connections such as Wireless and Wired. 

If you use a cable connection click this to check the manager 

reads connected. 

If your home or workplace uses a proxy server, this is also 

where to specify it. Simply click on Network Proxy on the left 

hand side, then click on None in the drop down menu. Choose 

Manual and enter the network settings given to you by your 

ISP (Internet Service Provider) or Network Administrator. 

Wireless networking
Although it’s possible to connect to wireless networks from 

within the Network Manager, it’s easier simply to click on the 

network icon at the top right of the screen. 

If you have a WiFi network in your home or office, it’s likely 

you will have connected to it already when setting up Ubuntu, 

so before proceeding, check the name of your local wireless 

network and see if there is the option to disconnect. Launch 

the Firefox browser and try to visit a few web addresses to 

make sure your connection is working.

If you are not already connected, try to find your network 

name in the drop down list. Hover your mouse over more 

networks if you do not see yours listed there. If you find the 

menu too difficult to navigate consider using the Network  

Manager. Click Wireless on the left hand side to see all 

available networks. Your network will most likely be protected 

 The Network Manager on a PC with two wireless cards and Ethernet port. 

 If you have more than one wireless adapter (see below) 

the dropdown menu lets you choose which to use.

For more 

information on your 

current connection, 

click the network 

icon at the top right 

of the screen and 

choose Connection 

Information. Your 

ISP may need this 

information if you’re 

having connection 

difficulties. 

Quick
tip
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Open the Network Manager by clicking the search bar and 

typing Network, then press return. Click the Wireless tab on 

the left hand side (if you have more than one wireless device 

select the one you’re not currently using), then the button 

marked Use as Hotspot. You will see a warning message 

asking you to confirm that you wish to create the hotspot. 

The WiFi hotspot uses WEP for security which is 

considered very insecure these days so make sure there is no 

sensitive data on your machine before agreeing to use it as a 

WiFi hotspot. 

Editing Connections
Ubuntu supports a number of other connections to networks 

such as Bluetooth, DSL and VPN. If you do not know what 

these are, it’s unlikely you’ll use them. Otherwise if you wish to 

add a new connection, click the network icon at the top right 

and choose Edit Connections. Click the Add button on the 

right hand side to choose various types of connections.

If you wish to connect to a VPN, bear in mind there are 

several types. By default Ubuntu supports PPTP (Point to 

Point Tunneling Protocol) which is commonly used by 

Microsoft systems. Your VPN provider however may use the 

OpenVPN standard which is generally considered to be more 

secure and reliable. To enable support for this open Terminal 

from the search bar and run the command:

sudo apt-get install network-manager-openvpn-gnome

Press Y to confirm you wish to proceed. The next time you 

open the Network Manager you will see the OpenVPN option. 

Regardless of which connection type you choose the 

wizard will guide you to enter the fields with the data given by 

your network provider. Click Save when you are done to add 

the connection. 

Connection issues
If your wireless connection is not working at all, there are 

simple steps you can take to arrive at the heart of the 

problem. If your computer previously worked with the same 

wireless network, then firstly check that it is not connected 

via an Ethernet cable. Also check the Network menu to 

ensure both Enable Networking and Enable WiFi are checked. 

You can also use the Network Manager to check you are 

connecting to the correct wireless network. Simply click on 

the Wireless option on the left hand side and make sure there 

is a tick next to your own WiFi network. This is important as 

Ubuntu may be connected to an unsecured WiFi hotspot. 

If you use a USB device to connect wirelessly, try reseating 

it. If the wireless is built into your device e.g for a laptop make 

sure that the wireless isn’t disabled as many portable 

computers have a key combination to do this. 

If you are accessing folders on other devices over your 

network via Samba (See Sharing via Samba), you can 

experience username and password request, alongside read/

write issues on certain folders or files. These options need to 

be changed on the networked systems.

On Windows 10 this is done via the Advanced sharing 

settings. On Apple Macs follow the steps on the Apple 

Support page at https://support.apple.com/en-ie/

HT204445 and change permissions for Everyone to Read 

and Write to make sure the folder can be accessed without a 

password. Note that as Apple has its own protocol for file 

sharing it’s very important to enable support for SMB when 

following the steps on the site. 

 You’ll need to give both the network name and security 

key to users who need to connect.

 Click Add in 

the Network 

Connections 

menu to choose 

a connection. 

VPNs using PPTP 

are supported 

by default, other 

connection types 

can be installed 

manually.

Remember that The 

Official Raspberry 

Pi WiFi Adapter, 

available for £6 

from the Pi Hut 

website will work 

out of the box 

in Ubuntu as it’s 

designed for Linux. 

Find more in-depth 

help with wireless 

troubleshooting 

at http://bit.ly/

LXF26network 

and https://help.

ubuntu.com/

community

Quick
tip

Quick
tip

Sharing Folders across your network
If you need to access folders on other 

machines in your home or workplace from 

Ubuntu, Samba or SMB (System Message 

Block) is a protocol that allows you to do this.

To get started, connect to your local 

network on the target device and enable 

sharing of the folder(s) via SMB. Windows 10 

Users can find help with this in the Syncing 

and Saving section of Microsoft Support 

(https://support.microsoft.com/en-us/

products/windows?os=windows-10). Mac 

OS users can find help on the Apple Support 

page at https://support.apple.com/en-ie/

HT204445. 

On the Ubuntu machine select the Files 

app then Other locations to see the remote 

folder. If it doesn’t appear right away, try 

holding Alt + F2 and inputting the ‘smb’ 

address you were given by your Windows PC 

or Mac e.g smb://192.168.42.1 and press 

return. You’ll see the folder icon has a picture 

of a network cable to allow you to easily tell the 

difference between this and a local folder on 

your machine. 

Once you have been able to access the 

folder consider right clicking and using the 

Add Bookmark to make it easy to access it 

next time. Any changes you make inside this 

folder will be reflected immediately on the 

target device. Similarly any files you move into 

here will exist on the other device only, not 

your Ubuntu machine. 

If you need a way to make sure files are 

kept the same across all devices at all times, 

consider using a cloud sharing service like 

Dropbox to automate the process. 

 You may be asked for a username & 

password when connecting via Samba. 

Ubuntu can remember these details, or you 

can tell the remote machine to allow anyone 

to access your sharing folders.



86  |  Linux Format Presents: Ubuntu

System settings

Closed source – or proprietary – drivers rely on the 

manufacturer for updates to be delivered. The manufacturer 

may provide this functionality within the drivers themselves, 

or you may have to manually check the website to see if new 

drivers have been released.

What’s available
The major three graphics card manufacturers – Intel, NVIDIA 

and AMD/ATI – all provide their own Ubuntu drivers. If you 

plan to upgrade to the closed-source graphics drive, the first 

thing to do is to identify your exact make and model of 

graphics card – particularly if you have no idea who the 

manufacturer is. If you head over to System Settings and 

select Details, you’ll see a graphics section, but it won’t tell 

you much. Instead, open a Terminal window and type:

lspci | grep vga

This will quickly list both manufacturer and model, which 

you’ll need in order to determine if a proprietary driver is 

available for your card.

NVIDIA and AMD
If you have an NVIDIA or AMD graphics card, then the 

quickest way to see if a proprietary driver is available is by 

opening System Settings, selecting ‘Software & Updates’ and 

switching to the ‘Additional Drivers’ tab. If your card is 

compatible, you should see – after a short delay – a list of 

alternative drivers appear. Choose the latest version marked 

‘proprietary, tested’ from the list and click ‘Apply Changes’. 

When the process completes, reboot your PC.

Don’t be surprised if your card isn’t detected – if the  

card is more than five or six years old, then it’s unlikely to be 

supported. AMD’s support goes back to 2010 and the HD 

5000 series, while NVIDIA cards date back to around the 

same time with GeForce 400 series. At first glance, you’ll see 

that NVIDIA does still provide links to legacy drivers for older 

cards – see www.nvidia.com/object/unix.html – but these 

won’t work with Ubuntu 15.10.

If your card is an older model, therefore, you’re stuck with 

the open-source drivers – Nouveau for NVIDIA cards, and 

Radeon for AMD cards. Don’t be too downhearted, both 

Hardware: 
Graphics  
card drivers
Let’s take a long, hard look at the advantages and disadvantages of switching 
graphics card drivers and what that actually entails.

O
ne of the most confusing aspects of switching from 

Windows to Linux is understanding how drivers – 

and in particular graphics card drivers – work. When 

you install Ubuntu on your PC, you’ll notice it appears to 

install the drivers you need for graphics to work perfectly, and 

indeed this is the case in the vast majority of cases. These 

drivers are open source, designed to provide the key 

functionality for any graphics card to work with Ubuntu.

Because they’re designed to just work, many of these 

drivers aren’t interested in providing you with cutting edge 

performance. For day to day use – browsing the internet, 

word processing and even editing images – they’re perfectly 

adequate, but if you have a modern graphics card, and want 

to take full advantage of its capabilities – particularly for gaming 

– you’ll need to investigate the possibility of replacing them 

with dedicated drivers provided by the manufacturers.

This second set of drivers – with the exception of drivers 

for Intel graphics – are closed source, which means that while 

they’re still free to install, you’re relying on the manufacturer 

for support. The open-source drivers that ship with Ubuntu 

are updated through Ubuntu’s own update tool, so they’ll 

update organically with the rest of your system.

 Intel’s graphics drivers are open source, unlike those provided by 

NVIDIA and AMD, so need to be installed manually.

To find out more 

about your graphics 

chipset – including 

its capabilities – 

install mesa-utils 

from the Software 

Centre. Once done, 

simply open a 

Terminal window 

and type the 

following: glxinfo | 

grep render.

Quick
tip
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provide more than basic functionality, with pretty decent 2D 

and 3D acceleration. They also support most older chipsets 

stretching back more than a decade. There’s no need to 

install them either – if your card is correctly detected, the 

driver should already be in place. Visit https://nouveau.

freedesktop.org/wiki/ and https://help.ubuntu.com/

community/RadeonDriver respectively for full details.

If you’re lucky enough to be able to use the proprietary 

driver, then not only do you gain performance enhancements 

for gaming and other high-end purposes, you’ll also be able  

to tweak your card using either the Catalyst Control Centre 

(AMD) or NVIDIA X Server utility – see the annotated 

screenshot for details of using the latter.

Intel chipsets
If your PC has an Intel processor and utilises its onboard 

graphics chip, you may be able to install the open-source Intel 

driver, which is found at https://01.org/linuxgraphics. At 

time of writing, the latest available driver is 1.4.0, which is 

designed for Ubuntu 15.10 and supports the following Intel 

graphics chips: 2nd-6th generation Intel Core processors, Bay 

Trail, Braswell and Hoxton Intel Celeron processors and the 

Intel Atom N450 (Pine Trail) chipset.

If your processor fits the bill, click the link under ‘Latest 

download’, then choose the 32-bit or 64-bit version depending 

on your Ubuntu build – if you don’t know this, open up 

System Settings and click Details, then check the ‘OS type’. 

Click the link to save the .deb file to your hard drive (or opt to 

open it in Software Centre if prompted). If necessary, double-

click the file and click Install, then follow the prompts to install 

the utility. Once done, open the Dash and type ‘Intel’ to locate 

the graphics installer. Again, follow the prompts and if your 

chipset is correctly identified, click Install to add the driver.

Reboot when prompted, and you’re done. There’s no 

separate graphical configuration utility – instead, use Screen 

Display under System Settings to tweak your card’s settings. 

Troubleshooting
Sadly, not all driver updates are successful, and you can find 

yourself locked out of the Ubuntu desktop if one goes awry. If 

this happens with NVIDIA drivers, press [Ctrl] + [Alt] + [F1] to 

drop to the shell. Log in using your username and password, 

then enter the following command:

sudo ubuntu-drivers devices

This identifies which graphics drivers are installed. 

Assuming it reveals NVIDIA drivers, enter the following 

command next:

sudo apt-get autoremove –purge nvidia-*

Follow the prompts to purge the drivers from your system. 

Now add the following command:

supt apt-get install xserver-xorg-video-nouveau

Once done (don’t worry if it tells you it’s already present), 

type sudo reboot and you should hopefully regain access to 

your desktop. 

AMD users should try the following lines instead:

sudo apt-get autoremove –purge fglrx-*

supt apt-get install xserver-xorg-video-ati

While they’re the most likely solutions, we’re sorry to say 

that these may not work – if this is the case, you’ll need to 

Google your problem to try some of the other suggestions  

on offer. 

 Switching to proprietary graphics drivers is actually quite simple – 

assuming your card is supported, of course.  

To avoid any worry 

when considering 

installing new 

drivers, take a drive 

image following the 

before you install 

the drivers, allowing 

you to roll back 

should the  

worst happen.

Quick
tip

Exploring the NVIDIA X Server interface

OpenGL settings
Access the ‘Image Settings’ slider from here, 

where you can try and strike a different balance 

between image quality and performance.

Display Configuration
Select this to tweak the resolution settings  

for each monitor attached to your PC – click  

a screen to select that monitor.

Antialiasing settings
This section allows you to configure the card’s 

ability to smooth jagged edges and textures 

when rendering 3D objects using OpenGL.

Thermal Settings
This provides a temperature gauge for your 

graphics card – keep it open while you stress-test 

the card if you’re worried about heat problems.

Application Profiles
Advanced users can fine-tune the various settings 

on offer for specific applications – typically games. 

Use the Help button to guide you.

PowerMizer
Some cards support different performance states 

– use this tab to view current settings and see if 

you can push the envelope if required.
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spend weeks developing an attack vector that can only be 

used on less than 2% of relatively secured PCs, verse over 

90% of systems in all manner of precarious conditions.

The end result is that the total number of known Linux 

threats is around 59, none of which have caused a single 

outbreak in the wild. Contrast that with over 122 million (as 

reported in the Kaspersky Security Bulletin 2015) threats for 

Windows systems. Don’t get blasé yet, Linux systems can be 

attacked in other ways, but first a little more on why Linux has 

dodged the malware bullet.

Built safer
On the whole Linux has been engineered in a way that makes 

it hard for malware to infect a system, to run and then to 

propagate themselves or cause further damage. Part of this is 

the Super User aka sudo and root mode that requires 

additional permissions to cause any damage. Standard users 

and by extension any malware can’t alter the system without 

extra permissions. Windows introduced a similar system in 

Windows Vista and later versions.

The other major protection for Ubuntu and Linux is the 

use of centralised repositories. Many Windows system 

become infected by users downloading infected software 

from dodgy websites and other sources, with Ubuntu and 

most Linux distros almost all software comes from a centrally 

managed and protected software repository. 

Then there’s sensible and open update policies. Linux has 

always quickly rolled out security updates as and when 

required, this has always been done in the open, so anyone 

can see and understand what the updates are doing. Due to 

the open source nature of Linux distros when a system is 

Malware: Linux 
virus protection
You wouldn’t dare fire up Windows without a small arms pile of anti-virus 
protection, but does Linux need the same protections?

I
f you’re moving to Linux from Windows then there’s one 

thing you might be looking for and failing to find: anti-virus 

software or these days anti-malware. When it comes to 

Windows you can hardly move for people offering anti-

malware packages, most new systems come installed with 

trials, while malware is so common even Microsoft includes 

its own Windows Defender software to try and combat the 

issue. So what about with Ubuntu and Linux?

You may have heard or if you do a quick search, might 

come across the line that Linux doesn’t need anti-virus 

software. The truth is any computer system can be vulnerable 

to a virus, malware or other security threats. It so happens 

with Linux that for various reasons we’ll cover in a bit, the 

ability for viruses to infect, run and spread are vastly reduced 

on Linux systems.

The biggest reason is Linux isn’t widely used by 

consumers, virus and malware writers are motivated by 

money – a very small number by fame – so this means they 

target the most widely used systems and those are Windows 

PCs running on around 90% of the world’s PCs. You wouldn’t 

Password protection
The biggest threat the average user is in danger 

of are hack attacks on their online accounts’ 

passwords. Many people being human reuse 

passwords alongside using weak passwords. This 

means if one account is hacked, the attacker can 

hack a large number of your other accounts using 

the same password and username details. The 

best way to protect against this is to use a 

password management system. In the past 

people used offline password managers, which 

are fine, but they don’t help in the modern mobile 

world. The new generation of password managers 

live online as browser plugins and mobile apps. 

This enables you to take all your complex 

passwords with you and have the password 

manager log you into your various online services 

and sites when you authorise it. 

We’re going to recommend two systems the 

first is https://keepersecurity.com this 

combines a desktop program, browser plug in 

and mobile app for completeness. It also 

supports all the platforms you could want 

including Linux, OSX, Windows, Android and iOS. 

The second is https://lastpass.com this is a 

browser and mobile app based system. It can tap 

into Google Authenticator for extra two-factor 

authentication to make it super secure. Both 

make excellent choices and will keep you far more 

secure online.

 Beef up your password security with a 

suitable password manager.

 Linux does have 

virus scanners, 

available but you 

really don’t need 

to use them. 
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updated, it can be all updated. Under Windows separate 

software packages have to take care of updating themselves, 

but this extends to standalone software, codecs, drivers, 

shared libraries, add-ons etc.

With Linux when the system is updated it’s all updated. 

This is also done in a user friendly way, so updates can be 

done when the user wants. A new Live Patch system can even 

reduce the need to reboot too after a system update. 

Scanners
Having said all that there’s still the potential risk of a viable 

attack and frankly there are far easier ways to be hurt 

financially through phishing and other online social 

engineering attacks. So all the usual advice applies as much 

to Linux as any other system: keep your system up to date, 

don’t download software from untrusted sources, also don’t 

run terminal commands from random sources, be wary 

online and use an up to date browser.

There are also arguments for running anti-virus software 

on a Linux system as it will still get to interact with Windows 

systems and the scanner could potentially intercept viruses 

passing through your system or you inadvertently 

downloading one and passing it on. There’s other genuine 

reasons such as a business requirement, scanning a Windows 

drive or network drive or to protect a virtual PC.

The most popular on Linux is the free for personal use 

ClamAV Antivirus. You’ll need to use the Terminal to install 

this but it’s easy enough, press Ctrl Alt T to open a Terminal. 

To install the base engine use:

sudo apt-get install clamav

To install the automated scanner type:

sudo apt-get install clamav-daemon

It should automatically update, but you can force one with 

this, though it’ll likely fail as ClamAV locks the log:

sudo freshclam

You can install a GUI front end through the Software 

Centre or else type:

sudo apt-get install clamtk

To scan a file you can just use the GUI or from the terminal 

to scan all the files and folders in your /home folder type:

clamscan -r /home 

This recursively scans all the files in your default /home 

folder (the default store) you can add a -i option to only 

display infected files. So to scan all the files on a system use:

sudo clamscan -ri /

A full scan as with any system will take a while, you’ll also 

likely get some errors, but don’t panic those are just read 

issues not viruses!

So the main thing to take home is that a desktop Linux PC 

is largely safe from old-school direct threats like viruses as 

there simply aren’t any. However, you as an individual are still 

vulnerable to having your online accounts hacked and falling 

for social engineering scams. On a wider scale Linux when 

used within online servers and Internet of Thing devices is 

also vulnerable to hacking attacks, but that’s another story. 

What’s a malware?

Malware – a happy non-offensive term for any 

“bad” software. Malware includes any software 

that harms a system, the user, data, or processes. 

Many of the malware categories overlap like 

trojans and spyware.

 Trojan – A malware type that hide in apps to get 

into a user’s system or they act as a program 

themselves. This malware does not replicate. So a 

hacker could make a password manager that will 

supposedly store users’ passwords and enter 

them in for the user. Instead, the username, site, 

and password combinations are sent to the trojan 

maker instead of storing the data – this would be 

a spyware trojan. 

 Spyware – This malware gathers a user’s 

private data (financial info, passwords, 

usernames, etc.) and sends it to the spyware 

maker or other entity that will use the 

information.

 Adware – Software that displays ads is 

considered adware. Not all adware is bad. 

 Worms – A replicating program that spreads to 

other computers. Most rely on networks for 

transportation. A virus attaches to programs and 

worms are standalone software. Viruses come on 

programs that users download and worms break 

in through the network. 

 Viruses – Computer viruses are replicating 

code that spread by hiding inside of infected 

applications and installers.

 Zombies – A computer that is controlled by a 

malicious hacker, trojan, or computer virus to 

complete malicious tasks.

 Scareware – Malware that scares users into 

downloading malicious software or paying money 

for the fix. It could pop up a message saying: 

“Your data will be deleted unless you pay $100” or 

“Your computer is infected”, you’re then 

encouraged to pay money for a fantasy fix.

 Ransomware – A more recent attack that locks 

the computer and files and will not lift the 

restrictions until the user pays a ransom.

 The basic interface for the ClamAV scanning system.

 Ensure you keep your systems up to date to avoid any new exploits.
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case carefully and disconnect your internal drives too. If the 

computer now boots to the splash screen, you can try 

reconnecting the internal drives and trying again; if you’re 

now able to boot to the login screen, shut down your PC and 

start reconnecting your external peripherals to see if the 

problem has cleared itself or can be targeted to a single 

device, in which case try a different cable, or go online and 

Google for known boot problems involving that device.

If you’re lucky, your motherboard will emit a series of 

beeps or flashing lights you can use – again by enlisting the 

help of the internet – to identify the likely problem. This may 

involve replacing a component or something more drastic.

If you’re able to get as far as your PC’s splash screen, but 

then your computer hangs or a ‘missing operating system’ 

error message appears, then first think back to any recent 

changes. If you’ve overclocked your PC, eg, you should now 

enter the system EFI or BIOS and look for the option to load 

fail-safe defaults. Try rebooting again.

If this fails, then the problem is likely to be with your hard 

drive, and so the first places to look are the MBR and Grub. 

If Grub isn’t set to automatically appear when your PC starts, 

try rebooting while holding the Shift key or tapping Esc to 

bring up the Grub boot menu to confirm it’s not able to even 

load itself. Jump to the Boot-Repair tool section once you’ve 

verified it’s nowhere to be found.

If Grub is able to load, but can’t find any bootable OS you’ll 

find yourself with a number of scenarios: you may be 

presented with a basic command prompt such as grub> or 

grub rescue>, which indicates one or more files required by 

Grub are missing or corrupt. You may get a specific error 

Startup: Fixing 
boot issues
It’s all gone wrong. Of course it has. Here’s how to resolve issues with non-
booting PCs without having to reach for the panic button (or a hammer).

S
tart-up problems. That moment when – having 

expected yourself to be getting on with your day’s 

work or entertainment – you find yourself staring at a 

cryptic error message, or even worse, a blank screen. No 

matter how many times you press reset or restart, the same 

impenetrable barrier blocks your path. So, what can you do?

Start-up problems come in all shapes and sizes, and they 

can be difficult to track down. There are, however, some 

sound principles to use that will resolve many errors, and in 

this tutorial, we’re going to look at the tools and techniques 

required to troubleshoot most start-up problems. You should 

start by examining how the boot process works (see The Boot 

process box, right). This reveals that the boot process can be 

split into three broad stages centred around the Grub 2 boot 

loader: pre-Grub, Grub and post-Grub. Knowing this allows 

you to focus your troubleshooting efforts based on where in 

the process the error or freeze occurs.

Let’s start at the beginning. You switch on your PC. 

If power comes on, but nothing else happens, chances are 

you’ve a hardware issue to sort – if you recently poked 

around the innards of your PC, then check everything is 

connected correctly. If not, unplug all external devices except 

your keyboard and try again. If this doesn’t work, open the 

 If you’re struggling to get the Boot-Repair tool disc to 

boot, experiment with the various fail-safe boot options.
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message or frozen splash screen, or you may just see Grub 

and nothing else, indicating it can’t even find the most basic 

information required to proceed.

If you press c you may be able to enter the Grub Terminal 

mode to perform basic checks and repairs – you can attempt 

to manually initiate the boot by pressing Ctrl+X or F10, eg, or 

use the  set  command to review current settings and change 

basic settings such as the graphics mode. Visit http://bit.ly/

Grub2Troubleshooting for a detailed guide to using Grub’s 

own troubleshooting tools, but remember that in most cases 

the simplest fix is to use the Boot-Repair tool.

If the Grub menu appears, then the issue may lie with its 

configuration file if things immediately grind to a halt after 

you select a menu option, but if Linux does start loading 

before grinding to a halt, the problem will lie with your 

operating system, in which case skip to the Post-Grub 

troubleshooting section (see the next page).

Boot-Repair tool
If you’re struggling to fix Grub issues by hand, or there’s no 

sign of Grub on your system at all, then you’ll need to enlist 

the services of your rescue media and the Boot-Repair tool, 

which works with all Debian-based distros, including Ubuntu.

The Boot-Repair tool itself will launch automatically when 

you boot from a Boot-Repair tool disc, but if you’re unable to 

create it, but have access to a Linux installation disc, use that 

in a live environment instead, then grab the Boot-Repair tool 

using the following commands:

$ sudo add-apt-repository ppa:yannubuntu/boot-repair

$ sudo apt-get update

$ sudo apt-get install boot-repair

$ boot-repair

The Boot-Repair tool is focussed on those early boot 

problems caused by the hard drive’s boot sector, MBR and 

Grub. It basically provides a convenient and user-friendly 

graphical front-end to the tools required to fix many 

problems. The tool offers a ‘Recommended repair’ option that 

promises to fix most frequent problems, or you can click 

‘Advanced options’ to see what it can do and manually select 

specific fixes without getting your hands dirty in the Terminal. 

The step-by-step guide (see Tweak Boot-Repair tool Settings, 

over the page) reveals what repairs and tweaks are possible, 

but note the tool is context-sensitive, and some options may 

be greyed out or missing depending on your setup.

The tool automatically generates a log of your system and 

what it attempts to do, which you can then share on the 

Ubuntu user forums if necessary. Before attempting any 

advanced tweaks on your own, it pays to try the 

recommended option first, then ask for help on the forums 

using the output logs generated – this will ensure you choose 

the right option and don’t cause more damage.

Non-Grub boot issues
Your rescue disc will also come in handy should you not even 

get as far as Grub loading. Once booted, verify the existence 

and state of your hard drive. Open the file manager and see if 

your partitions are visible and if you can access the files on 

them – this is a good time to back up any precious files 

before you proceed further.

If nothing shows up, check whether the hard drive has 

been detected by opening the Disks utility from your Ubuntu 

Live CD – if you’re using a Boot-Repair tool CD, you’ll need to 

install the gnome-disk-utility through the Synaptic Package 

Manager under System Tools. Once installed, open it via the 

Accessibility menu. The Disks tool lists all physically attached 

drives – if yours isn’t visible, you may find the drive has failed, 

in which case you’ll be reaching for your latest backup after 

 Give your hard drive the once-over when booting from 

your rescue disc to check it’s working as it should.

When you boot with 

your rescue media 

inserted your PC 

may automatically 

detect and boot 

from it; if it doesn’t, 

look for an option 

to bring up a boot 

menu when your 

PC starts (typically 

a key like F11) to 

select it manually. 

Failing that, enter 

the EFI or BIOS 

configuration to 

set it as the first 

boot device.

Quick
tip

The Boot process

When you press your system’s power 

button, control is initially given to your 

PC’s EFI or BIOS, which starts its various 

components, performs basic diagnostics 

tests and attempts to find a bootable 

device, which is typically the first hard 

drive. Once located, the BIOS or EFI looks 

for the Master Boot Record (MBR) at the 

very beginning of the drive, which has a 

tiny program inside that loads the next 

stage of the boot loader, reading a file (eg 

e2fs_stage_1_5), which in turn is able to 

load the Grub boot loader. A ‘missing 

operating system’ error at this point 

means you need your rescue disc for 

diagnostics as something is missing – 

either in Grub, the MBR or the drive itself.

Once Grub loads successfully it reads a 

file called menu.lst, which contains the 

list of choices you see in the boot menu. 

Each entry basically identifies the drive, 

partition and file that contains the Linux 

kernel, plus RAM disk file used by the 

kernel as it boots. The entry will also 

contain any additional parameters 

passed to the kernel.

Control is now passed to the kernel, 

which attempts to mount the root file 

system. This is a key moment, and if it 

fails you may get a kernel panic, or things 

might grind to a halt. If successful, it’ll 

create a single process to run the /sbin/

upstart file (other distros use init) – if this 

goes wrong, you’ll get a panic, it may halt 

again or drop you into a root shell. At this 

point, upstart starts running scripts and 

upstart events to start other services and 

eventually bring you to the logon screen.

 The Grub menu’s appearance is a critical point in 

the boot process – if your system gets this far your 

recovery options are greater.

http://bit.ly/Grub2Troubleshooting
http://bit.ly/Grub2Troubleshooting
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System logs are a 

valuable source of 

troubleshooting 

information – and 

you can access 

these from the  

/var/log directory 

using your rescue 

disc’s file manager 

or nano in a 

shell. Look out in 

particular for syslog, 

and investigate 

the dmesg shell 

command too.

Quick
tip

shelling out for a drive replacement, or starting again from 

scratch with a fresh Ubuntu installation and new-found love of 

backing up your system. Assuming your drive does show up, 

select it from the left-hand menu where you can examine the 

partition table plus check its physical health via its SMART 

[Not all that smart – Ed] attributes. Don’t panic unless the 

drive is deemed on its last legs, but do focus your next check 

on the partitions themselves. If you run the Boot-Repair tool, 

its recommended settings will include a full disk check, but 

you can manually perform this check yourself using GParted, 

which is on both rescue discs.

GParted enables you to see how your partitions are 

arranged, as well as revealing which one is the boot. Right-

click this and verify Mount is greyed out before choosing 

‘Check to schedule a disk check using the fsck tool’. This will 

check for and attempt to repair any problems it finds as  

soon as you click ‘Apply’, but it’s important the partition isn’t 

mounted before the check is run. Also give it as long as it 

needs to complete – this could take hours or even days in 

some extreme cases, and cancelling or aborting will almost 

certainly corrupt the partition. Make sure the check is run on 

all partitions on the boot drive.

In most cases, assuming the drive isn’t physically 

damaged or corrupt beyond repair, running these tests 

should ensure you’re able to at least get Grub working again.

Post-Grub troubleshooting
If you find that Grub appears to be working fine, but your 

problems begin when you attempt to load Linux itself. 

Try switching to verbose mode during boot by pressing the 

Esc key to see if any clues appear in the messages that scroll 

past (or if it hangs at a certain point). Make a note of these 

and do a search online for them for more advice. If this 

doesn’t happen, hold Shift at boot to bring up the Grub menu 

if necessary, then select ‘Advanced options’ followed by 

‘(recovery mode)’, which will launch Ubuntu in a minimal 

state, plus mount the file system in read-only mode. If this is 

successful, after a succession of scrolling messages you 

should find yourself presented with the Recovery Menu, 

offering nine options.

The options are all pretty much self-explanatory – the 

clean option may be of use if your hard drive is full, which can 

cause boot problems. If your problems started because a 

package failed to install properly, then dpkg will repair it and 

hopefully get things working again. The failsafeX option is a 

useful if you find yourself booting to a black screen or the 

graphical desktop doesn’t appear to be working correctly – it 

basically bypasses problems with your graphics drivers or X 

server to give you a failsafe graphics mode to troubleshoot 

your problem from.

We’ve touched on fsck already – this will check the drive 

for corrupt files, which can clear many errors, particularly if 

your PC crashed and has failed to boot since. The grub option 

isn’t relevant unless you’ve used Grub’s own recovery tools in 

place of the Boot-Repair tool to get this far in the boot 

process – selecting this will make your changes permanent.

Use the network option to re-enable networking, and the 

root option to drop to the shell prompt, allowing you to 

troubleshoot directly from there. If doing so, be sure to mount 

the file system in read/write mode using the following 

command:  mount -o remount,rw / 

You can also pass temporary kernel parameters to Ubuntu 

during the boot process, which may help in some scenarios. 

With your chosen operating system selected in Grub, press 

the e key to edit the kernel file. Scroll down to the line 

beginning  linux  – parameters are added to the end of this 

line after  quiet splash . You’ll need to make sure that you 

leave a space between each parameter. Once done, press 

Ctrl+x to boot with those parameters.

Note that any parameters you add here are temporary – 

in other words, they’re removed the next time you boot, so 

you can experiment until you find a solution that works, then 

– if necessary – make it permanent by editing the Grub 

configuration file (sudo nano /etc/default/grub).

You can also pass parameters from the live CD 

environment using the Boot-Repair tool using the ‘Add a 

kernel option’, which includes 15 common parameters that 

Take a fail-safe backup

It may seem strange, but if you’re struggling with 

start-up issues, you should attempt to take a 

backup of your hard drive before you perform 

any repairs – this means if you mess things up 

completely you can always roll back your system 

to the state it was in when the start-up problem 

first manifested itself.

Of course, if you’re diligent and you back up 

your system regularly, you could always simply 

roll things back now to a working state, although 

bear in mind there may be data loss involved if 

your home folder is on the same partition as 

your Linux installation (as is the case with 

default Ubuntu installs).

You’ll need a suitable backup device – 

typically a USB-connected hard drive – and a 

tool that takes a complete drive image of your 

system. The dd command-line tool can be used 

from both Ubuntu and Boot Repair Tool live CD 

environments, but the backup drive needs to be 

at least the same size – and preferably – bigger 

than the drive you’re copying.

At the other end of the complexity scale is 

Redo Backup & Recovery. You’ll need a blank CD 

or DVD to burn its 261MB ISO file to, but it 

provides an easy to follow graphical UI. You’ll find 

it at www.redobackup.org – or use the built in 

option covered earlier.

Redo Backup & Recovery offers by far the 

simplest way to make a fail-safe backup of 

your whole hard drive.

 Ubuntu’s recovery mode lets you try various fixes when 

Grub works, but Ubuntu no longer wants to.

http://www.redobackup.org
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can help with troubleshooting. Examples of these include 

acpi=off, which disables the ACPI system that’s known to 

cause random reboots or system freezes on certain PCs, and 

nomodeset, which instructs Ubuntu to only load graphics 

drivers after the X environment has been loaded, and not 

before. These temporary parameters can be passed to your 

rescue disc too, in case you’re having problems getting that 

working. Press [F6] at the initial boot screen to choose from 

the options on show. For more information on specific 

parameters, do an online search for the parameter or visit 

http://bit.ly/KernelParametersList for a complete list.

Repair install
There’s one last thing you can try from the Grub boot menu – 

if your kernel has been upgraded, it’s possible to boot using an 

older version of the kernel from the Advanced options screen 

under Grub. You’ll see each version of the kernel listed – try 

the previous version if you believe your boot problem is linked 

to the latest kernel. If this works, you can make the version 

you’ve used permanent by editing the Grub configuration file 

– the simplest way to do this is by using the Boot-Repair tool.

If things look particularly bleak, then you may have luck 

reinstalling Ubuntu over the top of itself. Boot from the 

Ubuntu Live CD and choose the option to ‘Install Ubuntu’ 

when prompted. When you get to the ‘Installation type’ screen 

you’ll be presented with a new option, pre-selected by default: 

‘Reinstall Ubuntu…’

This option basically reinstalls Ubuntu without touching 

your home folder or partition, which means not only should 

your documents and other files be preserved, but key settings 

and many programs may be left alone too. It’ll also leave 

entries in your boot menu alone, ensuring you won’t lose 

access to other operating systems.

What will be replaced are system-wide files, which will 

hopefully root out any corrupt ones and get your PC up and 

running again. Although it doesn’t affect your files, it’s still 

good practice to back up the drive – or at least your home 

folder or partition – before you begin.

To ensure you don’t lose anything from your system, 

make sure you recreate all user accounts with the same login 

and password, including – of course – your own during the 

install process. 

1  Main options
The first tab offers a convenient button for backing up your current 

partition table, boot sector and log – click this to copy this key 

information. It’s also where you can reinstall Grub, restore the MBR and 

choose whether to hide the Grub menu. If you think your filesystem is 

corrupt, tick ‘Repair file systems’ to have it checked and fixed.

2  Grub location
This tab allows you to specify which OS to boot by default in a multi-

boot setup. You can also choose to place Grub in its own separate  

/boot partition if you wish – typically this is only needed on encrypted 

disks, drives with LVM set up or some older PCs. The final option 

specifies which drive Grub itself will be placed (sda by default).

3  Grub options
This section opens with options for making sure Grub is updated to its 

latest version. There’s also three specific error fixes offered. You can 

also add new kernel options to the Grub menu here, or purge all 

previous kernels before reinstalling the last one. You may even see an 

option allowing you to edit the Grub configuration file directly.

4  Other tweaks
If the MBR options tab isn’t greyed out, use it to restore your MBR 

from a backup and choose which partition gets booted from it. The 

final Other options tab offers an opportunity for repairing Windows 

files (irrelevant in most cases) and provides options for pasting a 

summary of your settings online for reference.

Tweak Boot-Repair tool settings

http://bit.ly/KernelParametersList
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case. It’s not that people don’t want to help, but if the 

question has already been answered, if you’ve not look to see 

if a bug has already been reported, or you’re after details that 

are explained in the standard documentation then people are 

going to point this out first rather than help.

Using Ubuntu
Our first calling point is getting help with just using Ubuntu 

itself, you’re going to find a lot of helpful pointers throughout 

this guide and we’d recommend looking out for our other 

Linux and Ubuntu Made Simple guides on sale in all good 

shops and over at http://bit.ly/LXFspecial. Ubuntu 

provides basic help, open the Dash, type Help and click the 

question mark. 

This offers a basic guide to using different programs and 

parts of Ubuntu itself, alongside how to workaround and fix 

common problems. If you’re having difficulties just using 

basic parts of Ubuntu this should be your first port of call. If 

you’re having problems using specific programs within 

Ubuntu then you should turn your attention to the built-in 

help that’s offered by each application itself.

You can open the built-in help by pressing F1 while using 

any program, and then there’s the Help > Contents menu that 

all programs should offer. This provides the basic info you 

need to use individual programs. A new element of getting 

help with using these Ubuntu tools is YouTube, a modern 

trend is that many people have posted easy to follow video 

guides to using all aspects of Ubuntu and other Linux tools.

Help: How to 
fix problems
Something not working? Something broken? Something confusing? The 
Linux community is out there to dole out a little self help.

W
ith open source and Linux much is made of 

community. The people that develop the software, 

that create the documentation, that use it and 

maintain it, all of these and more come together to form a 

community around the software. This is usually centred 

around the program’s main website with forums, frequently 

asked questions, standard documentation for the software, 

social network accounts and more. This means that if you’re 

having problems using a standard feature, something isn’t 

working like it should or perhaps you even want to suggest a 

new feature there are places and people you can contact.

Of course, no one likes people who demand things and 

certainly in open source communities that is especially the 

Terminal help
We look at the Terminal on page 60 and if you’re 

serious about wanting to use Linux more and 

really get to grips with it, the Terminal is 

something you are going to have to use now and 

again. The truth is most of your Terminal use will 

be copying lines supplied by others, so really it 

shouldn’t be that intimidating. With that said 

getting help with using the Terminal is pretty 

easy, it has a number of highly comprehensive 

help systems that we’ll explain now how to use. 

You can basic help on any command by typing  

 <command name> --help  this is a standard for 

Linux commands. It’ll return a basic explanation 

of what the command does, what basic inputs 

it’s expecting and a list of the options you can 

use with it, each explained in turn.

If you find you’re getting too much text it’s 

possible to pass the output through a program 

called less, this enables you to scroll through the 

text using the arrow keys and press q to quit. To 

do this you’d type  <command> --help | less  for 

a more relaxed time.

For a more in depth explanation there’s the 

man command, just type  man <command 

name>  and a fuller manual will be displayed, 

and yes you can type  man man  to get help on 

man. Usefully typing man intro produces an 

introductory guide to using the Terminal, this 

includes the basics commands you will need day 

to day life. 

An alternative and often more friendly 

approach is using the info <command> terminal 

option, this offers a more wordy description of 

what a command does, what you can use it for 

and what the various options are for.

 It’s hard to use for beginners but there’s 

plenty of help stored within the terminal.

 Problems 

working out 

where something 

is? Try the built-

in guide.
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Of course moving online opens up a world of potential 

help. For Ubuntu specifically your first stop should be 

https://help.ubuntu.com where you’ll find an online version 

of the offline help manual you’ve already discovered. Clicking 

the Community Help Wiki link at the top will take you to a far 

more helpful area maintained by community contributors. 

This opening page provides a list of the more popular 

topics such as installation, moving from another OS, basic 

applications and moving into help for specific types of 

hardware, activities and other versions of Ubuntu sometimes 

known as flavours. The next step is to click the Other 

resources section, which takes you to https://help.ubuntu.

com/community/OtherResources area. Here you’ll find 

links to lots of different online areas of help.

AskUbuntu is a newer system that enables people to ask 

one-off questions, have them answered and then have the 

answered ranked. It helps good answers get promoted for 

easier visibility, but before you post anything you should 

search to see if your question has already been answered. 

The IRC section refers to a live chat system, but you’re not 

able to access it directly from the website. There are web-

based IRC systems such as https://webchat.freenode.net, 

you’ll need to log in and join the #ubuntu channel, where if 

you’re patient and polite you might find someone willing to 

answer your questions.

Another area you can get human support but also a huge 

database of fixed issues is the Ubuntu Forums over at 

https://ubuntuforums.org or from the previous Other 

Resources page. The Ubuntu forums have been running for 

over 12 years and are often the first time new users interact 

with other long-standing Ubuntu users. It’s advised to ensure 

you search first to see if your problem has already been 

answered, this will save everyone lots of time including 

yourself. Of course be polite, don’t repost the same problem 

across multiple sub-forums and try to provide as much 

information as possible. Stating “my screen is blank” isn’t 

really going to help anyone. 

Finding help with the forums is best done through the 

search tool in the top-right. You can dive into individual 

sections of the forum such as Installation, General Help, 

Hardware, but unless the issue is particularly timely or 

common it’s highly unlikely you’re going to stumble upon 

your specific issue very quickly. As an example the General 

Help forum has over 322,000 threads, each having who 

knows how many replies! 

Clicking the Advanced Search will greatly enhance your 

ability to search for the problem you have, in the correct 

forum. Here are our top tips for a better search. To begin with, 

the keywords that you choose need to be the most relevant, 

so if you’re using Ubuntu 16.10 and you’re unable to write to a 

USB stick, limit your keywords to something like: “Ubuntu 

USB write error”. We also strongly suggest switching the 

Keyword setting to Search Titles Only, rather than matching 

those keywords against the entirety of a post, just the title 

words are used.

Additionally use the Search in Forum option to limit any 

search to just the relevant one. Taking the last search as an 

example you’d like limit it to Hardware and perhaps General 

Help. We also suggest restricting returns to include at least 

two replies, which is an indicator of a useful reply. You may 

want to try setting the Find Posts to A Year Ago and Newer, to 

ensure you only get answers that are only a year old.

Of course you’re able to search more generally through 

Google or similar search engines. You’ll find plenty of help in 

many forums all over the internet, so keep searching and 

asking you’ll find friendly people we promise. 

 The Ubuntu Forums are the best place to get help on all manner of issues.

Searching for help

Keywords
Use a minimal number of words, 

stick to the ones most relevant to  

your problem.

Forums website
Get started by heading 

over to https://

ubuntuforums.org 

then use the top-right 

Advanced Search link.

Search titles only
We suggest switching to Search 

titles only, this helps greatly narrow 

down the number of returned posts.

Search in Forum
Another excellent way to focus your 

search is limit it to only relevant 

forums here.

Find Threads
It’s worth limiting 

returned search to ones 

with at least 2 replies, 

it’s unlikely any with 

less than this are useful.
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